
DPO70000SX シリーズ

オシロスコープ

ユーザ

*P071336303*
071-3363-03





DPO70000SX シリーズ

オシロスコープ

ユーザ

www.tek.com
071-3363-03

警告

保守点検に関する説明は、資格のあるサービス担当者のみを対
象としています。危害がおよぶ恐れがありますので、資格がない
限り保守点検を行わないでください。保守点検を実行する前に、
すべての安全性に関するサマリをご覧ください。

DPO70000SX シリーズ製品ファームウェア V10.0 以降をサポート



Copyright ©Tektronix.All rights reserved.使用許諾ソフトウェア製品は、Tektronix またはその子会社や供給者が所有するもの

で、米国著作権法および国際条約の規定によって保護されています。Tektronix 製品は、登録済および出願中の米国その

他の国の特許等により保護されています。本書の内容は、既に発行されている他の資料の内容に代わるものです。また、
本製品の仕様および価格は、予告なく変更させていただく場合がございますので、予めご了承ください。

TEKTRONIX および TEK は Tektronix, Inc. の登録商標です。

TekScope、TekConnect、および FastAcq は Tektronix, Inc.の登録商標です。

FastFrame、OpenChoice、MyScope、MultiView Zoom、SignalVu、TekExpress、TriMode、TekSecure、TekProbe、TekVPI、TekVISA、
UltraSync、および PinPoint は、Tektronix, Inc. の商標です。

Tektronix 連絡先

Tektronix, Inc.
14150 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA
製品情報、代理店、サービス、およびテクニカル・サポート：

■ 北米内：1-800-833-9200 までお電話ください。

■ 世界の他の地域では、www.tek.com にアクセスし、お近くの代理店をお探しください。

http://www.tek.com


目次

安全性に関する重要な情報 ........................................................................................................................ vii
安全にご使用いただくために ................................................................................................................. vii
安全に保守点検していただくために ...................................................................................................... ix
本マニュアル内の用語 ............................................................................................................................. ix
本機に関する用語 .................................................................................................................................... ix
本製品の記号 ............................................................................................................................................. x

適合性に関する情報 ...................................................................................................................................... xi
EMC 適合性 ................................................................................................................................................ xi
安全性 ......................................................................................................................................................... xii
環境基準に対する適合性 ...................................................................................................................... xiii

まえがき ........................................................................................................................................................... xv

機器の設置
スタンダード・アクセサリ ........................................................................................................................... 1
動作の要件 ................................................................................................................................................. 2
電源要件 ...................................................................................................................................................... 3
機器の損傷防止 ........................................................................................................................................ 3

ESD の防止 ............................................................................................................................................ 3
最大入力電圧に関する注意事項 ..................................................................................................... 5
適切なアッテネータの選択 ................................................................................................................. 5
コネクタのクリーニング ........................................................................................................................ 5
適切な接続テクニック .......................................................................................................................... 6

機器の電源の投入 .................................................................................................................................... 9
機器の電源の切断 .................................................................................................................................. 10
マルチ機器構成 ....................................................................................................................................... 10

機器の積み重ね ................................................................................................................................. 10
起動前の確認 ..................................................................................................................................... 13
UltraSync™ バス・ケーブル ................................................................................................................ 13
UltraSync™ バス・ケーブル接続の手順 .......................................................................................... 13
Master と Extension を接続する手順 ................................................................................................. 15
マルチ機器の電源の起動 ................................................................................................................ 16
機器モードの切り替え ....................................................................................................................... 20
ATI チャンネルと TekConnect チャンネル ......................................................................................... 21
マルチ機器構成のステータス表示 ................................................................................................. 21
利用できない機能 .............................................................................................................................. 22

DPO70000SX シリーズ・ユーザ i



DPO7AFP 型外部フロント・パネル（オプション） .................................................................................. 24
本機の検査 ............................................................................................................................................... 25

内部診断合格の確認 ........................................................................................................................ 25
Windows インタフェース・ガイドライン .............................................................................................. 26

信号パス補正 ........................................................................................................................................... 27
ネットワーク接続 ...................................................................................................................................... 30
2 台めのモニタの追加 ............................................................................................................................. 31
オペレーティング・システムと製品ソフトウェアのリストア ................................................................ 31
オペレーティング・システムのリストア .................................................................................................. 32
内部リカバリ・ユーティリティ .................................................................................................................. 32
製品ソフトウェアのインストール ............................................................................................................ 32

機器の詳細
フロントパネル・コネクタ .......................................................................................................................... 33
リア・パネル・コネクタ .............................................................................................................................. 35
インタフェースおよびディスプレイ ......................................................................................................... 36
コントロール・パネル ................................................................................................................................ 38
オンライン・ヘルプへのアクセス ............................................................................................................ 40
メニューおよびコントロール・ウィンドウへのアクセス ....................................................................... 41

機器の検査
内部診断合格の確認 .............................................................................................................................. 43

Acquisition
信号パス補正 ........................................................................................................................................... 45
アナログ信号入力のセットアップ .......................................................................................................... 48
デフォルト設定の使用 ............................................................................................................................. 50
オートセットの使用 ................................................................................................................................... 51
プローブの補正およびデスキュー ........................................................................................................ 52
アクイジションの概念 .............................................................................................................................. 52

アクイジション・ハードウェア ............................................................................................................. 52
サンプリング処理 ............................................................................................................................... 52
リアルタイム・サンプリング ............................................................................................................... 52
補間リアルタイム・サンプリング ...................................................................................................... 52
等価時間サンプリング ....................................................................................................................... 53
波形レコード ........................................................................................................................................ 53

目次  

ii  DPO70000SX シリーズ・ユーザ



補間方式 .............................................................................................................................................. 54
アクイジション・モードの仕組み ....................................................................................................... 54

拡張有効ビット数をオンにする .............................................................................................................. 55
アクイジション・モードの変更 ................................................................................................................. 56
アクイジションの開始および停止 .......................................................................................................... 57
水平モードの選択 .................................................................................................................................... 58
FastAcq の使用 .......................................................................................................................................... 60
DSP 拡張帯域幅の使用 .......................................................................................................................... 61
ターミネーション電圧の選択 .................................................................................................................. 64
ロール・モードの使用 .............................................................................................................................. 65
バスのセットアップ ................................................................................................................................... 66
シリアル・バスのセットアップ .................................................................................................................. 68
パラレル・バスのセットアップ ................................................................................................................. 70
バスの表示のセットアップ ...................................................................................................................... 72
FastFrame モードの使用 .......................................................................................................................... 73
FastFrame フレーム・ファインダの使用 ................................................................................................. 75

ピンポイント・トリガ
トリガの概念 .............................................................................................................................................. 77

トリガ・イベント ..................................................................................................................................... 77
トリガ・モード ........................................................................................................................................ 77
トリガ・ホールドオフ ............................................................................................................................ 78
トリガ・カップリング ............................................................................................................................. 78
水平軸位置 ......................................................................................................................................... 78
スロープおよびレベル ....................................................................................................................... 78
遅延トリガ・システム .......................................................................................................................... 78

トリガ・タイプの選択 ................................................................................................................................. 79
トリガ一覧 .................................................................................................................................................. 81
トリガ・ステータスのチェック ................................................................................................................... 82
A （メイン）トリガおよび B （遅延）トリガの使用 .................................................................................... 84

トリガ、B イベント ................................................................................................................................. 85
B トリガ、遅延時間後 ......................................................................................................................... 85
リセットによるトリガ ............................................................................................................................ 85
トリガ位置の修正 ............................................................................................................................... 86

B イベント・スキャンを使用するトリガ ................................................................................................... 87
パラレル・バスでのトリガ ........................................................................................................................ 90
シリアル・バスでのトリガ ......................................................................................................................... 92

 目次

DPO70000SX シリーズ・ユーザ iii



ビジュアル・トリガによるトリガ ............................................................................................................... 94
Action on Event の設定 .............................................................................................................................. 96
トリガ時の電子メールの送信 ................................................................................................................. 97
イベント時の電子メールの設定 ............................................................................................................ 98
水平遅延の使用 .................................................................................................................................... 100

波形の表示
表示スタイルの選択 .............................................................................................................................. 101
表示パーシスタンスの設定 .................................................................................................................. 102
表示フォーマットの設定 ........................................................................................................................ 104
波形補間の選択 .................................................................................................................................... 105
スクリーン・テキストの追加 .................................................................................................................. 106
目盛スタイルの設定 .............................................................................................................................. 107
トリガ・レベル・マーカの設定 ............................................................................................................... 108
日付と時刻の表示 ................................................................................................................................. 108
カラー・パレットの使用 .......................................................................................................................... 109
リファレンス波形色の設定 ................................................................................................................... 111
リファレンス波形色の設定 ................................................................................................................... 112
MultiView ズームの使用 ......................................................................................................................... 113
複数エリアのズーム .............................................................................................................................. 114
ズームした波形のロックおよびスクロール ....................................................................................... 116
ズームされたウィンドウでの波形の非表示 ...................................................................................... 117
波形の検索とマーキング ...................................................................................................................... 117
マークを手動で設定およびクリア（消去）するには、次の手順を実行します。 .......................... 118
検索マークを自動で設定およびクリア（消去）するには ................................................................. 120
ビジュアル検索の使用 .......................................................................................................................... 125

波形の解析
自動測定の実行 .................................................................................................................................... 127
自動測定一覧 ......................................................................................................................................... 128
自動測定のカスタマイズ ...................................................................................................................... 131

ゲーティング ...................................................................................................................................... 132
統計 ..................................................................................................................................................... 132
スナップショット ................................................................................................................................. 133
測定のコメント ................................................................................................................................... 133
リファレンス・レベル ......................................................................................................................... 135

カーソル測定の実行 ............................................................................................................................. 136

目次  

iv  DPO70000SX シリーズ・ユーザ



ヒストグラムの設定 ................................................................................................................................ 138
演算波形の使用 .................................................................................................................................... 140
スペクトラム解析の使用 ....................................................................................................................... 143
マスク・テストの使用 .............................................................................................................................. 146
リミット・テストの使用 ............................................................................................................................. 149

MyScope
新しい MyScope コントロール・ウィンドウの作成 .............................................................................. 151
MyScope コントロール・ウィンドウの使用 ........................................................................................... 155

情報の保存と呼び出し
スクリーン・イメージの保存 .................................................................................................................. 157
波形を保存 .............................................................................................................................................. 159
波形の呼出 ............................................................................................................................................. 161
機器設定の保存 .................................................................................................................................... 162
機器設定の呼び出し ............................................................................................................................. 163
測定の保存 ............................................................................................................................................. 164
ユーザ・マスクの保存 ............................................................................................................................ 165
ヒストグラム・データの保存 .................................................................................................................. 166
タイムスタンプの保存 ............................................................................................................................ 167
クリップボードへの結果のコピー ........................................................................................................ 168
ハードコピーの印刷 ............................................................................................................................... 170

アプリケーション・ソフトウェアの実行

使用例
間欠的に発生する異常の取り込み .................................................................................................... 173
拡張デスクトップおよび OpenChoice アーキテクチャを使用した効率的なドキュメント作成 ..... 176
バスでのトリガ ........................................................................................................................................ 178

付録 A、メンテナンス
メンテナンス ............................................................................................................................................ 181
クリーニング ............................................................................................................................................ 181
外部のクリーニング ............................................................................................................................... 181
調整間隔 .................................................................................................................................................. 182

 目次

DPO70000SX シリーズ・ユーザ v



調整 .......................................................................................................................................................... 182
フラットパネル・ディスプレイのクリーニング ..................................................................................... 182
修理のための機器の返送 ................................................................................................................... 183
TekScope リカバリ・レポート・ユーティリティ ....................................................................................... 183
交換できる部品 ...................................................................................................................................... 185
部品注文情報 ......................................................................................................................................... 186

付録 B、ヴァージョン・リリース
最新の高度な解析アプリケーションとバージョン・リリースの入手方法 ..................................... 187

目次  

vi  DPO70000SX シリーズ・ユーザ



安全性に関する重要な情報

このマニュアルには、操作を行うユーザの安全を確保し、製品を安全な状態に保つために順守しなければならな
い情報および警告が記載されています。

本機の点検にあたっては「安全にご使用いただくために」に続く「Service safety summary」を参照して、事故防止に

つとめてください。

安全にご使用いただくために

製品は指定された方法でのみご使用ください。人体への損傷を避け、本製品や本製品に接続されている製品の
破損を防止するために、安全性に関する次の注意事項をよくお読みください。すべての指示事項を注意深くお読
みください。必要なときに参照できるように、説明書を安全な場所に保管しておいてください。

該当する地域および国の安全基準に従ってご使用ください。

本製品を正しく安全にご使用になるには、このマニュアルに記載された注意事項に従うだけでなく、一般に認めら
れている安全対策を徹底しておく必要があります。

本製品は訓練を受けた専門知識のあるユーザによる使用を想定しています。

製品のカバーを取り外して修理や保守、または調整を実施できるのは、あらゆる危険性を認識した専門的知識の
ある適格者のみに限定する必要があります。

使用前に、既知の情報源と十分に照らし合わせて、製品が正しく動作していることを常にチェックしてください。

本製品は危険電圧の検出用にはご利用になれません。

危険な通電導体が露出している部分では、感電やアーク・フラッシュによってけがをするおそれがありますので、
保護具を使用してください。

本機を大きなシステムの下で使用する場合、そのシステムを構成する他のパーツにアクセスしなければならない
場合があります。他のシステムの操作に関する警告や注意事項については、その製品コンポーネントのマニュア
ルにある安全に関するセクションをお読みください。

本機をシステムの一部として使用する場合、そのシステムの安全性についてはシステムの構築者が責任を負うも
のとします。

火災や人体への損傷を避けるには

適切な電源コードを使用してください： 電源コードは本機に適した仕様で、使用国の基準を満たすもののみを使

用してください。他の製品の電源コードは使用しないでください。

本製品を接地してください： 本製品の電源コードには接地用のグランド線が付いています。感電を避けるため、グ

ランド線をアースに接続する必要があります。本製品の入出力端子に接続する前に、製品が正しく接地されてい
ることを確認してください。電源コードのグランド接続を無効にしないでください。

電源の切断： 本製品は、電源コードを引き抜いて電源ソースから切断します。スイッチの位置については、使用

説明書を参照してください。電源コードの取り扱いが困難な場所には設置しないでください。必要に応じてすぐに
電源を遮断できるように、ユーザが常にアクセスできる状態にしておく必要があります。

接続と切断は正しく行ってください： プローブと検査リードは、電圧ソースに接続されている間は着脱しないでくだ

さい。 電圧プローブ、テスト・リード、およびアダプタは、製品に付属した絶縁されたものか、当社が製品に使用で

きると明示したもののみを使用してください。

すべての端子の定格に従ってください： 発火や感電の危険を避けるために、本製品のすべての定格とマーキン

グに従ってください。本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参照してください。

コモン端子を含むどの端子にも、その端子の最大定格を超える電位をかけないでください。
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本製品の測定端子は、AC 電源、カテゴリ II、 III、および IV 回路には使用できません。

カバーを外した状態で動作させないでください： カバーやパネルを外した状態やケースを開いたまま動作させない

でください。危険性の高い電圧に接触してしまう可能性があります。

露出した回路への接触は避けてください： 電源が投入されているときに、露出した接続部分やコンポーネントに触

れないでください。

故障の疑いがあるときは使用しないでください： 本製品に故障の疑いがある場合には、資格のあるサービス担当

者に検査を依頼してください。

製品が故障している場合には、使用を停止してください。製品が故障している場合や正常に動作していない場合

には、製品を使用しないでください。安全上の問題が疑われる場合には、電源を切って電源コードを取り外してく
ださい。誤って使用されることがないように、問題のある製品を区別できるようにしておいてください。

使用前に、電圧プローブ、テスト・リード、およびアクセサリに機械的損傷がないかを検査し、故障している場合に

は交換してください。金属部が露出していたり、摩耗インジケータが見えているなど、損傷が見られるプローブま
たはテスト・リードは使用しないでください。

使用する前に、製品の外観に変化がないかよく注意してください。ひび割れや欠落した部品がないことを確認して

ください。

指定された交換部品のみを使用するようにしてください。

湿気の多いところでは動作させないでください： 機器を寒い場所から暖かい場所に移動する際には、結露にご注

意ください。

爆発性のガスがある場所では使用しないでください：

製品の表面を清潔で乾燥した状態に保ってください： 製品の清掃を開始する前に、入力信号を取り外してくださ

い。

適切に通気してください： ユーザ・マニュアルの設置手順を参照し、十分な換気を確保してください。

製品には通気用のスロットや開口部があります。その部分を覆ったり、通気が妨げられたりすることがないように

してください。開口部には異物を入れないでください。

安全な作業環境を確保してください： 製品は常にディスプレイやインジケータがよく見える場所に設置してくださ

い。

キーボードやポインタ、ボタン・パッドは正しく使用し、長時間の連続使用は避けてください。キーボードやポインタ

の使用方法を誤ると、身体に深刻な影響が及ぶ可能性があります。

作業場が該当する人間工学規格を満たしていることを確認してください。ストレスに由来するけががないように、

人間工学の専門家に助言を求めてください。

製品を持ち上げたり運んだりする作業は慎重に行ってください。本製品には持ち運び用のハンドルが取り付けら

れています。

警告： 本機はかなりの重量があります。怪我をしたり装置が損傷することがないように、製品を持ち運ぶときには
誰かの手を借りてください。

本製品には指定された当社のラック取り付け金具のみを使用してください。

安全性に関する重要な情報  
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安全に保守点検していただくために

「安全に保守点検していただくために」のセクションには、製品の保守点検を安全に行うために必要な詳細な情報

が記載されています。資格のあるサービス担当者以外は、保守点検手順を実行しないでください。保守点検を行
う前には、この「安全に保守点検していただくために」と「安全にご使用いただくために」をお読みください。

感電を避けるため、： 露出した接続部には触れないでください。

保守点検は単独で行わないでください。： 応急処置と救急蘇生ができる人の介在がない限り、本製品の内部点

検や調整を行わないでください。

電源を切断してください。： 保守点検の際にカバーやパネルを外したり、ケースを開く前に、感電を避けるため、製

品の電源を切り、電源コードを電源コンセントから抜いてください。

電源オン時の保守点検には十分注意してください。： 本製品には、危険な電圧や電流が存在している可能性が

あります。保護パネルの取り外し、はんだ付け、コンポーネントの交換をする前に、電源の切断、バッテリの取り
外し（可能な場合）、テスト・リードの切断を行ってください。

修理後の安全確認。： 修理を行った後には、常にグランド導通と電源の絶縁耐力を再チェックしてください。

本マニュアル内の用語

本マニュアルでは以下の用語を使用しています。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本機やその他の接続機器に損害を与えるおそれのある状態や行為を示します。

本機に関する用語

本機では次の用語を使用します。

■ 危険： ただちに人体や生命に危険をおよぼす可能性があることを示します。

■ 警告： 人体や生命に危険をおよぼす可能性があることを示します。

■ 注意： 本製品を含む周辺機器に損傷を与える可能性があることを示します。

 安全性に関する重要な情報
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本製品の記号

製品にこの記号が表記されているときは、マニュアルを参照して、想定される危険性とそれらを回避す
るために必要な行動について確認してください。（マニュアルでは、この記号はユーザに定格を示すた
めに使用される場合があります）。

本製品では、次の記号を使用します。

                 

安全性に関する重要な情報  

x  DPO70000SX シリーズ・ユーザ



適合性に関する情報

このセクションでは、本製品が適合している EMC 基準、安全基準、および環境基準について説明します。

EMC 適合性

EC 適合宣言 - EMC
指令 2004/108/EC 電磁環境両立性に適合します。『Official Journal of the European Communities』に記載の以下の基

準に準拠します。

EN 61326-1、EN 61326-2-1. 測定、制御、および実験用途の電気機器を対象とする EMC 基準  1 2 3 4

■ CISPR 11：グループ 1、クラス A、放射および伝導エミッション

■ IEC 61000-4-2：静電気放電イミュニティ

■ IEC 61000-4-3：RF 電磁界イミュニティ  5

■ IEC 61000-4-4：電流高速トランゼント／バースト・イミュニティ

■ IEC 61000-4-5：電力線サージ・イミュニティ

■ IEC 61000-4-6：伝導 RF イミュニティ 5

■ IEC 61000-4-11：電圧低下と遮断イミュニティ

EN 61000-3-2. AC 電源ライン高調波エミッション

EN 61000-3-3. 電圧の変化、変動、およびフリッカ

製造元適合性に関するお問い合わせ先.
Tektronix, Inc. PO Box 500, MS 19‐045
Beaverton, OR 97077, USA
jp.tek.com

オーストラリア／ニュージーランド適合宣言 - EMC
ACMA に従い、次の規格に準拠することで Radiocommunications Act の EMC 条項に適合しています。

■ CISPR 11：グループ 1、クラス A、放射および伝導エミッション（EN61326-1 および EN61326-2-1 に準拠）

1 本製品は住居区域以外での使用を目的としたものです。住居区域で使用すると、電磁干渉の原因となることがあります。
2 本製品をテスト対象に接続した状態では、この規格が要求するレベルを超えるエミッションが発生する可能性があります。
3 連結ケーブルを使用する場合は、高品質な低 EMI シールド付きケーブルを使用してください。
4 機器にテスト・リードまたはテスト・プローブが接続されているときには、これらのリード／プローブに電磁干渉がカップリングされるため、この標準に

より規定されたイミュニティ要件を満たせるとは限りません。電磁干渉による影響を最小限に抑えるには、信号の非シールド部分と対応するリター
ン・リードの間のループ領域を最小にします。また、電波障害の発生源からできるだけ遠ざけるようにします。ループ領域を少なくするための効率的
な方法は、非シールド部分のテスト・リードをツイストペアにすることです。プローブの場合、グランド・リターン・リードをできるだけ短くし、プローブ本
体に近づけるようにします。そうした処置を効率的に行えるように、プローブによっては、アクセサリとしてプローブ・チップ・アダプタが提供されている
機種もあります。いずれの場合も、使用するプローブまたはリードの取扱説明書を十分に読むようにしてください。

5 オシロスコープが継続的に電磁界にさらされている場合の性能基準は次のとおりです。 10m V/div ～ 1V/div：0.4 div 以下の波形変位または 0.8 div 以
下の p-p ノイズの増加。
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安全性

このセクションでは、製品が適合している安全規格およびその他の基準について説明します。

EC 適合宣言 - 低電圧

『Official Journal of the European Union』にリストされている次の仕様に準拠します。

低電圧指令 2006/95/EC

■ EN 61010-1：測定、制御、および研究用途の電子装置に対する安全基準、第 1 部：一般要件

米国の国家認定試験機関のリスト

■ UL 61010-1：測定、制御、および研究用途の電子装置に対する安全基準、第 1 部：一般要件

カナダ規格

■ CAN/CSA-C22.2 No. 61010-1：測定、制御、および実験用途の電子装置に対する安全基準 – 第 1 部：一般要件

その他の基準に対する適合性

■ IEC 61010-1：測定、制御、および研究用途の電子装置に対する安全基準、第 1 部：一般要件

機器の種類

テスト機器および計測機器

安全クラス

クラス 1 - アース付き製品

汚染度について

製品内部およびその周辺で発生する可能性がある汚染度の尺度です。通常、製品の内部環境は外部環境と同
じ規定が適用されるものとみなされます。製品は、その製品に指定されている環境でのみ使用してください。

■ 汚染度 1：汚染なし、または乾燥した非導電性の汚染のみが発生します。このカテゴリの製品は、通常、被包

性、密封性のあるものか、クリーン・ルームでの使用を想定したものです。

■ 汚染度 2：通常、乾燥した非導電性の汚染のみが発生します。ただし、結露によって一時的な導電性が発生

することもまれにあります。これは、標準的なオフィスや家庭内の環境に相当します。一時的な結露は製品非
動作時のみ発生します。

■ 汚染度 3：伝導性のある汚染、または通常は乾燥して導電性を持たないが結露時に導電性を帯びる汚染。こ

れらは、温度、湿度のいずれも管理されていない屋内環境に相当します。日光や雨、風に対する直接の曝露
からは保護されている領域です。

■ 汚染度 4：導電性のある塵、雨、または雪により持続的に導電性が生じている汚染。これは一般的な屋外環

境に相当します。

適合性に関する情報  
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汚染度

汚染度 2（IEC 61010-1 の定義による）。注：乾燥した屋内でのみ使用できます。

IP 定格

IP20 (IEC 60529 で定義)。

測定および過電圧カテゴリについて

本製品の測定端子は、測定する電源電圧について次の 1 つまたは複数のカテゴリに評価されます。

■ 測定カテゴリ II：低電圧インストレーションに直接接続された回路で実施する測定用。

■ 測定カテゴリ III：建築物の屋内配線で実施する測定

■ 測定カテゴリ IV：低電圧電源を使用して実施する測定

NOTE. 過電圧カテゴリ定格に該当するのは主電源回路のみです。測定カテゴリ定格に該当するのは測定回路の
みです。製品内部のその他の回路にはいずれの定格も該当しません。

主電源過電圧カテゴリ定格

過電圧カテゴリ II（IEC 61010-1 の定義による）

環境基準に対する適合性

このセクションでは本製品が環境におよぼす影響について説明します。

使用済み製品の処理方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。

機器のリサイクル. 本製品の製造には天然資源が使用されています。本製品には環境または人体に有害となる

可能性のある物質が含まれているため、製品を廃棄する際には適切に処理する必要があります。有害物質の放
出を防ぎ、天然資源の使用を減らすため、本製品の部材の再利用とリサイクルの徹底にご協力ください。

このマークは、本製品が WEEE（廃棄電気・電子機器）およびバッテリに関する指令 2012/19/EC およ

び 2006/66/EC に基づき、EU の諸要件に準拠していることを示しています。リサイクル方法について

は、当社の Web サイトのサービス・セクション（www.tek.com/productrecycling）を参照してください。

過塩素酸塩の取り扱い. 本製品には CR リチウム電池が搭載されています。CR リチウム電池はカリフォルニア州

法により過塩素酸塩材として規定され、特別な取り扱いが求められています。詳細については、www.dtsc.ca.gov/
hazardouswaste/perchlorate を参照してください。

有害物質に関する規制

本機は産業用監視および制御装置に分類されており、2017 年 7 月 22 日までは、改訂 RoHS Directive 2011/65/EU
の含有物質制限に準拠する義務はありません。

 適合性に関する情報
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まえがき

このマニュアルでは、DPO70000SX シリーズ機器の設置と基本的な操作方法について説明します。詳細な操作方

法については、ご使用の機器に搭載されているヘルプを参照してください。このマニュアルは次の機器を対象とし
ています。

■ DPO77002SX 型

■ DPO75902SX
■ DPO75002SX
■ DPO73304SX 型

■ DPO72304SX 型

主な特長

DPO70000SX シリーズの機器を使用して、電子設計の検証、デバッグ、および評価を行うことができます。主な特

長は次のとおりです。

■ アナログの 1 チャンネルにおいて 70 GHz の帯域幅および 200 GS/s のリアルタイム・サンプリング・レート、ア

ナログの 2 チャンネルにおいて 33 GHz の帯域幅および 100 GS/s のリアルタイム・サンプリング・レートを実現

（DPO77002SX 型）

■ アナログの 1 チャンネルにおいて 59 GHz の帯域幅および 200 GS/s のリアルタイム・サンプリング・レート、ア

ナログの 2 チャンネルにおいて 33 GHz の帯域幅および 100 GS/s のリアルタイム・サンプリング・レートを実現

（DPO75902SX 型）

■ アナログの 1 チャンネルにおいて 50 GHz の帯域幅および 200 GS/s のリアルタイム・サンプリング・レート、ア

ナログの 2 チャンネルにおいて 33 GHz の帯域幅および 100 GS/s のリアルタイム・サンプリング・レートを実現

（DPO75002SX 型）

■ アナログの 2 チャンネルにおいて 33 GHz の帯域幅および 100 GS/s のリアルタイム・サンプリング・レート、ま

たは 4 チャンネルにおいて 50 GHz のリアルタイム・サンプリング・レートを実現（DPO73304SX 型）

■ アナログの 2 チャンネルにおいて 23 GHz の帯域幅および 100 GS/s のリアルタイム・サンプリング・レート、ま

たは 4 チャンネルにおいて 50 GHz のリアルタイム・サンプリング・レートを実現（DPO72304SX 型）

■ 拡張帯域幅機能を有効にすると、帯域幅を広げて、パスバンドを平坦化するデジタル信号プロセッサ（DSP）
フィルタが適用されます。拡張帯域幅では、最高のサンプル・レートにおいて、有効化されたチャンネル間の
応答が一致します。S/N 比を改善するために、帯域幅は 500 MHz まで制限することができます。高性能のプロ

ーブとチップを使用すると、拡張帯域幅はプローブ・チップまで有効となります。

■ 最大 1,000,000,000 サンプルのレコード長（モデルとオプションにより異なります）

■ 最大 1.0% の DC 垂直ゲイン確度（モデルに応じて異なります）

■ UltraSync™ インタフェースを使用して最大 4 台の機器を接続することでチャンネル数の増加が可能

■ オプションの外部モニタにユーザ・インタフェースを表示可能

■ アナログ入力 4 チャンネル（モデルにより異なります。ハイレゾ・モードでない場合は、各チャンネル 8 ビットの

分解能）、補助トリガ入出力

■ 包括的なコマンド・セットとメッセージ・ベースのインターフェースによる完全なプログラミング機能

■ フレキシブルな A/B トリガ・イベントが可能

■ 25 GHz 以上のエッジ・トリガ、10 GHz 以上の補助トリガ
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■ 選択可能なトリガ位置修正機能によってトリガをより正確に指定し、ジッタを減らすことも可能

■ 内蔵された強力な測定機能（ヒストグラム、自動測定、アイ・パターン測定、および測定統計）

■ 波形を数学的に組み合わせて、データ解析作業に役立つ波形を作成可能。 演算式では任意フィルタを使用

可能。 スペクトラム解析を使用して、周波数領域で波形を解析可能

■ 水平軸スケールとは別に、サンプル・レートとレコード長をコントロール可能

■ 直感的なグラフィック・ユーザ・インタフェース（UI）および内蔵されている、スクリーン上で利用可能なオンライ

ン・ヘルプ

■ 内部リムーバブル・ディスク・ストレージ

マニュアル

本製品に関する各種情報の参照先は以下のとおりです。

参照項目 参照するマニュアル

設置と操作（概要） ユーザ・マニュアル

操作方法およびユーザ・インタフェース 本機のヘルプ機能（Help メニューから呼び出し）

プログラマ・コマンド プログラマ・マニュアル。当社 Web サイト

（www.tektronix.com/manuals）で入手可。

本マニュアルで使用する表記規則

このマニュアルでは、次のアイコンが使用されています。

ステップ フロントパネル
の電源

電源の接続 ネットワーク PS-2 SVGA USB

まえがき  
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機器の設置

本機を開梱し、スタンダード・アクセサリとして記載されているすべての付属品が含まれていることを確認します。
推奨アクセサリとプローブ、機器のオプション、およびアップグレードについては、オンライン・ヘルプに記載されて
います。 最新の情報について、当社 Web サイト（www.tektronix.com）を参照します。

スタンダード・アクセサリ

アクセサリ 当社部品番号

ユーザ・マニュアル（言語オプションにより異なります） 071-3357-xx
前面保護カバー、TekConnect 対応機器用

ATI 対応機器用

200-5337-00 
200-5358-00 

PCIe ホスト・ポート保護プラグ 200-5344-00 

2 番目の Ethernet ポート・プラグ 200-5389-00 

Fast Edge コネクタ用 50Ω 終端（2 個） 015-1022-01 

TCA-292D（5 個）（ATI 対応機器は 3 個） 090-0044-00 

Windows 互換キーボード 119-7275-xx

Windows 互換マウス 119-7054-xx

帯電防止用リスト・ストラップ 006-3415-05 
デスキュー・ケーブル（2.92mm（fe）-2.92mm（fe）） 174-6793-00 

デスキュー・アダプタ（1.85mm（fe）～2.92mm（fe））、ATI 対
応機器のみ

103-0483-00 

アッテネータ（2.92mm（fe）～2.92mm（ma）、50Ω、10DB） 011-0221-00 

ATI コネクタ・セーバ（1.85mm）、ATI 対応機器のみ 103-0474-00 

ATI 保護キャップ、ATI 対応機器のみ 016-2101-00 

トルク・レンチ、ATI 対応機器のみ 067-2787-00 

バッキング・レンチ、ATI 対応機器のみ 003-1942-00 

アクセサリ・ポーチ 016-2045-00 
ベストプラクティス・マニュアル 071-2989-04 
ROHS 情報 071-2185-04 

校正証明書 001-1179-00 
校正証明書保管用封筒 006-8018-01 
電源コード（以下のいずれかを選択）
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アクセサリ 当社部品番号

北米（オプション A0 型） 161-0213-00 

欧州全域（オプション A1 型） 161-0209-00 

英国（オプション A2 型） 161-0210-00 

オーストラリア（オプション A3 型） 161-0211-01 

スイス（オプション A5 型） 161-0212-01 

日本（オプション A6 型） 161-0213-00 

中国（オプション A10 型） 161-0320-00 

インド（オプション A11 型） 161-0325-00 

ブラジル（オプション A12 型） 161-0358-00 

電源コードなし（オプション A99 型）

動作の要件

警告：

けがをしたり、機器が損傷することがないように、機器を背面の脚に載せた状態で機器の操作を行わないように
してください。

1. カートまたはベンチに機器を設置します。機器は底部の脚を下にして設置します。オプションのラック・マウン
ト・キットが使用できます。次の設置要件および寸法に従ってください。

■ 上：0 cm（0 mm）

■ 左側面：7.62 cm（76 mm）

■ 右側面：7.62 cm（76 mm）

■ 後部：リア・パネルに接続されたケーブルを保護するために、後部の脚との間に 7.62 cm（76 mm）の空間

が必要

■ 底：脚が取り付けられていて、フリップ・スタンドを下げている場合は 0 cm（0 mm）

注意： 正しく冷却するためにオシロスコープの下側と側面には障害物を置かないでください。

適切な冷却が行われるように、機器を積み重ねる場合には、底部の脚を取り付けた状態で使用する必要が
あります。

2. 幅：48.26 cm（483 mm）

3. 高さ：15.24 cm（152 mm）

4. 機器を操作する前に、周囲温度（5 °C～+45 °C（+41 °F～+113 °F））を確認してください。

5. 動作温度：相対湿度 8 ～ 80%（+32 ℃（+90 ﾟF）まで）

5 ～ 45%（+32 ℃（+90 ﾟF）から最高 +45 ℃（+113 ﾟF）まで）、結露なし、最高湿球温度 +29.4 ℃（+85 ﾟF）（相対湿度

は +45 ℃（+113 ﾟF）で 32% に低下）

6. 動作高度：3,000 m（9,843 フィート）、高度 1500 メートル（4921.25 フィート）を超えた場合、最高動作温度は

300 メートル（984.25 フィート）につき 1 ℃ の割合で低下。

7. 最大入力電力：

機器の設置  

2  DPO70000SX シリーズ・ユーザ



TekConnect チャンネル： 1.2V 以下/FS 設定：

ターミネーション・バイアス（最大 30mA）を基準として±1.5V。

±5V 最大入力電力。

1.2V 未満/FS 設定：±8.0V（最大 Vterm 時の電流およびアッテネータの電力に制限される）。

ATI チャンネル： ± 0.75Vpk

補助チャンネル： ±5.0Vpk

電源要件

本機の電源要件を以下の表に示します。

電源電圧と周波数 消費電力

100 VAC ～ 240 VAC、50 Hz/60 Hz
または 115 VRMS、400 Hz

980 W

警告：

出火および感電のリスクを減らすため、主電源の電圧変動が動作電圧範囲の 10% を超えていないことを確認し
てください。

機器の損傷防止

ESD の防止

注意： 直接的な静電気放電により機器の入力が損傷することがあります。このような損傷を回避する方法につい
て、以下の情報をお読みください。

どのような電子機器を取り扱う場合でも、ESD（静電気放電）に常に注意を払う必要があります。本機には万全の

ESD 対策が施されていますが、信号入力への直接の大きな静電気放電が生じると機器を損傷する可能性があり

ます。機器が損傷することがないように、次の手順に従って、静電気放電を防止します。

1. ケーブルおよび TekConnect アダプタ

の取り付けまたは取り外しの際に
は、接地された帯電防止リスト・スト
ラップを付けて、人体から静電気を
放電します。本機では、この目的に
使用するコネクタがフロント・パネル
に用意されています。
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2. 未接続で放置されたままのケーブル
や、長く引き回したケーブルは、大
量の静電気を帯びている可能性が
あります。すべてのケーブルは機器
やテスト対象デバイスに接続する前
に、ケーブルの中心導体を一時的に
接地するか、ケーブルの一端を 50Ω
ターミネータに接続して放電します。

注意： 中心導体をコネクタ上のグラ
ンド・シェルに短絡させる際には、
（スクリュードライバ、レンチなどの）
器具は使用しないでください。擦り傷
や切り目などができると、ケーブル
の RF 応答に悪影響が及ぶ可能性
があります。
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最大入力電圧に関する注意事項

警告： すべての端子の定格に従ってください。機器の損傷を防ぐため、本製品のすべての定格とマーキングに従
ってください。本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参照してください。

コモン端子を含むどの端子にも、その端子の最大定格を超える電位をかけないでください。

ATI（非同期タイム・インターリーブ）入力の最大入力電圧は、±0.75Vpk です。これは、非破壊最大電圧です。

TekConnect 入力の最大入力電圧は、フル・スケール設定が 1.2V 以下の場合はターミネーション・バイアス（最大

30mA）を基準とし±1.5V、フル・スケール設定が 1.2V を超える場合は 8V です。

適切なアッテネータの選択

ATI 入力の最大電圧の範囲は、300mVFS です。アッテネータを使用すると、最大電圧の範囲が上がります。

表 4 : ATI 入力の最大電圧の範囲

アッテネータ ATI 入力の最大電圧の範囲

なし 300mVFS

3dB 420mVFS

6dB 600mVFS

10dB 950mVFS

16dB（アッテネータ：6dB ＋ 10dB） 1.88VFS

20dB 3VFS

コネクタのクリーニング

すべてのコネクタは清潔に保たれていなければなりません。コネクタに汚れがあると、そのコネクタだけでなく、汚
れたコネクタと一緒に使用されたすべてのコネクタが損傷してしまう可能性があります。また、汚れは、RF 性能の

低下につながる場合もあります。ケーブル、アッテネータ、アダプタは、ほこりが侵入しないように、すべてコネク
タ・カバーを装着した状態で保管しなければなりません。

使用前に、次の手順に従ってコネクタの状態を確認します:
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1. コネクタに汚れ、金属粒子が付着し
ていたり、キズや変形が見られない
か確認します。

2. 正しいサイズのコネクタが使用され
ていることを確認します。

警告： 圧縮空気を使用する場合は、
目を痛めることのないように目を保
護してください。

3. コネクタを下向きにして、低圧で圧縮
された空気を角度を付けてコネクタ
に吹き付け、コネクタをクリーニング
してください。

4. それでも汚れが落ちない場合には、
イソプロピル・アルコール溶剤を染
み込ませた適切なサイズの綿棒でコ
ネクタ・スレッドと接続表面をクリー
ニングしてください。中心導体を引っ
掛けないようにしてください。

注意： コネクタ中央のピンに圧力を
かけないように注意してください。中
心部のピンに圧力をかけると、コネ
クタが損傷する危険性があります。

適切な接続テクニック

ATI 1.85mm コネクタ、SMA コネクタ、アダプタ、DC ブロック、またはケーブルに接続するときは、8 インチポンドのト

ルクを使用してください。不適切なトルクまたは接続方法を使用すると、信号の品質が低下したり、コネクタが損
傷する可能性があります。

次の手順に従って、ATI 入力との接続を行います：

注意： ATI 入力との接続を行なうときに、付属のバッキング・レンチおよびトルク・レンチの使い方を誤ると、機器が
損傷する可能性があります。
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1. ケーブルおよびアダプタの取り付けまたは取り外しの際には、接地された帯電防止リスト・ストラップを付け
て、人体から静電気を放電します。本機では、この目的に使用するコネクタがフロント・パネルに用意されて
います。黒いプラスチックのパッキングが付いたグランド接続を使用します。これは、1MΩ シリーズの絶縁抵

抗を備えており、感電の危険を防止しながら、静電電圧を放電できます。

図 1 : 帯電防止リスト・ストラップの着用

2. 付属のコネクタ・セーバを使用して、機器のコネクタを保護してください。コネクタ・セーバを使用しないときは、
エンド・キャップを取り付けることによって、汚れや静電気による損傷を防止してください。フロント・パネルの
右上隅と、リア・パネルのオーディオ・コネクタの右側にも、ATI 保護カバーを収納する場所が用意されていま

す。コネクタ・セーバを取り付けるときは、8 インチポンドで締め付けてください。

注意： オシロスコープ ATI 入力コネクタはオス・コネクタであるため、コネクタ・セーバは予想とは逆に締め付
け／緩めるように表示されることがあります。

図 2 : コネクタ・セーバの取り付け

3. コネクタ・セーバではバッキング・レンチを使用して、コネクタ取り付けの際の回転による損傷を防ぎます。
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4. 付属のトルク・レンチ（8 インチポンド）を使用して、ケーブル・コネクタとコネクタ・セーバの接続部を締め付け

ます。

図 3 : ケーブルの取り付け

注意： ATI 入力との接続を行なうときに、中心導体が回転してしまうと、機器が損傷する可能性があります。
必要に応じて、バッキング・レンチを 2 本使用するなどして、回転を防止してください。すべてのコネクタの締
め付け（8 インチポンド）には、付属のトルク・レンチを使用します。

5. 必要に応じて、バッキング・レンチを 2 本使用するなどして、回転を防止してください。

図 4 : 2 本目のバッキング・レンチの使用
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機器の電源の投入

1. 本機リアパネルに AC 電源コードを接続します。

2. フロントパネルの電源ボタンを押して、本機の電源をオンにします。

電源ボタンは次の 3 通りの電源状態を表します。

■ 消灯：電源オフ

■ 緑：電源オン
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機器の電源の切断

1. フロントパネルの電源ボタンを押して本機をシャットダウンします。

注： マルチ機器構成の電源をオフにする場合は、最初に Master の機器の電源をオフにします。

シャットダウン・プロセスが完了し、本機がスタンバイ・モードに移行するまでに約 30 秒かかります。Windows
の Shutdown メニューを使用してシャットダウンすることもできます。

注： 本機を即時にシャットダウンするには、電源ボタンを 4 秒間長押ししてください。この場合、保存されてい
ないデータは失われます。

2. 機器の電源を完全にオフにするには、シャットダウン実行後、電源コードを取り外します。

マルチ機器構成

機器をマルチ機器構成で接続することにより、最大 4 チャンネル、最大の帯域幅、最高サンプル・レートを持つ、ト

リガおよびサンプル・クロックが同期されたシステムを構築できます。 

機器の積み重ね

複数の機器を積み重ねて設置すると設置スペースの節約になり、またケーブルの長さも短くなるため、接続の利
便性が向上します。 

警告： 機器を上下逆さにして使用する際は、指を挟まないように十分に注意して扱ってください。
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上部の脚を標準的な向きで使用すると、
ワークベンチ上に機器を上下逆にしてに
配置するときに役立ちます。 本機の上に

OM4000 シリーズを積み重ねるときにも、

標準的な向きを使用します。 

2 台の機器を単純に積み重ねて使用す

る場合は、脚を 180 度回転させます。 

上部の脚を回転させると窪みが現れるので、上に乗せた機器の下部の脚をその部分にぴったりと収納できます。
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起動前の確認

マルチ構成された機器は、電源をオンにする前に、すべてが正しく接続されている必要があります。 機器の電源

をオンにした後に構成が変更された場合には、システムを再起動しなければならない場合があります。 

マルチ機器構成で接続されていない機器の場合は、その機器はマルチ機器モードではなく、スタンド・アロン・モ
ードで起動されます。

UltraSync™ バス・ケーブル

マルチ機器構成に対応した機器の接続には、UltraSync バス・ケーブルを使用します。 

すべてのケーブルは、機器を起動する前に接続しておく必要があります。 ケーブルを接続する前に機器の電源を

オンにした場合には、再起動を行なう必要があります。
 

 

UltraSync™ バス・ケーブル接続の手順

UltraSync バス・ケーブル・バンドルを Master に接続するには、次の手順を実行します:

1. Master として使用する機器を選択します。

Master の接続部では、各 UltraSync ケーブル・バンドル・セットを指定されたポートに接続します。（最初に To
Extension B ポートを接続した後で、3 台目の機器を接続する場合には、To Extension C ポートを使用します。さ

らに、4 台目を接続する場合は、To Extension D ポートを使用します）：

2. クロック・ケーブルを 12.5 GHz Clock Out コネクタに接続します（8 インチポンドのトルクを使用）。

3. トリガ・ケーブルを Trigger コネクタに接続します。

4. PCIe ケーブルを PCIe コネクタに接続します。
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UltraSync バス・ケーブル・バンドルを Extension に接続します。

Extension では、各 UltraSync ケーブル・バンドル・セットを指定されたポートに接続します:

1. クロック・ケーブルを 12.5 GHz Clock In コネクタに接続します（8 インチポンドのトルクを使用）。

2. トリガ・ケーブルを To Master Trigger コネクタに接続します。

3. PCIe ケーブルを PCIe コネクタに接続
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Master と Extension を接続する手順

左から右へという順序で、Extension の各機器を Master の機器に接続します（Extension B、C、D という順序）。

注： Extension と Master との接続では、デイジーチェーンではなく、スター型の配線方式を使用します。
 

 

マルチ機器システムの電源をオフにする場合は、最初に Master の機器の電源をオフにします。
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マルチ機器の電源の起動

起動プロセスを実行中、機器ではその機器がマルチ機器構成で接続されているかどうか、確認が行われます。マ
ルチ機器構成でない場合には、機器はスタンドアロン・モードで起動されます。マルチ機器構成の場合には、構成
が検証されます。有効な構成が行われていない場合には、正しく構成を行なうためのガイダンスが表示されま
す。

注： マルチ機器システムが起動されたら、ウォームアップ時間が経過するまで待ってから信号経路補正を実行し
てください。

次の図では、Extension の接続が無効であるため、接続を修正するためのガイダンスが表示されており、Master と
の接続が行われていないことが示されています。
 

 

次の図では、Master が正しく接続されていません。問題を修正するためのガイダンスが表示されており、Extension
との接続が必要であることが示されています。
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次の図では、Master と Extension が正しく接続されている状態が示されています。
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マルチ機器の接続状態の検証が完了すると、それぞれの機器には動作ステータスが表示され、Master の機器に

はそのステータスおよびタイマが表示されます。オシロスコープ・アプリケーションが起動される前に、他に変更が
必要な場合には、タイマを一時停止させます。Start Scope（オシロスコープの起動）を押すと、タイマが省略されま

す。タイマのカウントがゼロになるとオシロスコープ・アプリケーションが起動されます。
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マルチ機器構成に ATI 対応機器が含まれる場合には、ここで ATI チャンネルまたは非 ATI（TekConnect）チャンネ

ルのいずれを使用するかを選択できます。この例では、ATI チャンネルが選択されています。

注： または、すべての TekConnect チャンネルで、Time Synchronized（時間同期）モードを選択することもできます。
このモードでは、アクイジションが時間同期され、Master が、すべての TekConnect チャンネルの水平軸、レコード
長、およびトリガ設定を制御します。すべてのチャンネルが確実に同期されるようにするには、シングル・シーケン
ス・モードで、マルチ機器構成を動作させます。すべての TekConnect チャンネル・データは、プログラム可能なイン
タフェース・コマンドを使用して取得します。波形データは、Master には送信されません。時間同期モードを使用し
たい場合に、詳細な情報が必要なときは、当社営業所までお問合せください。

マルチ機器の接続状態が有効であることが確認されると、それぞれの機器には動作ステータスが表示されます。
この例では、Master（A）がチャンネル 2（ATI）で取り込みを行っています。Extension（B）はチャンネル 2（ATI）で取り込

みを行っており、チャンネル 1 として表示されています。

マスタでは、それ自身が Master として認識されているほか、取り込みが行われているチャンネルも認識されてい

ます。

（オシロスコープ上で）Configuration Application とオシロスコープの表示を切り替えるには、Alt-Tab を使用します。

Configuration Application を閉じるには、x をクリックします。x が表示されていない場合は、Configuration Application の

右上部隅をダブルクリックすると、表示されます。
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マルチ機器システムが起動されたら、信号パス補正を実行します。信号パス補正(27 ページ)を参照してくださ

い。

機器モードの切り替え

ATI、非 ATI、および時間同期の各モードを切り替えるには、次の手順を実行します。 

1. Vertical（垂直軸） > Configuration（コン

フィグレーション）メニューから、ATI、
TekConnect、または TimeSync のいず

れかを選択します。
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2. Yes（はい）をクリックして継続しま

す。

マルチ機器システムの再起動： オシロスコープの電源を切らずに、マルチ機器システムを再起動するには、次の

手順を実行します。

1. Configuration Manager およびオシロス

コープ・アプリケーションをすべてシ
ャット・ダウンした後に、コンフィグレ
ーション・モードを変更せずに File（フ
ァイル）> Restart（再起動）を選択しま

す。

ATI チャンネルと TekConnect チャンネル

ATI チャンネルは、最高水準の帯域幅およびサンプル・レートと優れたノイズ性能を提供します。 ATI チャンネルを

使用する場合には、TekConnect チャンネルは利用できません。

マルチ機器構成のステータス表示

マルチ機器構成では、チャンネル番号、オン／オフ、実行／停止、アクイジション・ステータス（Arm/Trig'D）、および

UltraSync の接続情報などのステータス情報がディスプレイに表示されます。 マスタの機器の場合には、トリガ設

定や、取り込まれ表示されているチャンネルに関する情報も表示されます。
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利用できない機能

本書で説明している機能のうち、特定のモデルまたは構成で利用できないか、または変更されているものを、次
の表に示します。

表 5 : スタンドアローン機器

機能 DPO77002SX
型

DPO75902SX
型

DPO75002SX
型

DPO73304SX
型

DPO72304SX
型

ステート（クロック・パターン）トリガ 使用不可 使用不可 使用不可

XYZ モード 使用不可 使用不可 使用不可

ATI チャンネルでの等価時間アクイジ

ション

使用不可 使用不可 使用不可

ATI チャンネルでのハイレゾとピーク検

出

使用不可 使用不可 使用不可

ATI チャンネルでの FastAcq 使用不可 使用不可 使用不可

ATI チャンネルでのロール・モード 使用不可 使用不可 使用不可

ATI チャンネルでの IRE/MV 目盛モード 使用不可 使用不可 使用不可
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表 6 : マルチユニット構成

機能 DPO77002SX
型

DPO75902SX
型

DPO75002SX
型

DPO73304SX
型

DPO72304SX
型

Extension からのライン・トリガ 使用不可 使用不可 使用不可 使用不可 使用不可

Extension からの外部トリガ 使用不可 使用不可 使用不可 使用不可 使用不可

ラント、トランジション、ウィンドウ、タイ
ムアウトのトリガ

マップド・チャ
ンネル  1

マップド・チャ
ンネル

マップド・チャ
ンネル

マップド・チャ
ンネル

マップド・チャ
ンネル

周期、周波数 マップド・チャ
ンネル

マップド・チャ
ンネル

マップド・チャ
ンネル

マップド・チャ
ンネル

マップド・チャ
ンネル

パターン（ブール） 使用不可 使用不可 使用不可 使用不可 使用不可

セットアップ／ホールド（クロックとデー
タ）

使用不可 使用不可 使用不可 使用不可 使用不可

ステート（クロック・パターン） 使用不可 使用不可 使用不可 使用不可 使用不可

トリガのロジック・クオリフィーケーショ
ン

使用不可 使用不可 使用不可 使用不可 使用不可

低速シリアル（I2C、SPI、RS232…） 使用不可 使用不可 使用不可 使用不可 使用不可

A-B トリガ非 ATI ソース 使用不可 使用不可 使用不可 使用不可 使用不可

トリガ・タイプの検証 使用不可 使用不可 使用不可 使用不可 使用不可

周波数カウンタ 使用不可 使用不可 使用不可 使用不可 使用不可

等価時間アクイジション 使用不可 使用不可 使用不可 使用不可 使用不可

FastAcq モード 使用不可 使用不可 使用不可 使用不可 使用不可

ロール・モード 使用不可 使用不可 使用不可 使用不可 使用不可

波形データベース 使用不可 使用不可 使用不可 使用不可 使用不可

リミット・テスト・オプション 使用不可 使用不可 使用不可 使用不可 使用不可

1 マップド・チャンネルとは、Extension の機器上で取り込まれたチャンネルがマスタの機器にマッピングされ、使用される機能です。
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DPO7AFP 型外部フロント・パネル（オプション）

DPO7AFP 型は、物理的なノブやボタンを使用して、DPO70000SX シリーズ・オシロスコープを制御するためのオプ

ションのプラグイン・パネルです。 DPO7AFP 型に接続するには、次の手順を実行します。 

1. TekScope アプリケーションを閉じま

す。

注： DPO7AFP 型に接続する前に、
TekScope アプリケーションを閉じてお
く必要があります。

2. DPO7AFP 型を DPO70000SX シリーズ

の USB ポートに差し込みます。

Windows OS によって認識され、必要

なドライバが組み込まれるまで待機
します。

3. TekScope アプリケーションを起動し

ます。 TekScope がパネルに接続さ

れると、パネルの LED が点灯しま

す。

4. DPO7AFP 型が動作していることを確

認するために、いずれかのチャンネ
ル・ボタンを押して、TekScope アプリ

ケーションによって選択されたチャン
ネルを有効または無効にできること
を確認します。

注： TekScope を実行中に DPO7AFP
型を取り外した場合には、まず
TekScope を終了して、DPO7AFP 型を
再接続し、次に TekScope を再起動し
て DPO7AFP 型を使用する必要があ
ります。
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本機の検査

本機は、電源投入時に自動的にパワーオン・セルフテストを実行します。

内部診断合格の確認

機器の機能を確認するには、次の手順を使用します。

1. 機器の電源を入れます。

2. Instrument Diagnostics.... を選択しま

す。

3. RUN をクリックします。診断コントロ

ール・ウィンドウにテスト結果が表示
されます。

4. すべてのテストに合格することを確
認します。診断が失敗した場合は当
社サービス担当者にご連絡くださ
い。

 機器の設置
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Windows インタフェース・ガイドライン

本機は Microsoft Windows インタフェースを搭載しているため、Windows オペレーティング・システムに自由にアクセ

スできます。Windows デスクトップにアクセスし、他の Windows アプリケーション（Microsoft Excel など）を読み込んで

実行することもできます。

オペレーティング・システムに不適切な変更を加えると、本機の操作に悪影響を及ぼすおそれがあります。設定
変更は、以下に示すガイドラインに従って慎重に行ってください。

■ Control Panel での設定変更には細心の注意が必要です。よくわからない設定を変更するのは避けてくださ

い。

■ システム・フォントを削除したり、変更したりしないでください。本機の表示に影響を及ぼすおそれがあります。

■ システムの画面プロパティの変更には注意が必要です。解像度、テキスト・サイズ、フォント、向きなどを変更
すると、ディスプレイとタッチスクリーンの操作性に影響が及びます。

■ Windows フォルダや Program Files\Tektronix\AWG70000\ フォルダの内容は変更しないでください。

■ BIOS の設定を変更しないでください。BIOS 設定を変更すると機器全体の動作に影響が及ぶことがあります。
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信号パス補正

信号パス補正（SPC）は、機器の測定精度を最高レベルに維持できるよう、定期的に実行する必要があります。な

お、機器を使用して信号を高感度（10mV/div 以下）で測定する場合は、前回の補正後の温度シフトや経過時間に

かかわらず、SPC を実行することをお勧めします。SPC を怠ると、機器が保証性能レベルを満たさないことがあり

ます。

SPC では、周囲温度の変化や長期ドリフトによって生じる DC 確度の誤差を修正します。SPC では、アクイジショ

ン・システムを最適化し、DC オフセット、およびインタリーブ校正を修正します。SPC は AC 成分を含む入力信号に

よって悪影響を受けます。

アクイジション・システムを最適化するには、次の手順を使用します:

■ 前回の信号パス補正（SPC）後に温度が 5 ℃（9 ﾟF）以上変化した場合

■ より高い感度（10mV/div 以下）で信号を測定する機器を使用して SPC を 1 週間に一度以上実行している場合

■ 前面パネルの SPC ステータスが緑色ではない場合

■ ドライブ・メディアを交換、または挿入する場合

■ 機器を Master または Extension にするかの変更など、マスタかマルチ機器システムの構成を変更する場合。

1. 前提条件：

■ Utility（ユーティリティ）>Instrument
Calibration（機器校正）

>Temperature Status is Ready（温
度ステータスが READY）となる

まで機器の電源がオンになって
いる必要があります。

■ すべてのチャンネル入力信号を
削除する必要があります。

■ 時間軸の外部リファレンスを選
択している場合は、外部リファレ
ンス信号を接続したままアクティ
ブな状態にしておきます。

 機器の設置
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2. Instrument Calibration（機器校正）を

選択します。

DPO70000SX 機器のユーティリ

ティ・メニュー

3. Temperature Status（温度ステータス）

が Ready（READY） になったら、Run
SPC （SPC を実行）をクリックして校

正を開始します。校正には 10 ～
15 分かかります。

注： SPC 校正を実行する前に、すべ
てのチャンネル入力信号を削除して
ください。

注： 現在の機器で SPC を実行して
いないドライブを使用している場合、
前の SPC がないことを示す警告メッ
セージが表示されます。このメッセー
ジが表示されたら、SPC を実行してく
ださい。
 

 

 

DPO70000SX 機器の校正メニュー
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4. 合格にならない場合は、オシロスコ
ープを再度校正するか、資格のある
サービス担当者による機器のサー
ビスを受けてください。

注： SPC ステータス・アイコンを常時
表示したり、SPC が 1 か月以上実行
されていない場合に警告を表示する
には、それぞれ該当するチェックボッ
クスをクリックします。

 

DPO70000SX 機器の校正メニュー

5. SPC アイコンが赤の場合は、信号パ

ス補正を実行します。

SPC ステータス・アイコンの色を確認

します：

■ 緑色は SPC が正常に通過し、

温度が安定していることを示し
ます。

■ 黄色は機器がウォーム・アップ・
ステートである、または SPC が

最後に実行されてから 30 日以

上が経過していることを示しま
す。

■ 赤は SPC を実行する必要があ

ることを示します（温度の変動が
5 °C より大きい、SPC に失敗し

ている、または SPC が実行され

ていない）。
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ネットワーク接続

機器をネットワークに接続して、印刷、フ
ァイル共有、インターネット・アクセスなど
の機能を利用できます。機器をネットワ
ークで使用できるように構成するには、
標準の Windows ユーティリティを使用し

ます。不明な点は、ネットワーク管理者
に問い合わせてください。 

機器をリモートから制御し表示するには
Windows のリモート・デスクトップ接続を

使用してください。 
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2 台めのモニタの追加

外部モニタで Windows やインストールされたアプリケーションを使用しながら、機器を操作できます。 デュアル・モ

ニタをセットアップするには、次の手順に従います。

1. 電源をオフにします。

2. 2 台めのモニタを接続します。

3. キーボードを接続します。

4. マウスを接続します。

5. 機器の電源をオンにします。

6. モニタの電源をオンにします。

オペレーティング・システムと製品ソフトウェアのリストア

本機に搭載の Windows オペレーティング・システムは、直接リストアすることができます。 本機にはオペレーティン

グ・システムのリストア・ディスクは付属していません。

製品ソフトウェアをリストアまたは更新するには、Tektronix Web サイトから最新版をダウンロードする必要がありま

す。

注： 製品ソフトウェアをリストアまたは更新する際、Windows オペレーティング・システムをリストアする必要はあり
ません。
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オペレーティング・システムのリストア

注意： リストア・プロセスを実行すると、ハード・ドライブが再フォーマットされ、オペレーティング・システムが再イン
ストールされます。保存されていたデータはすべて失われます。可能であれば、システムのリストアを実行する前
に、重要なファイルを外部のメディアに保存してください。

本機に搭載の Windows オペレーティング・システムは、本機のハードウェアと製品ソフトウェアに用途を限定して
提供されているものです。これとは別のバージョンの Windows は、インストールしても正しく機能しません。

オペレーティング・システムをリストアしたら、製品ソフトウェア・インストール・パッケージを当社 Web サイトからダ
ウンロードし、再インストールする必要があります。

内部リカバリ・ユーティリティ

Windows オペレーティング・システムが破損した場合は、Acronis Startup Recovery Manager を使用して Windows オペ

レーティング・システムをリストアすることをおすすめします。この Acronis ソフトウェアは、ハード・ドライブにプリイ

ンストールされているリストア・イメージを使用してオペレーティング・システムをリインストールします。

この方法ではリストア・イメージが維持されるので、何回でもリストア・プロセスを繰り返すことができます。

1. 本機にキーボードを接続します。

2. 本機を再起動します。起動プロセスが実行されている間、画面上部に次のメッセージが表示されます。

Starting Acronis Loader... press F5 for Acronis Startup Recovery Manager

注： システムのリストアが正常に行われるようにするには、Acronis ソフトウェアの Windows バージョンを使用
する必要があります。 汎用 MAC キーボードを使用して、Acronis ソフトウェアの DOS バージョンを起動します。
MAC キーボードは使用しないでください。

3. Acronis True Image Tool が開くまで、F5 キーを繰り返し押します。メッセージが表示されてから機器が通常どお

り起動するまでに 15 秒ほどかかります。Acronis アプリケーションが起動しない場合は、本機の電源を一度切

ってから入れ直し、再度同じ手順を実行してください。

4. Restore をクリックします。

5. Confirmation ダイアログ・ボックスで、Yes をクリックして本機のオペレーティング・システムをリストアします。リ

ストアせずにプロセスを終了するには、No をクリックします。リストア・プロセスには約 30 分ほどを要します

が、実際にかかる時間は機器の設定によって異なります。

製品ソフトウェアのインストール

注： DPO77002SX 型の場合は、製品ソフトウェアをご注文いただく必要があります。

1. 製品ソフトウェアのインストール・パッケージをダウンロードします。インストール・パッケージの内容は次のと
おりです。

■ 取扱説明書

■ 製品ソフトウェアのインストーラ

2. 画面の指示に従って製品ソフトウェアをインストールします。
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機器の詳細

フロントパネル・コネクタ

図 5 : ATI チャンネルと TekConnect チャンネル
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図 6 : TekConnect チャンネル

表 7 : フロントパネル・コネクタ

識別子 コネクタ 概要

1 USB 2.0 USB コネクタ が 4 つあります。

2 シャーシ・グランド バナナ・プラグでグランド接続します。

1 MΩ の抵抗を通じたグランド端子 バナナ・プラグでグランド接続します。
ケーブルおよび TekConnect アダプタの取り付けまたは取り

外しの際には、接地された帯電防止リスト・ストラップを付け
て、人体から静電気を放電します。

3 DC プローブ校正 DC プローブ校正出力

4 1、2、3、および 4（アナログ入力） これらのコネクタはアナログ信号を供給します。

5 Aux In 補助トリガ入力

6 差動高速エッジ 高速エッジの差動ステップ信号を出力します。
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リア・パネル・コネクタ

表 8 : リア・パネル・コネクタ

コネクタ 概要

PCIe PCIe ポート（外部デバイスの接続やマルチ機器システムの構成に使用可能）

12.5 GHz クロック入力 SMA 型コネクタ。マルチ機器構成で使用される外部クロック信号を出力します。

12.5 GHz クロック出力 SMA 型コネクタ。サンプル・レートに関与する高速クロック信号を出力します。 このクロックはマ

ルチ機器構成で使用されます。

トリガ UltraSync トリガ・バス

LAN 本機をネットワークに接続する RJ-45 コネクタ。

USB 3.0 マウス、キーボード、その他の USB デバイスを接続できるよう、USB 3.0 Host コネクタ（タイプ A）
を 4 基搭載。付属のマウスおよびキーボード以外の USB デバイスについては、当社がサポート

やデバイス・ドライバを提供することはありません。

USB USB デバイス・コネクタ

VGA 拡張デスクトップ操作用のモニタの接続に使用する VGA ポート。DVI モニタを VGA コネクタに接

続するには、VGA-DVI アダプタを使用してください。

DVI-D DVI-D ビデオ・ポートを使用して、プロジェクタやフラットパネル LCD モニタに機器の表示画面を

送ります。

ディスプレイ・ポート デジタル・ディスプレイ・インタフェースを提供します。

PS/2 マウス このコネクタは PS/2 マウスに使用します。

PS/2 キーボード このコネクタは PS/2 キーボードに使用します。

オーディオ ライン出力、ライン入力、マイク入力用のコネクタ。

補助出力 SMA 型コネクタは、機器がトリガされたり、マスク・テストのエラーまたは完了といった、その他

の特定のイベントが発生したときに、TTL 互換の負極性パルスを出力します。

リファレンス出力 外部デバイスへ同期信号を出力する SMA 型コネクタ

外部リファレンス入力 SMA 型コネクタ。外部リファレンス・クロック入力を出力します。

電源 電源コード入力。
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インタフェースおよびディスプレイ

メニューバー・モードを使用すると、機器のすべての機能を管理するコマンドにアクセスできます。 ツールバー・モ

ードを使用すると、最も頻繁に使用する機能にアクセスできます。

1. メニュー・バー： データ I/O、印刷、オ

ンライン・ヘルプ、および機器の諸機
能にアクセスします

2. ボタン / メニュー： クリックして、ツー

ルバー・モードとメニュー・バー・モー
ドを切り換えます

3. 汎用ノブのリードアウト： 汎用ノブを

使用して制御するパラメータの調整
と表示を行います

4. ディスプレイ： ライブ波形、リファレン

ス波形、演算波形、およびバス波形
がカーソルと共に表示されます。

5. 波形ハンドル： クリックおよびドラッ

グして、波形またはバスの垂直位置
を変更します。ハンドルをクリックし、
汎用ノブを使用して位置とスケール
を変更します。

6. コントロール・ステータス： 垂直選

択、スケール、オフセット、およびパ
ラメータをすばやく参照できます 一
部のプローブ・チップについてはプロ
ーブ・ステータスも参照できます。

7. リードアウト： この領域には、カーソ

ルと測定リードアウトが表示されま
す。測定は、メニュー・バーまたはツ
ールバーから選択できます。 コント

ロール・ウィンドウが表示されると、
いくつかのリードアウトの組み合わ
せが目盛領域に移動します

警告： 垂直方向にクリッピングされた場合、リードアウトに電圧が低く表示されていても、プローブ・チップには

危険な電圧がかかっていることがあります。垂直方向にクリッピングされた場合は、  記号がリードアウトに表
示されます。振幅関連の自動測定で、信号が垂直方向にクリッピングされた場合は測定結果が不正確になり
ます。またクリッピングされると、他のプログラムで使用するためにエクスポートしたり保存したりした波形の振
幅値が不正確になります。演算波形がクリッピングされている場合、その演算波形の振幅測定には影響を与
えません。

 

8. Status：アクイジション・ステータス、モード、アクイジション数、トリガ・ステータス、日付、時間を表示し、レコ

ード長や垂直パラメータもすばやく参照できます。
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1. ボタン / メニュー： クリックして、ツー

ルバー・モードとメニュー・バー・モー
ドを切り換えます

2. カーソルをドラッグして、画面上の波
形を測定します

3. 位置のアイコンをドラッグして、波形
を移動します

4. アイコンをクリックして、汎用ノブを波
形の垂直位置 / スケールに割り当て

ます

5. 波形領域を斜めにドラッグして、ズ
ーム、ヒストグラムの有効化／無効
化、ゲート測定を行うためのボックス
の作成、およびビジュアル・トリガの
追加と制御を実行できます

6. アイコンをドラッグして、トリガ・レベ
ルを変更します

 機器の詳細
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コントロール・パネル

注： これらのコントロールは、外部フロント・パネル・アクセサリで利用できます。 これらのコントロールが実行する
機能は、機器のメニューでも利用できます。

1. 選択されたチャンネルに基づいて、
自動的に垂直、水平、トリガのコント
ロールをセットアップする場合に押し
ます。

2. 設定をデフォルト値に戻す場合に押
します。

3. ハードコピーの印刷またはスクリー
ンの取り込みを行う場合に押しま
す。

4. MultiView Zoom 機能をオンにして、デ

ィスプレイに拡大目盛を追加する場
合に押します。

5. すべての波形の水平方向のスケー
ル、位置、遅延を調整したり、レコー
ド長（分解能）を設定します。

6. アクイジションを開始／停止したり、
シングル・アクイジション・シーケンス
の開始、データのクリア、または高
速アクイジションを実行する場合に
使用します。

7. トリガ・パラメータの設定に使用しま
す。 Advanced を押して、追加のトリ

ガ機能を表示します。 Arm（動作可

能）、Ready（準備完了）、および

Trig'D（トリガ済み）ライトがアクイジシ

ョン・ステータスを示します。

8. 波形の輝度を調整する場合に回し
ます。

9. 画面インタフェースで選択したパラメ
ータを調整する場合に回します。 押
すと、粗調整と微調整を切り替えで
きます。

10. カーソルのオン/オフを切り替える場

合に押します。
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11. 波形の検索およびマークに使用しま
す。

12. このボタンはタッチ・スクリーンのオ
ンとオフを切り替える場合に押しま
す。

13. チャンネル表示のオン/オフを切り替

えます。 波形の垂直方向のスケー

ルや位置、オフセットの調整を行い
ます。 位置とオフセットを切り替えま

す。

 機器の詳細
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オンライン・ヘルプへのアクセス

オンライン・ヘルプでは、機器のすべての機能に関する詳しい情報を参照できます。

アクティブ・ウィンドウに関する状況に応
じたヘルプを利用するには、Help > Help
on Window... を選択するか、または F1 を
押します。 

1. ヘルプ・システム内の任意のトピック
を参照するには、Help > Contents
and Index... を選択します。

2. Contents、Index、または Find タブを使

用してトピックを選択し、Display をク

リックします。

ヘルプ・システム内を移動するには、次
の操作を行います。 

■ ヘルプ・ウィンドウ内のボタンをクリッ
クすると、概要と個別のトピックの表
示を切り換えることができます。

■ 機器を操作できるようにヘルプを非
表示にする場合は、ヘルプ・ウィンド
ウの Minimize ボタンをクリックしま

す。

■ 直前に表示したヘルプ・トピックをも
う 1 度表示するには、Alt キーおよび

Tab キーを押します。
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メニューおよびコントロール・ウィンドウへのアクセス

次の手順を使用して、メニューやコントロール・ウィンドウにアクセスできます。

■ メニューをクリックし、コマンドを選択
します。

 

■ ショートカット・メニューを表示するに
は、目盛内の任意の場所またはオ
ブジェクトを右クリックします。ショー
トカット・メニューは状況依存である
ため、右クリックした領域またはオブ
ジェクトに応じてメニューが異なりま
す。いくつかの例を右の図に示しま
す。

 

■ ツールバー・モードで、ボタンをクリッ
クすると、セットアップ・コントロール・
ウィンドウにすばやくアクセスできま
す。（インタフェースおよびディスプレ
イを参照）。

 

 機器の詳細
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機器の検査

機器の機能を確認するには、次の手順を使用します。

内部診断合格の確認

1. 機器の電源を入れます。

2. Instrument Diagnostics... を選択しま

す。

3. Run をクリックします。診断コントロー

ル・ウィンドウにテスト結果が表示さ
れます。

4. すべてのテストに合格することを確
認します。診断が失敗した場合は当
社サービス担当者にご連絡くださ
い。
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Acquisition
このセクションでは、アクイジション・システム使用の概念と手順について説明します。

信号パス補正

信号パス補正（SPC）は、機器の測定精度を最高レベルに維持できるよう、定期的に実行する必要があります。な

お、機器を使用して信号を高感度（10mV/div 以下）で測定する場合は、前回の補正後の温度シフトや経過時間に

かかわらず、SPC を実行することをお勧めします。SPC を怠ると、機器が保証性能レベルを満たさないことがあり

ます。

SPC では、周囲温度の変化や長期ドリフトによって生じる DC 確度の誤差を修正します。SPC では、アクイジショ

ン・システムを最適化し、DC オフセット、およびインタリーブ校正を修正します。SPC は AC 成分を含む入力信号に

よって悪影響を受けます。

アクイジション・システムを最適化するには、次の手順を使用します:

■ 前回の信号パス補正（SPC）後に温度が 5 ℃（9 ﾟF）以上変化した場合

■ より高い感度（10mV/div 以下）で信号を測定する機器を使用して SPC を 1 週間に一度以上実行している場合

■ 前面パネルの SPC ステータスが緑色ではない場合

■ ドライブ・メディアを交換、または挿入する場合

■ 機器を Master または Extension にするかの変更など、マスタかマルチ機器システムの構成を変更する場合。

1. 前提条件：

■ Utility（ユーティリティ）>Instrument
Calibration（機器校正）

>Temperature Status is Ready（温
度ステータスが READY）となる

まで機器の電源がオンになって
いる必要があります。

■ すべてのチャンネル入力信号を
削除する必要があります。

■ 時間軸の外部リファレンスを選
択している場合は、外部リファレ
ンス信号を接続したままアクティ
ブな状態にしておきます。
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2. Instrument Calibration（機器校正）を

選択します。

DPO70000SX 機器のユーティリ

ティ・メニュー

3. Temperature Status（温度ステータス）

が Ready（READY） になったら、Run
SPC （SPC を実行）をクリックして校

正を開始します。校正には 10 ～
15 分かかります。

注： SPC 校正を実行する前に、すべ
てのチャンネル入力信号を削除して
ください。

注： 現在の機器で SPC を実行して
いないドライブを使用している場合、
前の SPC がないことを示す警告メッ
セージが表示されます。このメッセー
ジが表示されたら、SPC を実行してく
ださい。
 

 

 

DPO70000SX 機器の校正メニュー
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4. 合格にならない場合は、オシロスコ
ープを再度校正するか、資格のある
サービス担当者による機器のサー
ビスを受けてください。

注： SPC ステータス・アイコンを常時
表示したり、SPC が 1 か月以上実行
されていない場合に警告を表示する
には、それぞれ該当するチェックボッ
クスをクリックします。

 

DPO70000SX 機器の校正メニュー

5. SPC アイコンが赤の場合は、信号パ

ス補正を実行します。

SPC ステータス・アイコンの色を確認

します：

■ 緑色は SPC が正常に通過し、

温度が安定していることを示し
ます。

■ 黄色は機器がウォーム・アップ・
ステートである、または SPC が

最後に実行されてから 30 日以

上が経過していることを示しま
す。

■ 赤は SPC を実行する必要があ

ることを示します（温度の変動が
5 °C より大きい、SPC に失敗し

ている、または SPC が実行され

ていない）。
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アナログ信号入力のセットアップ

ドロップ・ダウン・メニューまたは外部フロント・パネルを使用して、信号を取り込むように機器を設定します。

ドロップ・ダウン・メニューを使用する場合は、次の手順を実行します。

プローブまたはケーブルを入力信号ソー
スに接続します。

注意： 機器の損傷を防ぐため、機器への
接続作業の際には必ず帯電防止リスト・
ストラップを着用し、入力コネクタに対す
る最大入力電圧の定格を順守してくださ
い。

 

入力チャンネルを選択するには、次の手
順を実行します。 Vertical > Vertical Setup
を選択します。 選択したいチャンネルの

タブを選択し、Display ボタンを押して、チ

ャンネルのオン／オフを切り替えます。  

Horiz/Acq > Autoset を選択します。  

Vertical > Vertical Setup を選択します。 垂
直位置、スケールおよびオフセットを調
整するには、次の手順を実行します。
Position、Scale、Offset のコントロールをダ

ブルクリックし、ポップアップ・キーパッド
を使用して、調整を行います。 
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Horiz/Acq > Horizontal/Acquisition Setup
を選択します。 水平位置およびスケール

を調整します。 Position および Scale のコ

ントロールをダブルクリックし、ポップアッ
プ・キーパッドを使用して、調整を行いま
す。 

水平位置により、プリトリガとポストトリガ
のサンプル数が決定されます。  

外部フロント・パネルを使用する場合は、次の手順を実行します。

1. プローブまたはケーブルを入力信号
ソースに接続します。

注意： 機器の損傷を防ぐため、機器
への接続作業の際には必ず帯電防
止リスト・ストラップを着用し、入力コ
ネクタに対する最大入力電圧の定
格を順守してください。

2. 入力チャンネルを選択します。

3. Horiz/Acq、次に Autoset を選択しま

す。

4. 垂直位置、スケール、およびオフセ
ットを調整します。

 Acquisition
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5. 水平位置およびスケールを調整しま
す。

水平位置により、プリトリガとポストト
リガのサンプル数が決定されます。  

デフォルト設定の使用

1. 設定を出荷時デフォルト設定にすば
やく戻すには、File メニューから

Recall Default Setup を選択するか、

または体部フロント・パネルの
DEFAULT SETUP を押します。
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オートセットの使用

オートセットを使用すると、入力信号の特性に基づいて、機器（アクイジション、水平軸、トリガ、垂直軸）をすばや
く自動的に設定できます。 オートセットでは、波形に 2 つまたは 3 つのサイクルと中間レベル付近のトリガを表示

するように信号が調整されます。

1. プローブを接続し、入力チャンネル
を選択します。（アナログ信号入力
のセットアップ(48 ページ)を参照）。

2. オートセットを実行するには、Horiz/
Acq、Autoset を選択するか、または

外部フロント・パネルで AUTOSET ボ
タンを押します。

3. 直前のオートセットをやり直すには、
Undo をクリックします。オートセット

によって影響されないパラメータの
設定は変更されません。

ヒント

■ オートセットは、アナログ・チャンネルを自動的にセットアップします。

■ iCapture 搭載機では、オートセットにより自動的に iCapture チャンネルが設定されます。

■ オートセットでは、波形の位置を適切に調整するために垂直軸位置が変更される場合があります。また、オ
ートセットでは、垂直オフセットが調整される場合もあります。

■ 1 つまたは複数のチャンネルが表示されているときに Autoset（オートセット）を実行すると、機器は最も数の小

さいチャンネルを水平スケールおよびトリガに選択します。各チャンネルの垂直スケーリングは個別に操作で
きます。

■ チャンネルが表示されていないときにオートセットを実行すると、機器はチャンネル 1 （Ch 1）をオンにし、チャ

ンネル 1 をスケーリングします。

■ X をクリックして、Autoset Undo コントロール・ウィンドウを閉じます。Autoset Undo が閉じても、Edit メニューから

Undo Last Autoset コマンドを選択して、直前のオートセットを元に戻すことができます。

■ Utilities メニューの User Preferences を変更することにより、自動的に Autoset Undo コントロール・ウィンドウが表

示されないようにできます。
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プローブの補正およびデスキュー

測定精度を最適化するには、機器のオンライン・ヘルプを参照して、次の手順を実行します。

■ 受動プローブの補正

■ アクティブ・プローブの補正

■ 入力チャンネルのデスキュー

アクイジションの概念

アクイジション・ハードウェア

信号を表示するには、信号が入力チャンネルを通過し、そこでスケーリングおよびデジタル化される必要がありま
す。各チャンネルには、専用の入力増幅器とデジタイザが備えられています。 各チャンネルでデジタル・データ・

ストリームが生成され、そのデータから波形レコードが抽出されます。

サンプリング処理

アクイジションは、アナログ信号をサンプ
リングしてデジタル・データに変換し、そ
れを波形レコードにまとめる処理です。
作成された波形レコードは、アクイジショ
ン・メモリに格納されます。 

リアルタイム・サンプリング

リアルタイム・サンプリングでは、1 つのト

リガ・イベントを使用して取り込んだポイ
ントをすべてデジタル化します。単発現
象や過渡的現象を取り込む場合は、リア
ルタイム・サンプリングを使用します。 

補間リアルタイム・サンプリング

補間リアルタイム・サンプリングでは、
1 つのトリガ・イベントを使用して取り込ん

だポイントをすべてデジタル化します。機
器が最大リアルタイム・サンプル・レート
で完全な波形を表すのに十分なサンプ
ルを取得できない場合は、サンプルが補
間されます。単発現象や過渡現象を取り
込む場合は、補間リアルタイム・サンプリ
ングを使用します。 
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等価時間サンプリング

機器のリアルタイム・サンプリングの最大
サンプリング・レートよりも速いレートでサ
ンプリングするには、等価時間サンプリ
ングを使用します。等価時間サンプリン
グは、Equivalent Time（等価時間）が選択

されていて、リアルタイム・サンプリング
を使用して波形のレコードを作成するの
に速すぎるサンプリング・レートにタイム・
ベースが設定されている場合にのみ使
用されます。 

機器は、波形を複数回取り込むことで、
完全な波形レコードの作成に必要なサン
プル密度を取得します。つまり、等価時
間サンプリングは、反復信号にだけ使用
します。 

波形レコード

機器は、次のパラメータを使用して、波
形レコードを生成します。 

■ サンプル・インターバル：サンプル・
ポイント間の間隔。

■ レコード長：波形レコードの生成に必
要なサンプル数。

■ トリガ・ポイント：波形レコード内の時
刻ゼロの基準。

■ 水平軸上の位置：水平遅延がオフ
の場合、水平位置は、で示される波
形レコードの割合（0 ～ 99.9%）です。

トリガ・ポイントと水平基準ポイント
は、波形レコード内の同じ時間にな
ります。たとえば、水平位置が 50 パ
ーセントである場合は、トリガ・ポイ
ントは、波形レコードの中央になりま
す。水平遅延がオンの場合は、トリ
ガ・ポイントから水平基準の時間が
水平遅延となります。
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補間方式

この機器では、取込んだサンプルの間を補間できます。補間は、波形レコードに必要な実際のサンプルが不足し
ている場合に行われます。直線補間法は、直線適合を使用して、実際の取込みサンプルの間のレコード・ポイント
を計算します。

Sin(x)/x 補間法は、曲線適合を使用して、実際の取込み値の間のレコード・ポイントを計算します。 Sin(x)/x 補間法

はデフォルトの補間モードです。これは、波形を正確に表わすのに必要なサンプル・ポイントが直線補間法より少
ないためです。

アクイジション・モードの仕組み

Acquisition Mode
Sample（サンプル）モードでは、各アクイジシ

ョン・インターバルからサンプリングされた最
初のポイントが保持されます。 デフォルトの

アクイジション・モードはサンプルです。

Peak Detect（ピーク検出）モードでは、連続し

た 2 つのアクイジション・インターバルに含ま

れるすべてのサンプルのうち最大のサンプ
ルと最小のサンプルが使用されます。 この

モードは、補間のないリアルタイム・サンプリ
ングでのみ使用でき、高周波数のグリッチを
捕捉するのに便利です。

Hi Res（ハイレゾ）モードでは、各アクイジショ

ン・インターバルのすべてのサンプルの平均
が算出されます。 ハイレゾは、高分解能で

低帯域幅の波形を表示します。

エンベロープ・モードでは、多数のアクイジシ
ョンから最高レコード・ポイントと最低レコー
ド・ポイントが特定されます。 エンベロープ・

モードでは、各アクイジションにピーク検出を
使用します。

アベレージ・モードでは、多数のアクイジショ
ンの各レコード・ポイントについて平均値が
算出されます。アベレージ・モードでは、各ア
クイジションにサンプル・モードを使用しま
す。 アベレージ・モードを使用すると、不規

則ノイズが減少します。

Waveform Database モードは、複数のアクイ

ジションで取込んだソース波形データを 3 次
元的に累積します。 このデータベースには、

振幅とタイミングに関する情報に加えて、特
定の波形ポイント（時間および振幅）の取り
込み回数も含まれます。
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拡張有効ビット数をオンにする

Acquisition タブのこのコントロールは、拡張有効ビット数（ENOB）のオン／オフを切り替えて、波形詳細度を最適化

するために使用します。 
 

 

1. ENOB のオン／オフを切り替えるには、Enhanced Effective Number of Bits チェック・ボックスをクリックします。こ

のコントロールは、Horizontal/Acquisition コントロール・ウィンドウの Acquisitions タブにあります。

拡張有効ビット数は、インターリーブ補正 DSP を有効にし、有効ビット数を改善します。このコントロールは、一部

の機器モデルでのみ使用できます。このコントロールは、Hi Res モードでは使用できません。

拡張有効ビット数がオンの場合、水平／アクイジション・リードアウトに EB+ が表示されます。
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アクイジション・モードの変更

アクイジション・モードを変更するには、次の手順を使用します。

1. Horiz/Acq > Acquisition Mode を選択

します。

2. アクイジション・モードを選択するに
は、次のいずれかの操作を行いま
す。

■ メニューからアクイジション・モー
ドを直接選択します。

■ Mode..., をクリックして、アクイジ

ション・モードを選択します。

 

3. 平均アクイジション・モードおよびエ
ンベロープ・アクイジション・モードの
場合は、# of Wfms（波形数）コントロ

ールをクリックしてから、汎用ノブで
波形の数を設定します。 波形データ

ベース・モードでは、Samples コント

ロールをクリックしてから、汎用ノブ
でサンプルの数を設定します。

ヒント

■ 波形またはサンプルの数を設定するには、キーパッド・アイコンをクリックします。
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アクイジションの開始および停止

取り込みチャンネルを選択したら、次の手順を実行します。

1. アクイジションを開始するには、
Horiz/Acq > Run/Stop を選択して Run/
Stop をクリックするか、外部フロント・

パネルの RUN/STOP ボタンを押しま

す。

2. アクイジションを停止するには、Run/
Stop をもう一度クリックするか、また

は RUN/STOP ボタンを押します。

3. 単発のアクイジションを取得するに
は、Single Sequence をクリックする

か、Single ボタンを押します。
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水平モードの選択

この機器には 3 つの水平モードがあります。デフォルトでは、自動が設定されていますので、 テスト・セットアップ

に最適な水平モードを選択してください。

水平モードを設定するには、Horiz/Acq >
Horizontal/Acquisition Setup を選択し、水

平軸コントロール・ウィンドウを表示しま
す。次に、以下のモードのいずれかを選
択します。 

Automatic モードでは、スケールとサンプ

ル・レートを設定できます。レコード長は
従属変数です。スケールの値が変わるこ
とによってレコード長がその制限値を超
えると、サンプル・レートは次のレベルの
設定値に下がります。 

サンプリング・モードがリアルタイムで、
サンプル・レートがリアルタイム制限値の
場合、サンプル・レートを増やそうとして
も効果はありません。 

レコード長の制限値を設定するには、
Record Length Limit をクリックし、ボタン

またはキーパッドで制限値を設定しま
す。デフォルトの最大制限値は、機器の
モデルとレコード長オプションによって異
なります。 
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Constant Sample Rate モードでは、サンプ

ル・レートとスケールを設定できます。デ
フォルトのサンプル・レートを使用すれ
ば、帯域幅フィルタの操作を確実に行う
ことができます。レコード長は従属変数
です。最大レコード長は、機器のモデル
とレコード長オプションによって異なりま
す。 

外部フロント・パネルの分解能ノブを使
用すると、Automatic モードと Constant
Sample Rate モードの両方でサンプル・レ

ートを調節できます。 

Manual モードでは、サンプル・レートとレ

コード長を設定できます。水平スケール
は従属変数で、サンプル・レートとレコー
ド長から計算されます。 

Manual モードでは、水平スケール・ノブを

使ってレコード長を調整します。 

ここで示すように、3 つのモードはすべ

て、サンプル・レート、スケール、および
レコード長と連動しています。水平ライン
は、最大リアルタイム・サンプル・レートで
す。階段状の各ラインは、スケールを増
やすと、サンプル・レートは、最大レコー
ド長または設定したレコード長制限値に
達したときに小さくなっていかなければな
らないことを示しています。Manual モード

は、最大レコード長を使用します。 

Automatic モードと Constant Sample Rate モ
ードはまったく同じです。ただし、Constant
Sample Rate モードの場合、サンプル・レ

ートは、帯域幅拡張フィルタが確実に使
用されるレートに保たれています。 
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FastAcq の使用

高速アクイジション・モードでは、波形のアクイジションが行われる間のデッド・タイムが短縮されるため、グリッチ
やラント・パルスなどの過渡的イベントであっても、取り込み、表示することができます。 また、高速アクイジショ

ン・モードでは、発生頻度に応じた輝度で波形現象を表示できます。 FastAcq は ATI チャンネルでは利用できませ

ん。

1. オプションのフロント・パネルで
FastAcq を選択するか、または Horiz/
Acq > Fast Acquisition を選択しま

す。

2. グリッチ、トランゼント、その他の不
規則なイベントを探します。

異常を発見したら、それを観測する
ためのトリガ・システムをセットアップ
します。（間欠的に発生する異常の
取り込み(173 ページ)を参照）。 

ヒント

■ 詳細情報または稀にしか発生しないイベントを最も効果的に取り込むには、Horiz/Acq > Horizontal/Acquisition
Setup > Acquisition> Fast Acq を選択し、次に、Optimize For Capturing Details または Capturing rare events を選

択します。
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DSP 拡張帯域幅の使用

機器が拡張帯域幅機能を備えている場合は、より正確な立上り時間測定を実行するために、デジタル信号処理
（DSP）拡張帯域幅を使用して帯域幅を拡大し、最大のサンプル・レートにおけるパスバンドをフラット化します。 拡
張帯域幅を使用すると有効チャンネル全体に適合した応答が可能になるため、チャンネル間の比較測定および
差動測定を行うことができます。

1. AUTOSET を使用して、水平、垂直、

およびトリガのコントロールを設定す
るか、または手動でコントロールを
設定します。

2. Vertical > Bandwidth Enhanced... を選

択します。

 Acquisition

DPO70000SX シリーズ・ユーザ 61



3. Digital Filters (DSP) Enabled をクリッ

クして、拡張帯域幅をオンにします。
DSP を有効にするには、サンプル・

レートを正しく設定する必要がありま
す。

4. DSP フィルタが有効になるよう一定

のサンプル・レートを強制的に確保
するには、Force Constant Sample
Rate チェック・ボックスをオンにしま

す。

注： まだ設定されていない場合に
Constant Sample Rate を選択すると、
一定のサンプル・レートが確保され
るよう水平モードが設定されます。こ
のサンプル・レートは DSP が有効に
なるように設定され、さらに、DSP 帯
域幅が選択されます。

 

5. 目的の帯域幅を Bandwidth リストか

ら選択します。

選択できる利用可能な帯域幅は、機
器、プローブ、およびプローブ・チッ
プによって異なります。 

Analog Only を選択すると、ハードウェ

ア（HW）帯域幅が選択されます。 

6. 選択した内容をすべてのチャンネル
に適用するには、Apply To All
Channels チェック・ボックスをオンに

します。

プロービングが異なっているため同
じように設定できないチャンネルが
ある場合、各チャンネルの帯域幅
は、選択した内容に一番近い値が
設定されます。 

拡張帯域幅がオンになると、垂直リード
アウトに帯域幅インジケータが表示され
ます。 

ヒント

■ 波形ハンドルを右クリックするとメニューが表示され、チャンネル帯域幅とその他の帯域幅拡張設定を選択で
きます。

■ DSP 拡張帯域幅は、最大のサンプル・レートで発生します。

■ 信号の立上り時間が 50 ps 未満の場合に、DSP 拡張帯域幅を使用してください。
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■ より高い波形スループットが必要な場合、オーバードライブ信号の場合、Analog Only を選択します。

■ Vertical > Bandwidth Limit を選択してから帯域幅を選択すると、機器の帯域幅を制限できます。

 Acquisition

DPO70000SX シリーズ・ユーザ 63



ターミネーション電圧の選択

従来のオシロスコープ入力は、グランドに終端されていました。 しかし、測定される信号がグランドを基準としてい

ない場合がよくあります。 信号をグランドに落とすと測定結果に悪影響を与えたり、DUT が損傷してしまう可能性

もあります。 また、ターミネーション電圧は TekConnect チャンネルでは利用できますが、ATI チャンネルでは利用で

きません。

本機は、±3.4 V までの可変ターミネーション電圧を被測定デバイス（DUT）に供給し、また幅広いオフセット電圧を

サポートできます。 これにより、DUT の条件や動作をオシロスコープで反映させることができ、DUT の実際の動作

に近い環境で高速信号を測定することができます。

ターミネーション電圧とオフセットを組み合わせて、オシロスコープの基準ポイントを DUT の動作範囲の中央に合

わせることにより、ダイナミック・レンジを最大化し、測定システムのノイズを最小化することができます。

チャンネルのターミネーション電圧を設定するには、次の手順を実行します。

1. Vertical > Vertical Setup を選択しま

す。

2. Termination Voltage フィールド内をク

リックします。 キーパッドまたは汎用

ノブを使用して、ターミネーション電
圧を設定します。

Acquisition  

64  DPO70000SX シリーズ・ユーザ



ロール・モードの使用

ロール・モードは、低周波信号をストリップ・チャート・レコーダのように表示できます。 ロール・モードを使用する

と、完全な波形レコードが取込まれるのを待たずに、取込んだデータ・ポイントが表示されます。

1. Horiz/Acq > Horizontal/Acquisition
Setup... を選択します。

2. 選択されていない場合には、
Acquisition タブをクリックします。

Auto（オート）をクリックし、ロール・モ

ードをオンにします。

注： ロール・モードでは、サンプル、
ピーク検出、またはハイレゾのアクイ
ジション・モードを使用する必要があ
ります。

 

3. ロール・モードでのアクイジションを
停止するには

■ シングル・シーケンスでない場
合は、Horiz/Acq > Run/Stop を選

択して Run/Stop をクリックする

か、または外部フロント・パネル
で RUN/STOP を押して、ロール・

モードを停止します。

■ シングル・シーケンスの場合
は、完全なレコードが読み込ま
れると、ロール・モード・アクイジ
ションが自動的に停止します。

 

ヒント

■ エンベロープ、アベレージ、波形データベース・アクイジション・モードに切り換えても、ロール・モードはオフに
なります。

■ 水平スケールを 50 ms/div 以上に設定しても、ロール・モードは無効になります。
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バスのセットアップ

シリアル・バス（オプション）およびパラレル・バスのセットアップが行えます。

1. Vertical > Bus Setup を選択します。

2. Config タブを選択します。

3. スクロールして、セットアップするバ
スを選択します。

4. バスの表示をオンまたはオフに切り
替えるには、Bus ボタンをクリックし

ます。

5. バスのデフォルトのラベルを変更す
るには、Label をクリックし、キーボー

ドで新しいラベルを入力します。

6. バスの表示位置を変更するには、
Bus Position をクリックし、キーボード

または汎用ノブで新しいバスの位置
を入力します。
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7. バス・タイプを選択するには、Bus
Type の Serial または Parallel をクリッ

クします。

いずれのバス・タイプも設定できま
す。 

シリアル・バスのセットアップ(68 ペ
ージ)を参照してください。またはパラ
レル・バスのセットアップ(70 ペー

ジ)を参照してください。 

ヒント

■ バス・ハンドルまたは波形ハンドル上でクリックし、そのハンドルを目的の位置にドラッグすることで、バスまた
は波形を配置します。
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シリアル・バスのセットアップ

シリアル・バス（オプション）のパラメータの設定は次のように行います。 

1. シリアル・バスをセットアップするに
は、Bus Type の Serial を選択し、ドロ

ップダウン・リストからシリアル・バス
のタイプを選択します。

バスのタイプによって設定できるパ
ラメータが異なります。選択したバス
に従って、適切な他のバス・タイプを
セットアップします。 

バスのセットアップの詳細について
は、オンライン・ヘルプを参照してく
ださい。 

2. 表示されたバスのコンポーネントに
対する入力を選択するには、コンポ
ーネントの Input フィールドをクリック

し、表示されたリストから選択しま
す。

3. 入力のスレッショルドを設定するに
は、Threshold フィールドをダブルクリ

ックし、キーパッドでスレッショルドを
入力します。

注： 現在共通になっているスレッショ
ルドを個別に設定する場合は、Trig
> A Event (Main) Trigger Setup に移動
して、Settings を Independent に変え
ます。

 

4. 表示されたバスのコンポーネントに
対する極性を選択するには、コンポ
ーネントの Polarity フィールドをクリッ

クし、表示されたリストから選択しま
す。
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ヒント

■ カスタム・シリアル・デコーダを使用する場合は、オンライン・ヘルプを参照してください。
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パラレル・バスのセットアップ

パラレル・バスのパラメータの設定は次のように行います。 

1. パラレル・バスを設定するには、Bus
Type で Parallel を選択します。

バスのセットアップの詳細について
は、オンライン・ヘルプを参照してく
ださい。 

2. バスのソースを追加するには、Add
Sources の Select ボタンをクリックし

ます。

3. バスに含める各チャンネルのボタン
をクリックします。パラレル・バスの
順序はチャンネルを選択した順で決
まります。

4. OK ボタンをクリックします。

5. バス内のチャンネルを移動するに
は、移動するチャンネルまでスクロ
ールして選択し、上矢印または下矢
印ボタンをクリックします。

6. バス内のチャンネルを削除するに
は、削除するチャンネルまでスクロ
ールして選択し、Remove ボタンをク

リックします。

7. チャンネルのスレッショルドを設定す
るには、Thresholds の Setup ボタンを

クリックします。
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8. 設定するスレッショルドごとに、チャ
ンネルの Threshold をダブルクリック

し、オプションの外部フロント・パネ
ルのキーパッドまたは汎用ノブを使
用して、スレッショルドを入力します。

9. 目的のスレッショルドを設定したら、
OK ボタンをクリックします。

10. クロックのソースおよび極性を設定
するには、該当する項目をダブルク
リックし、表示されたリストから選択
します。 クロックのレベルを設定する

には、Clock Level をダブルクリック

し、オプションの外部フロント・パネ
ルのキーパッドか汎用ノブを使用し
てレベルを入力します。
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バスの表示のセットアップ

バス・スタイルおよびデコーディングの設定が行えます。 

1. Vertical > Bus Setup を選択します。

2. Display タブを選択します。

3. バスを選択するには、スクロールし
てバスを表示し、バスを選択します。

4. バス・デコーディングのリストからデ
コーディングを選択します。

Results Table の詳細についてはオン

ライン・ヘルプを参照してください。 

5. + ボックスをクリックしてビューを展開

するか (下位項目を表示する) 、また

は - ボックスをクリックしてビューを

折り畳みます (下位項目を表示しな

い) 。

6. ディスプレイの + ボックスまたは - ボ
ックスをクリックすることによって、バ
ス・ビューを追加したり削除すること
もできます。使用可能なビューとして
は、トランザクション／トランスポー
ト、リンク／フレーミング／パケット、
物理／バイト／シンボル、およびビ
ット・レベルがあります。
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7. シンボル・テーブルを使用する場合
は、Use Symbol File チェックボックス

をオンにします。Browse をクリックし

て、シンボル・テーブル・ファイルを
選択します。

バスによっては他の設定ができるも
のもあります。バスに応じて他の設
定も行います。 

バスのセットアップの詳細について
は、オンライン・ヘルプを参照してく
ださい。 

FastFrame モードの使用

FastFrame を使用すると、多くのトリガ・イベントを単一のレコードとして大きなレコードに取り込み、各レコードを個

別に表示して測定できます。 タイム・スタンプを使用すると、特定のフレームの絶対トリガ時間や特定の 2 つのフ

レームのトリガ間の相対時間を表示できます。

1. AUTOSET を使用して、水平、垂直、

およびトリガのコントロールを設定す
るか、または手動でコントロールを
設定します。

2. Horiz/Acq > FastFrame Setup... を選択

します。
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3. FastFrame を押してオンにします。

4. Frame Size および # of Events Frames
を選択します。次に汎用ノブを使用
して、それぞれを設定します。フレー
ム数は、取り込まれるトリガ・イベン
トの数を表します。 フレーム・サイズ

は、各トリガ・イベント（またはフレー
ム）で保存されるサンプルの数で
す。メモリ不足ですべてのレコードを
保存できない場合は、フレーム数が
減少します。フレーム長が短いほ
ど、取り込めるフレームの数が増え
ます。

5. Frame Viewing（フレームの表示）コン

トロールを使用して、表示するフレー
ムを選択します。

6. 複数のフレームを重ねて表示する場
合は、Overlay（オーバーレイ）を選択

します。

7. Time Stamps（タイム・スタンプ）コント

ロールを使用して、基準フレームの
ソースとフレーム番号を選択します。
基準フレームは、2 つのフレーム間

の相対時間を測定する際の開始ポ
イントとなります。

ヒント

■ FastFrame は、各トリガ・イベントに関連したデータを保持して、詳細な解析や視覚的な検証を行う場合に使用

します。

■ FastFrame は、イベント間に不要な長いデッド・タイムがあるような複数のイベントを取り込む場合に使用しま

す。

■ Temp（温度）または Spectral（スペクトラム）を使用する場合、選択されたフレームが濃い青で表示されて見にく

い場合があります。Normal（ノーマル）、Green（青）、Gray（グレー）のカラー・パレットを使用すると、複数のフレ

ームが最も見やすくなります。
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■ Average Summary Frame を選択した場合は、演算機能（Averaging）を All Frames または Only Summary Frames の
いずれに適用するかを選択できます。 サマリ・データに注目すればよい場合は、Only Summary Frames を選択

すると、システム・スループットが大幅に改善します。
 

 

FastFrame フレーム・ファインダの使用

フレーム・ファインダでは、他のフレームとは異なる FastFrame のフレームを見つけることができます。

1. FastFrame フレームのソースを選択し

ます。

2. From Frame # および To Frame # を入

力して、検索範囲を設定します。

3. Horiz/Acq > Run/Stop を選択し、Run/
Stop をクリックするか、または外部フ

ロント・パネルで Run/Stop を押して、

アクイジションを停止します。

4. Start をクリックして、検索を開始しま

す。
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フレーム・ファインダは異なるフレームを
探し出して表示します。 

5. 検索している異常が表示フレーム内
にない場合、No をクリックします。フ

レーム・ファインダは別の異なるフレ
ームを検索します。

6. 検索している異常が表示フレーム内
にある場合は、Yes をクリックしま

す。

7. 検索を終了する場合は、Stop をクリ

ックします。

8. Horiz/Acq > Run/Stop を選択し、Run/
Stop をクリックするか、または外部フ

ロント・パネルで Run/Stop を押して、

アクイジションを再開します。
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ピンポイント・トリガ

ピンポイント・トリガ・システムは、A および B トリガの両方で使用できる拡張トリガ・タイプを備えており、特定の数

のイベントや一定の時間の後で B イベントが発生しない場合に、トリガ・シーケンスをリセットすることができます。

ピンポイント・トリガは、最も複雑なトリガ・イベントや連続したトリガ・イベントを基にしたイベントの取り込みをサポ
ートしています。

このセクションでは、トリガ・システムを使用する概念と手順について説明します。

トリガの概念

トリガ・イベント

トリガ・イベントは、波形レコードに時刻ゼロ・ポイントを確立します。すべての波形レコード・データは、そのポイン
トを基準にして時間順に並べられます。 本機は、波形レコードのプリトリガ部分が一杯になるように、サンプル・ポ

イントを連続的に取り込んで保持します。 トリガ・イベントが発生すると、機器は、サンプルの取込みを開始して波

形レコードのポストトリガ部分（トリガ・イベントの後、つまり右側に表示される）を作成します。 トリガが認識される

と、アクイジションが完了し、ホールドオフ時間が切れるまで、機器は次のトリガを受け入れません。

トリガ・モード

トリガ・モードは、トリガ・イベントがない場合に機器の動作を決定します。

■ ノーマル・トリガ・モードは、トリガされた場合にだけ機器が波形を取込むことができるようにします。トリガが発
生しない場合は、前に取り込んだ波形レコードがそのまま表示されます。前の波形がない場合、波形は表示
されません。

■ オート・トリガ・モードは、トリガが発生しない場合でも、機器が波形を取込むことができるようにします。オー
ト・モードは、トリガ・イベントの発生後に開始されるタイマを使用します。タイムアウトまでに別のトリガ・イベン
トが検出されないと、機器は強制的にトリガを実行します。トリガ・イベントを待機する時間は、タイム・ベース
の設定に基づいて決定されます。

オート・モードでは、有効なトリガ・イベントがなくても強制的にトリガされるので、ディスプレイ上の波形の同期は
取れません。波形は、画面全体に波打って表示されます。有効なトリガが発生するとディスプレイは安定します。

エッジ・トリガ・モードでは、Trigger Setup コントロール・ウィンドウで Force Trigger ボタンをクリックし、強制的にトリガ

を実行できます。

Trig > Mode メニューでトリガ・モードを選択します。 詳細については、機器のオンライン・ヘルプを参照してくださ

い。
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トリガ・ホールドオフ

アクイジションを開始した後、それ以降にトリガを認識させない期間を延長することで、トリガ・ホールドオフはトリ
ガを安定させるのに役立ちます。そのように延長することで、システムが繰り返しバーストの残りのイベントをスキ
ップするのに役立ち、各バーストでは必ず最初のイベントでトリガが行われるようになります。機器が好ましくない
トリガ・イベントでトリガしている場合は、ホールドオフを調整すると、安定したトリガが得られます。

トリガ・ホールドオフは Trig > Holdoff メニューで設定します。 詳細については、機器のオンライン・ヘルプを参照し

てください。

トリガ・カップリング

トリガ・カップリングにより、トリガ回路に渡す信号の部分を指定します。エッジ・トリガでは、有効なすべてのカップ
リング・タイプ （AC、DC、低周波除去、高周波除去、ノイズ除去、RF）を使用できます。その他のトリガ・タイプで

は、DC カップリングのみを使用します。機器によっては、使用できないカップリング・タイプもあります。

Trig > A Event (Main) Trigger Setup メニューで、トリガ・カップリングを選択します。 詳細については、機器のオンライ

ン・ヘルプを参照してください。

水平軸位置

水平位置は、波形レコード上でトリガが発生する場所を定義します。これにより、機器がトリガ・イベントの前後に
取り込みを行う数を選択できます。 トリガの前にあるレコードは、プリトリガ部分です。 トリガの後にあるレコード

は、ポストトリガ部分です。

プリトリガ・データはトラブルシューティングに役立ちます。 たとえば、テスト回路にある不要なグリッチの原因を調

査する場合は、プリトリガ期間を十分に長くしてグリッチでトリガすることで、グリッチの前のデータを取り込みま
す。グリッチの前に発生する事象を解析することにより、グリッチの原因の調査に役立つ情報を入手できる可能性
があります。 または、トリガ・イベントの結果としてシステムで発生している事象を観察する場合は、ポストトリガ期

間を十分に長くして、トリガ後のデータを取込みます。

スロープおよびレベル

スロープ・コントロールは、信号の立上りエッジと立下りエッジのどちらでトリガ・ポイントを検出するかを決定しま
す。 レベル・コントロールは、トリガ・ポイントがあるエッジ上の場所を決定します。

遅延トリガ・システム

A（メイン）トリガ・システムだけを使用してトリガすることも、A（メイン）トリガと B（遅延）トリガを併用して連続的なイ

ベントをトリガすることもできます。連続的なトリガを使用する場合は、A トリガ・イベントによりトリガ・システムが動

作可能になり、B トリガ条件が満たされると、B トリガ・イベントにより機器がトリガされます。A トリガと B トリガに

は、個別のソースを設定できます（通常はこのようにします）。B トリガ条件は、時間遅延や特定のイベント数に基

づいて設定します A （メイン）トリガおよび B （遅延）トリガの使用(84 ページ)を参照してください。
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トリガ・タイプの選択

機器では、外部フロント・パネルから基本的なトリガ・パラメータを変更したり、Trigger Setup コントロール・ウィンドウ

でより高度なトリガを設定することができます。

注： 一部の機種では、使用できないタイプのトリガがあります。

1. Trig > Edge Setup を選択します。

2. セットアップのメニューからソース、
スロープ、カップリング、およびモー
ドを設定します。
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3. 他のトリガ・タイプを選択するには、
Trig メニューから直接トリガ・タイプを

選択します。

4. トリガ・タイプに表示されるコントロー
ルを使用して、トリガの設定を完了し
ます。トリガを設定するためのコント
ロールは、トリガ・タイプ、機器のモ
デル、またオプションにより異なりま
す。
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トリガ一覧

トリガ・タイプ トリガ条件

エッジ スロープ・コントロールの定義に従い、立上りエッジまたは立下りエ
ッジでトリガします。 カップリングとして、DC、AC、LF 除去、HF 除
去、ノイズ除去、および RF を選択できます。

グリッチ 指定した幅よりも狭い（または広い）パルスの場合にトリガさせる
か、指定した幅よりも狭いグリッチを無視します。

幅 指定した時間範囲内または範囲外のパルスでトリガさせます。 正
のパルスまたは負のパルスでトリガできます。

ラント 2 つのしきい値の一方を通過してから他方を通過する前に、最初

のしきい値を再度通過するパルス振幅でトリガします。正または負
のラント、または指定した幅より広いラントを検出できます。 これら

のパルスは、他のチャンネルのロジック・ステートでもクオリファイで
きます。

ウィンドウ 入力信号が上限しきい値レベルを超えた場合、または下限しきい
値レベルを下回った場合にオシロスコープをトリガさせます。信号
がしきい値ウィンドウに入ったときまたは出たときに機器をトリガさ
せます。 Trigger When Wider オプションを使用して時間によって、ま

たは Trigger When Logic オプションを使用して他のチャンネルのロジ

カル・ステートによって、トリガ・イベントをクオリファイします。

タイムアウト 指定した時間内にパルスが検出されない場合にトリガします。

トランジション 指定した時間より高速または低速のレートで、2 つのしきい値間を

遷移するパルス・エッジを検出してトリガします。 パルス・エッジは

正または負です。

パターン ロジック入力信号により、選択した関数が True または False になる

場合にトリガします。 指定した時間だけ論理条件を満たしてからト

リガするように指定することもできます。

ステート クロック入力の状態が変化したときに、選択した論理関数へのすべ
てのロジック入力によって関数が True または False になるときにトリ

ガします。

セットアップ／ホール
ド

クロックを基準にしてセットアップ時間内およびホールド時間内にロ
ジック入力の状態が変化した場合にトリガします。 このモードは、

セットアップ違反およびホールド違反をトリガします。

バス 定義したバスのコンポーネント（指定したアドレスなど）でトリガしま
す。一部の機器とオプションによりパラレル、 SPI、RS-232、USB、お
よび I2C のトリガが可能です。

周波数／周期 指定した時間または周波数の範囲でトリガします。
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トリガ・ステータスのチェック

リードアウトまたは外部フロント・パネルのステータス・ライトでトリガ・ステータスをチェックします。

 

いくつかの主要なトリガ・パラメータの設
定をすばやく確認するには、表示の下部
でトリガ・リードアウトをチェックします。 リ
ードアウトは、エッジ・トリガと拡張トリガ
で異なります。 

1. A トリガ・ソース = CH3

2. トリガ・スロープ = 立上りエッジ

3. トリガ・レベル = 250 mV

4. 時間軸

5. ARM（動作可能）、READY（準備完

了）、TRIG'D（トリガ済み）の各リード

アウトをチェックして、トリガのステー
タスを確認します。

6. トリガ・オプション・メニューをチェック
してトリガ・モードを確認します。
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ARM（動作可能）、READY（準備完了）、

TRIG'D（トリガ済み）の各外部フロント・パ

ネル・コントロールをチェックして、トリガ
のステータスを確認します。 

■ TRIG’D（トリガ済み）がオンの場合、

機器は有効なトリガを取り込み、波
形のポストトリガ部分の処理を実行
しています。

■ READY（準備完了）がオンの場合、

機器は、有効なトリガの発生を受け
入れることができ、トリガを待機して
います。プリトリガのデータは取り込
まれています。

■ ARM（動作可能）がオンの場合、トリ

ガ回路は、波形レコードのプリトリガ
部分を処理しています。

■ TRIG'D（トリガ済み）と READY（準備

完了）がオンの場合は、有効な A イ
ベント・トリガが認識され、機器は遅
延トリガを待機しています。 遅延トリ

ガが認識されると、遅延波形のポス
トトリガ部分が処理されます。

■ ARM（動作可能）、TRIG'D（トリガ済

み）、READY（準備完了）がオフの場

合、アクイジションは停止していま
す。
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A （メイン）トリガおよび B （遅延）トリガの使用

単純な信号に対して A イベント（メイン）トリガを使用し、より複雑な信号を取り込むために B イベント（遅延）トリガ

と組み合わせて使用することができます。 トリガ・システムは、A イベントの発生後に、B イベントを検出してからト

リガして波形を表示します。

A トリガ 

1. Trig > A Event (Main) Trigger Setup...
を選択します。

2. A Event タブで A トリガのタイプとソー

スを設定します。

B トリガ（遅延） 

注： マルチユニット・システムでは、A お
よび B のトリガ・ソースが、どちらも同じ
ユニットでなければなりません。

 

3. A →B Seq タブで関数を選択します。

4. トリガ遅延時間または B イベント数

を設定します。

5. B Event（B イベント）（遅延）タブで、B
トリガの特性を設定します。
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6. Mode タブで、Trigger Mode の Normal
および Holdoff の Auto 選択します。

トリガ、B イベント

A トリガで機器が動作可能になります。

ポストトリガ・アクイジションが、n 番目の

B イベントから開始されます。 

B トリガ、遅延時間後

A トリガで機器が動作可能になります。

ポストトリガ・アクイジションは、トリガ遅
延時間の経過後に最初の B エッジで開

始されます。 

リセットによるトリガ

B トリガ・イベントが発生した場合に、トリ

ガ・システムをリセットする条件を指定で
きます。リセット・イベントが発生した場合
に、システムは、B イベントの待機を停止

し、A イベントの待機に戻ります。 
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ヒント

■ B トリガ遅延時間と水平遅延時間は、別々の機能です。A トリガのみを使用して、または A トリガと B トリガの

両方を併用してトリガ設定を行う場合、水平遅延を併用すればアクイジションをさらに遅延させることができま
す。

トリガ位置の修正

トリガ位置修正機能は、データ・パスおよびトリガ・パスにおける誤差を修正し、表示されている波形にトリガをより
正確に配置します。また、このトリガ位置修正機能では、アベレージングを使用して、ノイズの多い信号へのトリガ
配置を正確に行うこともできます。 エッジ・トリガをより正確に波形に配置するには、次の手順を実行します。

1. 波形にトリガをより正確に配置する
には、Enhanced Triggering チェック・

ボックスをオンにします。ノイズの多
い信号にトリガをより正確に配置す
るには、さらに、Optimized for Noisy
Signals チェック・ボックスをオンにし

ます。

Optimized for Noisy Signals は、

Enhanced Triggering をオンにした場

合にのみ選択できます。 
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B イベント・スキャンを使用するトリガ

A トリガ・イベントにより同期または開始されたオーバーラップするアイ・ダイアグラムを作成するには、A->B Seq タ
ブで B Event Scan を On に設定します。

Trig on nth Event を設定すると、アクイジション全体の中で A イベント後に発生する n 番目の B イベントが取り込ま

れます。B Event Scan を設定すると、B イベント値に増分が自動的に加えられ、そのたびに信号の異なる領域が取

り込まれます。 

1. A Event タブで A トリガのタイプとソー

スを設定します。

2. B Event タブで B トリガのタイプとソー

スを設定します。

3. 波形にトリガをより正確に配置する
には、Enhanced Triggering チェック・

ボックスをオンにします。ノイズの多
い信号にトリガをより正確に配置す
るには、さらに、Optimized for Noisy
Signals チェック・ボックスをオンにし

ます。

4. A>B Seq タブで、Trig on nth Event と B
Event Scan を選択します。

5. B Event Scan > Setup を押して、B
Event Scan Setup ウィンドウを表示し

ます。
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6. B イベントの開始値を設定します。

7. B イベントの終了値を設定します。

8. B イベント値に増分を加えるまでの

アクイジション回数を設定します。

9. 指定回数のアクイジション発生後の
B イベント値の増分方法を選択しま

す。

Sequential Scan： 終了値に達するま

で 1 ずつ加えます。終了値に達した

後は、B イベント値を開始値にリセッ

トしてプロセスを再開します。 

Random Scan： Advance After ボックス

で指定した回数のアクイジションごと
に、B イベント値を開始値と終了値

の間のランダムな値に設定します。 

Toggle Between Events： Advance After
ボックスで指定した回数のアクイジ
ションごとに、B イベント値を開始値

と終了値に交互に切り替えます。 
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10. ここに示す図では、DDR3 の DQS 信
号が Ch 1、DQ 信号が Ch 2 です。こ

の機器は Run Mode であり、Display
Mode は Infinite Persistence に設定さ

れています。この機器のトリガ設定
は以下のとおりです。

A Event タブで、Trigger Type を
Window、Source を Ch 1 に設定し、

DDR3 DQS 書き込み状況を検出しま

す。  

B Event タブで、Trigger Type を Edge
に、Source を Ch 2 に設定し、DQ（ク
ロック）のエッジをトリガします。 

A->B Sequence を Trig on nth Event に
設定します。  

B Event Scan Setup ウィンドウで、Start
Event = 1、End Event = 8 に設定し、

Sequential Scan モードを選択します。 

データのアイは Ch 2 の DQ 信号によ

り形成されます。  
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パラレル・バスでのトリガ

パラレル・バスでトリガして、問題を特定します。

1. パラレル・バスをセットアップします
（バスのセットアップ(66 ページ)を参

照）。 Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブを選択します。

3. Bus トリガ・タイプを選択します。
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4. トリガをオンにするバスを選択しま
す。

注： クロック同期バスは、クロック・ソ
ースが Ch4 にセットされている場合
のみ、ドロップダウン・リストに表示さ
れます。

 

5. Edit ボタンをクリックして、トリガする

パターンおよびフォーマットを設定し
ます。

6. データ・フォーマットの選択

7. キーパッドを使用して、トリガするパ
ターンを設定します。
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8. 波形を解析します。

シリアル・バスでのトリガ

シリアル・バスでトリガして、問題を特定します。

シリアル・バスをセットアップします（バス
のセットアップ(66 ページ)を参照）。 

1. Trig > A Event (Main) Trigger Setup...
を選択します。

2. A Event タブを選択します。
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3. Bus トリガ・タイプを選択します。

4. バスを選択します。

5. トリガするバス信号を選択します。

6. Trigger On の選択とバスのタイプに

従って、必要なバスの選択を行いま
す。

バスのセットアップの詳細について
は、オンライン・ヘルプを参照してく
ださい。 
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ビジュアル・トリガによるトリガ

ビジュアル・トリガ機能により、トリガ条件をディスプレイ・スクリーンで直接設定することができます （ビジュアル・ト

リガは、一部のモデルではオプションです）。

1. ビジュアル・トリガ領域を作成するに
は、まず画面を左クリックしてそのま
まドラッグし、任意の四角形を作成し
ます。次に、メニューから Add Visual
Trig Area を選択します。

注： 同じメニューから、すべてのビジ
ュアル・トリガ領域の表示と非表示を
切り替えたり、ビジュアル・トリガ機
能自体のオン・オフを切り替えること
ができます。

 

2. 領域をクリックすると、そのハンドル
が有効になります。 領域をクリックし

て、希望の位置にドラッグすることが
できます。 枠のハンドルをクリック、

ドラッグすると、垂直方向および水
平方向に領域の大きさを調整できま
す。

3. ビジュアル・トリガ領域を右クリック
し、メニューから Visual Trigger Area を
選択します。

このメニューで、トリガ領域を編集し
たり、ビジュアル・トリガの条件を設
定することができます。 

ビジュアル・トリガを作成し、編集す
る方法の詳細についてはオンライ
ン・ヘルプを参照してください。 
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4. Trig メニューから Visual Trigger Setup
を選択し、Visual Trigger equation をダ

ブルクリックします。

Qualification Expression Editor の使用

方法の詳細についてはオンライン・
ヘルプを参照してください。 
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Action on Event の設定

Action on Event 機能により、たとえばトリガ・イベントやマスク・エラー、リミット・テストのエラーなど、特定の条件に

合致する状況が発生したときにさまざまなファイルを自動的に保存するよう、オシロスコープを設定することができ
ます。

1. File > Action on Event を選択します。

2. 使用するイベントを選択します。

3. イベントが発生したときに取るアクシ
ョンを選択します。セーブ、電子メー
ルの送信、あるいはその両方が選
択できます。

保存の詳細を設定するには、Setup
ボタン （Save ボタンの隣）を使用しま

す。 

電子メールの詳細を設定するには、
Setup ボタン （Save E-mail ボタンの

隣）を使用します。（イベント時の電
子メールの設定(98 ページ)を参

照）。 

4. ファイルを保存する場所を選択しま
す。

5. 保存の条件となるイベントを選択し
ます。

6. イベント発生時に保存するファイル
の形式を選択します。

7. ファイルの命名規則を設定します。

8. 保存するイベントの数を指定しま
す。
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トリガ時の電子メールの送信

次の手順を実行する前に、イベント時の電子メールを設定する必要があります。 （イベント時の電子メールの設定
(98 ページ)を参照）。

1. Trig > A Event (Main) Trigger Setup...
を選択します。

2. Mode タブを選択します。

3. E-mail on Trigger で On をクリックし、

Setup をクリックします。（イベント時
の電子メールの設定(98 ページ)を
参照）。
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イベント時の電子メールの設定

1. Utilities > E-mail on Event > Setup... を
選択します。

2. 受信者の電子メール・アドレス（1 つ
または複数）を入力します。エントリ
が複数ある場合は、カンマで区切り
ます。電子メール・アドレス・ボックス
に入力できる文字数は 252 文字まで

です。

3. Config をクリックして、次に SMTP サ
ーバー・アドレスを入力します。アド
レスについては、ネットワーク管理者
に問い合わせてください。
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4. 電子メール送信の必要なイベント
（1 つまたは複数）を選択します。

5. 添付ファイルを含めるには、添付フ
ァイルのタイプを選択してから、
Settings をクリックしてフォーマットを

指定します。

6. メッセージ数の上限および電子メー
ルの最大サイズを設定しますメッセ
ージ数が上限に達した場合、引き続
きイベント通知のメールが送信され
るようにするには、Reset をクリックす

る必要があります。

7. 設定した電子メール･アドレスが正し
いことを確認するには、Send をクリッ

クしてテスト・メールを送信します。

8. 必要な場合は Config をクリックし

て、電子メールの構成ダイアログボ
ックスで構成を調整します。
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水平遅延の使用

トリガの場所から時間が大きく離れてい
るエリアで波形の詳細を取り込む場合
は、水平遅延を使用します。 

1. Horiz/Acq > Horizontal/Acquisition
Setup を選択します。

2. Delay Mode ボタンを押して遅延モー

ドをオンにします。

3. 遅延時間を水平方向の POSITION
（位置）コントロールで調整するか、
コントロール・ウィンドウで入力しま
す。

4. 水平方向の SCALE ノブを調整し、必

要な詳細を取り込みます。

ヒント

■ 遅延アクイジションの拡大には、MultiView ズームと水平遅延を併用します。

■ 水平遅延の ON と OFF を切り替えると、トリガ位置近くの領域と遅延時間を中心とした領域の 2 つの対象領

域の信号詳細を素早く比較できます。
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波形の表示

このセクションでは、波形の表示の概念と手順について説明します。詳細についてはオンライン・ヘルプを参照し
てください。

表示スタイルの選択

表示スタイルを設定するには、Display >
Display Style を選択してから、次のいず

れかのスタイルを選択します。  

Vectors（ライン）レコード・ポイント間が線

で結ばれた波形を表示します。 

Dots（ドット）波形のレコード・ポイ ントを

画面上にドットで表示します。 

Intensified Samples（高輝度サンプル）実

際のサンプルを表 示します。 補間され

た ポイントは表示されません。 
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表示パーシスタンスの設定

Display >Display Persistence を選択して

から、パーシスタンスのタイプを選択しま
す。 

■ No persistence（パーシスタンスなし）

は、現在のアクイジションの波形レコ
ード・ポイントだけを表示します。新
しいそれぞれの波形レコードは、前
に取り込まれたチャンネルのレコー
ドを置き換えます。

■ 無限パーシスタンスは、アクイジショ
ン表示設定の 1 つを変更するまで、

連続的にレコード・ポイントを累積し
ます。ノーマル・アクイジション・エン
ベロープの外側にあるポイントの表
示に使用します。

■ 可変パーシスタンスでは、指定され
た時間インターバルの間、レコード・
ポイントを蓄積します。各レコード・ポ
イントは、時間インターバルに従って
個別に減衰します。

■ リセット・パーシスタンスは、パーシ
スタンスをクリアします。
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1. 可変パーシスタンスの時間を設定す
るには、Display >DisplayPersistence
>Persistence Controls... を選択しま

す。

2. Variable、Persist Time をクリックして

から、汎用ノブを使用して残光時間
を設定します。
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表示フォーマットの設定

機器は、2 つのフォーマットで波形を表示できます。目的に最もよく合うフォーマットを選択してください。

Display >Display Format を選択します。 

■ 時間の経過とともに変化する信号振
幅を表示するには、YT フォーマット

を選択します。

■ XY フォーマットを選択すると、波形レ

コードの振幅をポイントごとに比較で
きます。

次のチャンネルが比較されます。

Ch 1（X）と Ch 2（Y）、

Ch 3（X）と Ch 4（Y）、

Ref 1（X）と Ref 2（Y）、

Ref 3（X）と Ref 4（Y）

ATI チャンネルを使用した機器では、

次のチャンネルが比較されます。

Ch 1（X）と Ch 3（Y）、
■ CH1 （X）および CH2 （Y）波形レコード

の電圧レベルを XY フォーマットと同

様にポイントごとに比較するには、
XYZ フォーマットを選択します。表示

される波形輝度は、CH 3（Z）の波形

レコードによって変調されます。XYZ
フォーマットはトリガされます。CH3
の -5 目盛の信号（位置とオフセット

を含む）では、画面に何も表示され
ません。また、+5 目盛の信号は、最

高の輝度で表示されます。

 

ヒント

■ XY フォーマットは、リサージュ・パターンなどの位相の関係を調べる場合に特に便利です。

■ XY フォーマットはドットだけの表示ですが、パーシスタンスを設定できます。XY フォーマットを選択した場合

は、Vector（ベクトル）スタイルを選択しても無効になります。

波形の表示  

104  DPO70000SX シリーズ・ユーザ



波形補間の選択

Display >Waveform Interpolation を選択し

てから、次のいずれかを選択します。 

■ Sin(X)/X 補間法は、取り込んだ実際

のサンプル間の曲線適合を使用し
てレコード・ポイントを計算します。

■ 直線補間法は、直線適合を使用し
て、実際の取込みサンプルの間のレ
コード・ポイントを計算します。

 

ヒント

■ Sin(X)/X 補間法は、デフォルトの補間モードです。このモードでは、直線補間法の場合よりサンプル・ポイント

の数が少なくても、波形を正確に表現できます。
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スクリーン・テキストの追加

1. Display > Screen Text を選択します。

2. 最大 8 つの独立したテキスト行を入

力できます。

3. Text の Off または On をクリックする

と、テキスト表示のオン／オフを切り
替えることができます。

4. Font または Color をクリックすると、

画面テキストのフォントと色を選択で
きます。

5. Controls をクリックすると、Text
Properties コントロール・ウィンドウが

開きます。ここでは、ディスプレイ上
のテキストの配置を指定できます。

6. Clear（クリア）をクリックして、選択し

た行のテキスト全体を消去します。

ヒント

■ 画面のテキストをクリックしてドラッグすると、画面上の位置を変更できます。

■ 波形やバスにもラベルを付けることができます。（バスのセットアップ(66 ページ)を参照）。
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目盛スタイルの設定

目盛スタイルを設定するには、Display >
Graticule Style を選択してから、次のいず

れかのスタイルを選択します。  

波形パラメータをすばやく見積もるため
に使用します。 

クロスヘアが不要な場合に、カーソルや
自動リードアウトによる全画面測定に使
用します。 

このスタイルは、自動リードアウトなどの
データを表示する領域を残したまま、波
形パラメータをすばやく見積もるために
使用します。 

ディスプレイ機能が不要な場合に、自動
リードアウトなどのスクリーン・テキストと
共に使用します。 

NTSC ビデオ信号に使用します。 

NTSC 以外のビデオ信号に使用します。 
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Solid は Full に似ていますが、グリッド、ク

ロスヘア、および枠を実線で描画しま
す。 

トリガ・レベル・マーカの設定

1. Display >Objects... を選択します。

2. 次のいずれかを選択します。

■ Short は、目盛の片側に短い矢

印を表示します。

■ Long（ロング）は、目盛全体にわ

たる水平線を表示します。

■ Off（オフ）>は、トリガ・レベル・マ

ーカをオフにします。

 

日付と時刻の表示

1. Display > Objects... を選択します。

2. 目盛にある日時の表示を切り換えま
す。Utilities（ユーティリティ）メニュー

を使用して、日時を設定します。

波形の表示  

108  DPO70000SX シリーズ・ユーザ



カラー・パレットの使用

Display > Record View Palette または

FastAcq/WfmDB Palette を選択し、次に示

す波形および目盛のカラー・ スキームの

いずれかを選択します。 

■ Normal（標準）は、全体的に良好な色

調と明るさのレベルで表示します。
各チャンネル波形の色は、外部フロ
ント・パネルの垂直ノブの色に対応
しています。

■ Temperature Grading（温度グレーディ

ング）は、サンプル密度の最も高い
波形エリアを赤の影で表示します。
サンプル密度の最も低いエリアは、
青の影で表示されます。

■ Monochrome Green（モノクロ・グリー

ン）は、サンプル密度の最も高い波
形エリアを明るい緑の影で表示しま
す。サンプル密度の最も低いエリア
は、暗い緑の影で表示されます。ア
ナログ・オシロスコープのディスプレ
イに最も近いモードです。

 

■ Spectral Grading（スペクトラム・グレー

ディング）は、サンプル密度の最も高
い波形エリアを青の影で表示しま
す。サンプル密度の最も低いエリア
は、赤の影で表示されます。

 

■ Monochrome Gray（モノクロ・グレー）

は、サンプル密度が最も高い波形エ
リアを明るいグレーの影で表示しま
す。サンプル密度が最も低いエリア
は、暗いグレーの影で表示されま
す。

 

■ User は、ユーザが定義した色で波形

を表示します。
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ヒント

■ Display > Colors コントロール・ウィンドウのカラー・グレーディング・パレットの 1 つを選択すると、サンプル密

度によって色分けされた表示になります。

■ Record View（レコード表示）用と FastAcq/WfmDB（高速アクイジション /WfmDB）用の 2 つのカラー・パレットがあり

ます。
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リファレンス波形色の設定

Display > Colors... を選択してから、次の

いずれかを選択します。 

■ Default（デフォルト）は、リファレンス

波形にデフォルトのシステム・カラー
を使用します。

■ Inherit（継承）は、リファレンス波形に

元の波形と同じカラーを使用しま
す。

 

 波形の表示

DPO70000SX シリーズ・ユーザ 111



リファレンス波形色の設定

Display > Colors... を選択してから、次の

いずれかを選択します。 

■ Default（デフォルト）は、演算波形に

デフォルトのシステム・カラーを使用
します。

■ Inherit（継承）は、リファレンス波形に

元の波形と同じカラーを使用しま
す。

 

ヒント

■ 演算およびリファレンス波形のデフォルト・カラーは、各波形で異なります。
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MultiView ズームの使用

取り込んだ波形を垂直方向、水平方向、または両方向に拡大する場合は、MultiView ズーム機能を使用します。ま

た、ズームした波形は、整列またはロックしたり、自動的にスクロールさせることができます。 スケーリングと位置

は、表示のみに影響し、実際の波形データには影響しません。

1. MultiView Zoom がオフの場合は、

Horiz/Acq > Zoom Setup... を選択し、

Zoom、Controls をクリックするか、ま

たは外部フロント・パネルの
MultiView Zoom を押して、ズーム目

盛を追加します。

 

2. HORIZ（水平）または VERT（垂直）を

押して、ズームの目盛で拡大する軸
を選択します。ズーム波形のスケー
ルと位置を調整するには、汎用ノブ
を使用します。

この例では、メイン目盛が目盛の上
半分に、ズーム目盛が目盛の下半
分になっています。 

注： ズーム波形の表示/非表示を切
り替えるには、Show/Hide Waveforms
を押して、表示するズーム波形を指
定します。

 

 

3. ズーム目盛のサイズを調整するに
は、Vertical または Horiz/Acq メニュー

から Zoom Graticule Size を選択しま

す。

4. MultiView Zoom がオンでリードアウト

がズーム・コントロールに連結してい
ない場合は、MultiView Zoom ボタン

を押して、リードアウトをズーム・コン
トロールに連結します。 ズームをオ

フにするには、MultiView Zoom ボタ

ンを再度押します。

 

ヒント

■ Zoom Setup メニューを使用して、ズームされる波形の目盛サイズを変更することもできます。
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複数エリアのズーム

1 つのレコードにある複数のエリアを同時に表示し、比較する場合は、次の手順を使います。

1. ズームする波形を囲むボックスをク
リックし、ドラッグします。

2. Zoom 1 On（ズーム 1 オン）を選択し

ます。

3. ズームする波形のもう 1 つのエリア

を囲むボックスをクリックし、ドラッグ
してから、Zoom 2 On（ズーム 2 オン）

を選択します。

4. ズームしたエリアを水平方向に調整
するには、Zoom（ズーム）ボックスの

下にある水平マーカをクリックし、ズ
ームしたエリアを選択します。

5. オプションの汎用ノブを使用するか、
またはリードアウトをダブルクリック
し、キーパッドを使用して、選択した
ズーム・エリアの水平位置と倍率を
調整します。
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6. ズームしたエリアを垂直方向に調整
するには、Vertical > Zoom Setup... を
選択し、垂直フィールドをクリックした
後、オプション汎用ノブを使用する
か、またはリードアウトをダブルクリ
ックし、キーパッドを使用して、垂直
位置と倍率を調整します。

ヒント

■ ズーム・エリアをクリアするには、Zoom Setup（ズーム設定）コントロール・ウィンドウから、Position Factor Reset
（位置倍率のリセット）をクリックします。

■ Zoom Setup コントロール・ウィンドウから、各ズーム表示をオンまたはオフにします。

■ MultiView Zoom ボタンを押して、すべてのズーム表示のオンとオフを切り替えます。

■ ズームしたエリアを水平方向に移動するには、Zoom（ズーム）ボックスの下にある水平マーカをクリックし、ド

ラッグします。
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ズームした波形のロックおよびスクロール

1. Lock and Scroll を使うには、Vertical ま
たは Horiz/Acq メニューの Zoom
Setup... を選択し、Lock and Scroll タ
ブを選択します。

2. 単一のズームしたエリアをスクロー
ルするには、 Zoom 1-4 ボタンをクリ

ックしてから、Auto Scroll ボタンをクリ

ックします。

3. 複数のズームしたエリアを同時にス
クロールするには、Lock をクリックし

てから、スクロールする Zoom1-4 ボ
ックスをクリックします。

ズームしたエリアをロックすると、そ
の相対的な水平位置がロックされま
す。1 つのロックおよびズームしたエ

リアの水平位置を変更すると、すべ
ての水平位置が変わります。 

ヒント

■ 複数のズーム・エリアが選択され、ロックされていない場合、一番上の番号のズーム・エリアがオートスクロー
ルされ、その他のエリアは静止したままになります。
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ズームされたウィンドウでの波形の非表示

1. 波形を非表示にしたり表示したりす
るには、Vertical メニューまたは Horiz/
Acq メニューから Zoom Setup... を選

択します。

2. Zoom タブを選択し、次に Show/Hide
Waveforms を押します。

3. 表示または非表示にする波形が含
まれるズーム領域を選択します。

4. 非表示にするチャンネル波形、演算
波形、またはリファレンス波形のチェ
ック・ボックスをオフにします。

波形の検索とマーキング

取り込んだ波形に対して、目的の位置をマークすることができます。このマークは、波形の解析を特定の領域に
限定して行いたいときに便利です。波形がある特別な条件を満たしたときにその領域を自動的にマークするよう
に設定したり、項目ごとに手動でマークしたりすることができます。マークからマーク（目的の領域から目的の領
域）に移動することも可能です。トリガに使用する同じパラメータの多くを、自動的に検索してマークできます。多く
の検索パラメータには、トリガとしてのタイム・リミットはありません。演算波形およびリファレンス波形上で検索し
たり、取り込まれた特定の種類のイベントすべてを検索したりできます。

検索マークは、リファレンスに対して波形領域をマークする 1 つの方法です。 検索条件を使用して、自動的にマー

クするよう設定できます。 特定のエッジ、パルス幅、ラント、ロジック・ステート、立上り／立下り時間、セットアップ

／ホールド違反、およびバス検索の種類を使用して、領域を検索およびマークできます。
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マークを手動で設定およびクリア（消去）するには、次の手順を実行します。

1. MultiView Zoom をオンにします。

Zoom 1 がマークで使用されていま

す。

（MultiView ズームの使用(113 ページ)
を参照）。 

2. Analyze > Search を選択します。

3. ズーム・ボックスの下部を選択し、外
部フロント・パネルの汎用ノブを回し
て、検索マークを設定（またはクリ
ア）する波形の領域にドラッグして移
動します。

Next（→）または Prev（←）矢印ボタン

を押すと、次のマークにジャンプでき
ます。 

4. Set Clr ボタン、または外部フロント・

パネルの Set/Clear ボタンを押しま

す。

画面中央に検索マークがない場合
は、マークが追加されます。 

マーク作成時に、水平ズーム倍率が
保存されます。ズーム倍率は、Next
または Prev を使用してマーク間を移

動するときにリストアされます。 

マーク作成時に、水平ズーム倍率が
保存されます。ズーム倍率は、Next
または Prev を使用してマーク間を移

動するときにリストアされます。 
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5. 検索マーク間を移動して波形を調べ
ます。 Next（→）または Prev（←）矢印

ボタンを使用すると、他のコントロー
ルを調整せずに、マークされた場所
の間を移動できます。

6. マークを削除します。 Next（→）また

は Prev（←）矢印ボタンを押して、削

除するマークに移動します。 中央位

置のマークを削除するには、Set Clr
ボタンまたは外部フロント・パネルの
Set/Clear ボタンを押します。これによ

り、手動または自動のどちらで作成
されたマークも削除できます。
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検索マークを自動で設定およびクリア（消去）するには

1. Search を押すか、Analyze > Search
を選択します。

2. メニューから、目的の検索の種類を
選択します。

検索メニューは、トリガ・メニューに
類似しています。 

シリアル・バスの検索はオプションで
す。 

3. Configure タブで検索を設定します。

トリガ・セットアップまたは検索セット
アップをコピーするには、Copy
Settings を押します。

4. Copy Settings ウィンドウで、設定のコ

ピー元とコピー先を選択します。
Copy、Close の順に押します。
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5. 現在のセットアップを変更するには、
表示されているコントロールの設定
を調整します。表示されているコント
ロールは、選択した検索の種類によ
って異なります。

6. 検索が On になっていない場合は、

All Searches を押して検索をオンに

切り替えます。

7. 画面上で、緑の三角形は自動マー
クの位置を示し、白の三角形はカス
タム（ユーザ定義）マークの位置を示
します。この三角形とラインは、標準
の波形画面およびズームした波形
画面の両方で表示されます。
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8. Next（→）と Prev（←）矢印ボタンを使

用してマーク間を移動し、すばやく波
形を観察することができます。他の
調整は不要です。

9. 検索イベント・カウントまたはマーク
時間の表示を切り替えるには、
Results タブを選択し、View の Count
を押します。

10. マーク・テーブルをファイルにエクス
ポートするには、All Marks の Export
を押します。

11. 1 つまたはすべてのマークをユー

ザ・マークに変換するには、Search
Marks の Save または Save All を押し

ます。

12. 現在ハイライトされている行をマー
ク・テーブルから削除するには、
Search Marks の Clear を押します。

13. エンジニアリング表記または高確度
フォームでマーク位置を切り替える
には、Digits を押します。

14. マークを示す三角形表示のオンとオ
フを切り替えるには、View タブを選

択し、Show Marks を押します。

波形の表示  

122  DPO70000SX シリーズ・ユーザ



15. 一致するイベントが見つかった場合
にアクイジションを停止するには、
Mode タブを選択し、Stop Acquisition
if event found チェック・ボックスをオ

ンにします。

ヒント

■ 検索は、取り込まれたデータに対してのみ実行されます。検索するデータを取り込むよう機器をセットアップし
てください。

■ 検索イベントを認識できるようサンプル・レートを設定してください。複数のサンプル・インターバルよりも広い
グリッチを検索できます。

■ トリガ設定をコピーして、取込んだ波形内でトリガ条件を満たすような他の位置を検索することができます。検
索設定をトリガにコピーすることもできます。

■ エッジ検索マークは、ズーム倍率なしで作成されます。他の種類の検索については、適切なズーム倍率でマ
ークが作成されます。

■ Bring Zoom to Mark の Zoom 2 または Zoom 3 を押すと、対応するズーム・ビューが Zoom 1 と同じズーム・パラメ

ータで表示されます。

■ カスタム（ユーザ）マークは、波形が保存されるとき、および設定が保存されるときに、波形とともに保存され
ます。

■ 波形を保存しても、自動検索マークはその波形と共には保存されません。しかし、検索条件は保存されたセ
ットアップに格納されているので、その検索条件を使用して簡単にマークを再度取り込むことができます。

利用できる検索の種類を以下に示します。

Search（検索） 概要

エッジ ユーザが指定したしきい値レベルを使用して、立上りまたは立下りエッジを検索しま
す。

グリッチ 指定した幅よりも狭い（または広い）パルスを検索するか、指定した幅よりも狭いグリ
ッチを無視します。

幅 ユーザが指定したパルス幅より大きい（>）、小さい（<）、等しい（=）、あるいは等しくな

い（≠）ような正または負のパルス幅を検索します。

セットアップ&ホールド ユーザ指定のセットアップおよびホールド時間違反を検索します。

ラント 一方の振幅しきい値と交差し、もう一方のしきい値とは交差せずに最初のしきい値と
再び交差する正パルスまたは負パルスを検索します。 すべてのラント・パルス、ま

たはユーザ指定の時間よりも大きい（>）、小さい（<）、あるいはユーザ指定の時間と

等しい（=）、または等しくない（≠）時間を持つラント・パルスを検索します。

ウィンドウ しきい値ウィンドウに入る信号、またはしきい値ウィンドウから出る信号を検索しま
す。Trigger When Wider オプションを使用して時間によって、または Trigger When Logic
オプションを使用して他のチャンネルのロジカル・ステートによって、検索をクオリファ
イします。
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Search（検索） 概要

パターン High、Low、Don't Care のいずれかに設定された各入力によって、複数の波形でロジッ

ク・パターン（AND、OR、NAND、または NOR）を検索します。 イベントが True になった

とき、False になったとき、またはユーザ指定の時間よりも大きい（>）、小さい（<）、あ
るいはユーザ指定の時間と等しい（=）、または等しくない（≠）ないときに、そのイベン

トを検索します。さらに、入力の 1 つを同期（ステート）検索のクロックとして定義する

必要があります。

トランジション ユーザが指定した時間より長い（>）、短い（<）、等しい（=）、あるいは等しくない（≠）よ
うな立上り／立下りエッジを検索します。

タイムアウト 指定された時間にパルスがない場合、それを検索します。

ステート クロック入力の状態が変化し、選択した論理関数へのすべてのロジック入力によっ
て関数が True または False になるとき、それを検索します。

DDR リード DDR リード・パルスを検索します。オプション DDRA 型が必要です。

DDR ライト DDR ライト・パルスを検索します。オプション DDRA 型が必要です。

DDR リードおよびライト DDR リード・パルスおよび DDR ライト・パルスを検索します。オプション DDRA 型が必

要です。

バス パラレル： 2 進値または 16 進値を検索します。

Custom：カスタム・デコーダの使用を検索します。
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ビジュアル検索の使用

ビジュアル検索は、メイン・トリガと同じ設定で実行します。 ビジュアル検索の結果は、解析検索と区別できる色の

マークで表示されます。 次の手順でビジュアル検索を設定します。

1. ピンポイント・トリガを設定します（トリ
ガ・タイプの選択(79 ページ)を参

照）。

2. ビジュアル・トリガを設定します（ビジ
ュアル・トリガによるトリガ(94 ページ)
を参照）。

3. Mark All Trigger Events in Record をク

リックします。

4. ビジュアル・トリガ領域は青色で表示
されます。

5. ビジュアル検索領域は緑色で表示さ
れます。

6. アクティブなビジュアル検索領域の
みが表示されます。 他のビジュアル

検索領域に移動するには、Mark の
Next ボタンまたは Prev ボタンを押し

ます。

ビジュアル検索の結果を操作したり
表示するには、他の Analyze Search
コントロール･ウィンドウを使用しま
す。  
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波形の解析

この機器は、波形解析に役立つ機能（カーソル、自動測定、統計、ヒストグラム、演算、スペクトラム解析、および
詳細な合否テスト）を備えています。ここでは、波形解析の概念および手順について説明します。 詳細について

はオンライン・ヘルプを参照してください。

自動測定の実行

1. Measure > Measurement Setup... を選

択します。

2. 測定するチャンネル波形、演算波
形、またはリファレンス波形を選択し
ます。

3. タブを使用して、5 つの異なるカテゴ

リの測定を選択します。

4. すべての測定を削除するには、Clear
All をクリックします。

5. 複数の測定を削除するには、クリッ
クおよびドラッグして測定を選択し、
Clear Selected をクリックします。
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Measure（測定）メニューで、選択した波形

の測定方法を直接選択することもできま
す。（自動測定一覧(128 ページ)を参

照）。 

ヒント

■ ロール・モードでは、アクイジションを停止するまで測定値を利用できません。

警告： 垂直方向にクリッピングされた場合、リードアウトに電圧が低く表示されていても、プローブ・チップには

危険な電圧がかかっていることがあります。垂直方向にクリッピングされた場合は、  記号がリードアウトに
表示されます。振幅関連の自動測定で、信号が垂直方向にクリッピングされた場合は測定結果が不正確に
なります。またクリッピングされると、他のプログラムで使用するためにエクスポートしたり保存したりした波形
の振幅値が不正確になります。演算波形がクリッピングされている場合、その演算波形の振幅測定には影響
を与えません。

自動測定一覧

次の表は、振幅、時間、詳細、ヒストグラム、コミュニケーションのカテゴリ別に各自動測定の一覧を示したもので
す （自動測定の実行(127 ページ)を参照）。

表 9 : 振幅測定

測定 概要

振幅 波形全体またはゲート領域で測定されたハイ値からロー値を引きます。

ハイ この値は、立下り時間や立上り時間の測定などで、高基準値、中間基準値、低基準
値が必要な場合に 100% 値として使用されます。この値の計算には、最小／最大方

式またはヒストグラム方式を使用します。最小／最大方式では、検出された最大値
を使用します。ヒストグラム方式では、中点より上で最も頻繁に出現する値を使用し
ます。この値は、波形全体またはゲートされた領域について測定されます。
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測定 概要

ロー この値は、立下り時間や立上り時間の測定などで、高基準値、中間基準値、低基準
値が必要な場合に 0% 値として使用されます。この値の計算には、最小／最大方式

またはヒストグラム方式を使用します。最小／最大方式では、検出された最小値を
使用します。ヒストグラム方式では、中点より下で最も頻繁に発生する値を使用しま
す。この値は、波形全体またはゲートされた領域について測定されます。

実効値 波形全体またはゲート領域の真の実効値（RMS）電圧です。

AC 実効値 測定領域で電圧を二乗平均した値。

最大 通常は、正の最大ピークの電圧です。最大値は、波形全体またはゲート領域全体に
ついて測定されます。

最小 通常は、負の最大ピークの電圧です。最小値は、波形全体またはゲート領域全体に
ついて測定されます。

Pk-Pk（P-P 値） 波形全体またはゲート領域における最大振幅と最小振幅の絶対差です。

サイクル実効値 波形の最初のサイクルまたはゲート領域の最初のサイクルにわたる真の実効値
（RMS）電圧です。

+Overshoot（正オーバシュー

ト）

この値は、波形全体またはゲート領域全体について測定され、次の式で表されま
す。 正のオーバシュート =（（最大値 － ハイ値）／振幅） × 100%。

-Overshoot（負オーバシュー

ト）

この値は、波形全体またはゲート領域全体について測定され、次の式で表されま
す。 負のオーバシュート＝（ロー値 － 最小値）／振幅 × 100%。

Mean（平均値） 波形全体またはゲート領域にわたる算術平均です。

サイクル平均値 波形の最初のサイクルまたはゲート領域の最初のサイクルにわたる算術平均で
す。

表 10 : 時間測定

測定 概要

立上り時間 波形またはゲート領域の最初のパルスの立上りエッジで、低基準値（デフォルト =
10%）から最終値の高基準値（デフォルト = 90%）まで上昇するのに要する時間です。

立下り時間 波形またはゲート領域の最初のパルスの立下りエッジで、高基準値（デフォルト =
90%）から最終値の低基準値（デフォルト = 10%）まで下降するのに要する時間です。

Pos Width（+ パルス幅） 正パルスの中間基準（デフォルトは 50%）振幅ポイント間の距離（時間）です。波形ま

たはゲート領域における最初のパルスで測定されます。

Neg Width（- パルス幅） 負パルスの中間基準（デフォルトは 50%）振幅ポイント間の距離（時間）です。波形ま

たはゲート領域における最初のパルスで測定されます。

+Duty Cyc（正デューティ・サ

イクル）

信号周期に対する正のパルス幅の比率をパーセンテージで表します。デューティ・
サイクルは、波形またはゲート領域の最初のサイクルで測定されます。

-Duty Cyc（負デューティ・サ

イクル）

信号周期に対する負のパルス幅の比率をパーセンテージで表します。デューティ・
サイクルは、波形またはゲート領域の最初のサイクルで測定されます。

Period 波形またはゲート領域の最初のサイクルを完了するのに要する時間です。周期は
周波数の逆数で、単位は秒です。

周波数 波形領域またはゲート領域にある最初のサイクルの周波数。Frequency（周波数）は

期間の逆数です。単位はヘルツ（Hz）で、1Hz は 1 サイクル／秒です。

Delay 2 つの異なる波形の中間基準（デフォルトは 50%）振幅ポイント間の時間です。
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表 11 : 詳細測定

測定 概要

領域 波形全体またはゲート範囲の領域を電圧-秒で表します。グランドより上の測定領域

は正、グランドより下の測定領域は負です。

サイクル領域 波形の最初のサイクルまたはゲート範囲の最初のサイクルの領域を電圧-秒で表し

ます。共通基準ポイントより上の領域は正、下の領域は負となります。

位相 波形の一方が他方よりも先行または遅延する時間量を角度で表します。360°が 1 波
形サイクルに相当します。

バースト幅 波形全体またはゲート領域全体について測定されたバースト（一連の過渡的現象）
の継続時間です。

表 12 : ヒストグラムの測定項目

測定 概要

Wfm Ct（波形数） ヒストグラムに含まれる波形数を表示します。

Hits in Box（ボックス内ヒット

数）

ヒストグラム・ボックス内またはボックス上のポイント数。

Peak Hits（ピーク・ヒット数） ヒストグラムの最大ビンに含まれるポイント数を表示します。

Median（メジアン） ヒストグラム・ボックスの中点を表示します。ヒストグラム・ボックス内またはボックス
上で取り込んだすべてのポイントの半分はこの値より下、半分はこの値より上になり
ます。

最大 垂直ヒストグラムにはゼロ以外の最も高いビンの電圧、水平ヒストグラムにはゼロ以
外の最も右側にあるビンの時間が表示されます。

最小 垂直ヒストグラムにはゼロ以外の最も低いビンの電圧、水平ヒストグラムにはゼロ以
外の最も左側にあるビンの時間が表示されます。

Pk-Pk（P-P 値） ヒストグラムの p-p 値を表示します。垂直ヒストグラムは、ゼロ以外の最高ビンの電

圧からゼロ以外の最低ビンの電圧を引いた値を表示します。水平ヒストグラムに
は、ゼロ以外の最も右側にあるビンの時間からゼロ以外の最も左側にあるビンの時
間を引いた値が表示されます。

Mean（平均値） ヒストグラム・ボックス内またはボックス上のすべてのポイントを取り込み、平均を測
定します。

Std Dev ヒストグラム・ボックス内またはボックス上で取り込んだすべてのポイントの標準偏差
（実効値（RMS）偏差）を測定します。

Mean ± 1 Std Dev（平均

±3 標準偏差）

ヒストグラム内で、ヒストグラム平均から 1 標準偏差内にあるポイントのパーセンテ

ージを表示します。

Mean ± 2 Std Dev（平均

±3 標準偏差）

ヒストグラム内で、ヒストグラム平均から 2 標準偏差内にあるポイントのパーセンテ

ージを表示します。

Mean ± 3 Std Dev（平均

±3 標準偏差）

ヒストグラム内で、ヒストグラム平均から 3 標準偏差内にあるポイントのパーセンテ

ージを表示します。
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表 13 : 通信測定

測定 概要

Ext Ratio（消光比） アイのトップとベースの比率。この測定は、波形データベースまたは波形データベー
ス・モードで保存されたリファレンス波形に対してのみ有効です。

Ext Ratio %（消光比 %） アイ・ベースに対するアイ・トップの比率をパーセンテージで表します。この測定は、
波形データベースまたは波形データベース・モードで保存されたリファレンス波形に
対してのみ有効です。

Ext Ratio（消光比（dB）） アイ・ベースに対するアイ・トップの比率をデシベル数で表します。この測定は、波形
データベースまたは波形データベース・モードで保存されたリファレンス波形に対し
てのみ有効です。

Eye Height（アイ高さ） アイ高さの測定値（ボルト）です。

Eye Width（アイ幅） アイ幅の測定値（秒）です。

Eye Top（アイ・トップ） 消光比の測定に使用される最高値です。

Eye Base（アイ・ベース） 消光比の測定に使用される最低値です。

Crossing %（交差 %） アイ交差ポイントをアイ高さのパーセンテージとして表します。

Jitter P-P（ジッタ P-P） 現在の水平軸単位にあるエッジのジッタのピーク・ピーク値。

Jitter RMS（ジッタ RMS） 現在の水平軸単位内にあるエッジのジッタの RMS 値。

Jitter 6 Sigma（ジッタ 6 シグ

マ）

エッジ・ジッタの RMS 値の 6 倍を現在の水平軸の単位で表したものです。

Noise P-P（ノイズ P-P） ユーザが指定した信号のトップまたはベースのノイズのピーク・ピーク値。

Noise RMS（ノイズ RMS） ユーザが指定した信号のトップまたはベースのノイズの RMS 値。

S/N Ratio（S/N（信号対ノイ

ズ）比）

ユーザが指定した信号のトップまたはベースのノイズに対する信号振幅の比率。

Cyc Distortion（サイクル歪

み）

最初のアイ交差のピーク・ツー・ピークの時間変動を、アイ周期のパーセントとして
中基準で測定したものです。

Q-Factor（Q ファクタ） ノイズに対するアイ・サイズの比率です。

自動測定のカスタマイズ

ゲートの使用、測定統計の修正、測定基準レベルの調整、またはスナップショットの取得により、自動測定をカス
タマイズします。
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ゲーティング

ゲートを使用して、測定を波形の特定部
分に限定します。 

1. Measure > Gating > Gating... を選択し

ます。

2. ゲートの位置を設定するには、次の
いずれかの操作を行います。

■ Cursor（カーソル）をクリックし、

カーソルとカーソルの間の領域
をゲート範囲に設定します。

■ Zoom (1-4) をクリックして、Zoom
1 ～ 4 目盛に対するゲート領域

を設定します。

 

統計

統計は測定時に自動的にオンになりま
す。統計により測定の安定性の特性を
調べることができます。 

1. 表示された統計を変更するには、
Measure > Statistics を選択して、

Mean または All を選択します（All（す
べて）には、最小値、最大値、平均
値、標準偏差、および母集団が含ま
れます）。

2. 統計を削除するには、Off を選択しま

す。

注： カーソルを測定値の上に置くと、
高分解能の測定値が表示されま
す。
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スナップショット

ある時点における有効なすべての測定
の状態を確認するには、Measure >
Snapshot を選択します。 

注： 測定のセットアップが無効の場合
は、測定結果として 3 つの疑問符が表示
されます。

 

一般的な測定のスナップショットを取得
するには General を、通信測定のスナッ

プショットを取得するには Comm を選択し

ます。 

測定のコメント

1. 測定にコメントを付けるには、
Measurements Setup コントロール・ウ

ィンドウで、Annotation を選択しま

す。ドロップダウン・リストから、コメン
トを付ける測定を選択します。
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2. 測定コメントの記述量を選択するに
は、Measure > Annotation > Standard
または Detailed を選択します。

波形の解析  

134  DPO70000SX シリーズ・ユーザ



リファレンス・レベル

基準レベルにより、時間関連の測定の取
込み方法が決定されます。 

1. Measure > Reference Levels... を選択

します。

2. 測定基準レベルを別の相対値また
は絶対値に調整します。

■ 立上り時間や立下り時間の計
算には、High 基準および Low 基
準が使用されます。デフォルト
の High 基準は 90%、Low 基準は

10% です。
■ Mid（中）基準は、主にパルス幅

などのエッジ間の測定に使用し
ます。デフォルトのレベルは 50%
です。

■ Mid2（中 2）基準は、遅延または

位相の測定で指定された 2 番
目の波形に使用されます。デフ
ォルトのレベルは 50% です。

 

ヒント

■ アイ信号の測定時にノイズ値を正確に測定するには、Reference Levels Setup メニューに移動して、信号タイプ

を必ず Eye（アイ）に設定してください。
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カーソル測定の実行

取り込まれた波形について、手動で測定するにはカーソルを使用します。

1. Cursors > Cursor Controls を選択す

るか、外部フロント・パネルの
Cursors ボタンを押します。

注： カーソルがオンで汎用ノブ・リー
ドアウトが位置コントロールに連結し
ていない場合は、Cursors ボタンを押
してコントロールをリードアウトに連
結します。 カーソルをオフにするに
は Cursors ボタンをもう一度押しま
す。

 

2. Cursor Source（カーソル・ソース）を選

択します。

3. 次の中からカーソル・タイプを 1 つ選

択します。

■ 水平バーには、振幅（一般的に
はボルトまたはアンペア単位）
が測定されます。

■ 垂直バーには、水平軸パラメー
タ（一般的には時間）が測定さ
れます。

■ 垂直軸パラメータと水平軸パラ
メータは、波形カーソルおよびス
クリーン・カーソルで同時に測定
されます。 波形カーソルは波形

に接触し、スクリーン・カーソル
は波形に接触せずに浮かんだ
状態になります。
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4. 2 つの波形間の測定を行う場合は、

Waveform を選択して、各カーソル用

の波形ソースを選択します。

5. Cursors > Cursor Position... を選択

し、汎用ノブを使用してカーソル位置
を調整します。

6. 表示されるカーソル測定結果を確認
します。

ヒント

■ 複数のカーソルが並んで移動するように設定するには、Cursor Track Mode を使用します。各カーソルを別々に

移動するには、独立カーソル・モードを使用します。

■ ズーム目盛を使用すると、カーソルを波形の特定ポイントに直接配置し、精密な測定を行うことができます。

■ また、カーソルをクリックおよびドラッグして、別の位置へ移動することもできます。

■ Move Cursors to Center を押して、ディスプレイの中央にカーソルを移動することもできます。

■ 実線または点線のカーソルを選択できます。

■ トリガ・ポイントから垂直カーソルまでの時間は、垂直カーソルで測定されます。
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ヒストグラムの設定

垂直（電圧）または水平（時間）のどちらか一方のヒストグラムを表示できます。 ヒストグラム測定を使用して、1 つ
の軸に沿った波形のセクションに関する統計測定データを取得できます。

1. ヒストグラムの対象になる波形セグ
メ ントを横切るようにポインタをクリ

ックし、ドラッグします。 たとえば、水

平ヒストグラムの高さより高いボック
スを作成します。

2. ショートカット・メニューから、
Histogram Vertical（垂直ヒストグラ

ム）または Histogram Horizontal（水
平ヒストグラム）を選択します。

3. 目盛の上部（水平ヒストグラムの場
合）または左端（垂直ヒストグラムの
場合）にヒストグラムを表示されま
す。
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4. ヒストグラムのスケール、またはヒス
トグラム・ボックスのサイズおよび位
置を調整するには、Measure >
Waveform Histograms を選択して、

Histogram Setup コントロール・ウィンド

ウを使用します。

5. また、ヒストグラム・データを自動測
定することもできます。（自動測定の
実行(127 ページ)を参照）。

ヒント

■ 垂直ヒストグラムは信号ノイズの測定、水平ヒストグラムは信号ジッタの測定に使用します。

■ ショートカット・メニューをアクティブにして、ヒストグラムの表示をオフにする場合は、クリックおよびドラッグの
手順を使用します。
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演算波形の使用

チャンネル波形やリファレンス波形の解析をサポートするには、演算波形を作成します。ソース波形などのデータ
を組み合わせたり変換したりすることで、実際に必要なデータ表示を導出することができます。

あらかじめ定義されている演算式の場合は、次の手順を使用します。

1. Math > Math Setup... を選択します。

2. あらかじめ定義されている数値式の
1 つを選択します。

高度な演算波形式を作成するには、次の手順を使用します。

1. Math > Math Setup... を選択します。

2. Editor（エディタ）をクリックします。
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3. ソース、演算子、定数、測定、変数、
および関数を使用して高度な演算波
形式を作成します。

4. 条件に合った式が定義されたら、
Apply（適用）をクリックします。

5. 独自のフィルタを追加するには、
Filter タブをクリックします。Load（読
み込み）をクリックします。

6. 使用するフィルタのフォルダをダブ
ルクリックします。使用するフィルタ
をダブルクリックします。

7. 選択したフィルタを使用して、演算式
を構築します。

8. 条件に合った式が定義されたら、
Apply（適用）をクリックします。
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ヒント

■ 演算式をダブルクリックすると、Math Equation Editor が開きます。

■ ソースが無効の場合、演算定義は作成されません。

■ 演算波形は、アナログ・チャンネル波形、リファレンス波形、演算ソース波形および測定値を基に作成しま
す。

■ 演算波形に対する測定は、チャンネル波形と同じ方法で行います。

■ 演算波形の水平スケールおよび位置は、演算式のソースから導出されます。ソース波形のこれらのコントロ
ールを調整すると、演算波形も調整されます。

■ Autoscale がチェックされていない場合は、演算波形をオンにしたり演算式を変更した際に、垂直軸方向のス

ケールや位置は計算されません。

■ 演算波形を拡大するには、MultiView Zoom を使用します。ズーム領域の位置を調整するには、マウスを使用し

ます。

■ 任意演算フィルタの詳細についてはオンライン・ヘルプを参照してください。
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スペクトラム解析の使用

定義済みスペクトラム演算式には、次の手順を使用します。詳細についてはオンライン・ヘルプを参照してくださ
い。

1. Math > Math Setup... を選択します。

2. あらかじめ定義されているスペクトラ
ム演算式の 1 つを選択します。

3. Basic をクリックします。

4. Resolution BW または Frequency Span
をクリックし、キーパッドまたは汎用
ノブを使用して、スペクトラムの表示
を調整します。

注： Resolution BW と Frequency Span
は、手動水平モードの場合にのみ調
整可能です。

 

高度なスペクトラム演算式を作成するには、次の手順を使用します。
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1. Math > Advanced Spectral... を選択し

ます。

2. 定義する演算波形を選択します。

3. 作成するスペクトラム波形のタイプ
をクリックします。波形を定義しなお
すには、Clear（クリア）をクリックしま

す。

4. ソース波形を選択します。

5. Spectral Setup コントロール・ウィンド

ウのコントロール、または外部フロン
ト・パネルの汎用ノブを使用して、ス
ペクトラムの波形を調整します。

6. 時間領域と周波数領域の波形を同
時に表示できます。

Gating を使用して、スペクトラム解析

の対象として時間領域波形の一部
分だけを選択します（ゲーティング
(132 ページ)を参照）。 

ヒント

■ スペクトラム演算波形のソースは、チャンネル波形または他の演算波形である必要があります。

■ 短いレコード長を使用すると、機器の応答が速くなります。

■ 長いレコード長を使用すると、信号に対してノイズが低減するため、周波数分解能が向上します。
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■ ウィンドウ関数が異なると、スペクトラムのフィルタ・レスポンスの形状が異なり、分解能帯域幅も異なる結果
になります。詳細についてはオンライン・ヘルプを参照してください。

■ ゲート幅は分解能帯域幅（RBW）によって直接制御されます。 このため、コントロールを調整すると、時間領

域ゲート・マーカも移動します。

■ スペクトラムの実数データまたは虚数データの線形振幅を表示できます。これは、スペクトラムをオフラインで
処理し、時間領域トレースに変換する場合に便利です。
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マスク・テストの使用

シリアル通信マスク・テスト（オプション MTM または MTH）では、あらかじめ定義されたテンプレートまたはマスクと

信号を比較することができます。信号がテストに合格するには、マスクにより定義されたセグメントの範囲外にな
っている必要があります。一般的に、マスクは ANSI などの規格委員会によって定義されます。 マスク・テストを実

行するには、次の操作を行います。

1. Mask > Source... を選択します。

2. 信号ソースを選択します。

3. Masks タブをクリックします。

4. Type および規格を選択します。

3357-002

44

波形の解析  

146  DPO70000SX シリーズ・ユーザ



5. Config（設定）ボタンをクリックして、

Mask Configuration（マスク設定）コント

ロール・ウィンドウにアクセスします。
このコントロール・ウィンドウでは、マ
スクと違反の表示方法、およびマス
クの Autoset（オートセット）と Autofit
（オートフィット）の設定値を調整する
ことができます。

6. Masks（マスク）をクリックし、Mask
Setup（マスクの設定）コントロール・

ウィンドウに戻ります。

7. Lock Mask to Wfm をクリックして On に

し、水平軸または垂直軸の設定の
変更に合わせてマスク変更されるよ
うにします。

8. Hit Count を On に切り替えて、マス

ク・テスト中に違反がハイライト表示
されるようにします。

9. Autoset（オートセット）をクリックし、

入力信号の特性に基づいて、波形
がマスクと自動的に揃うようにしま
す。

10. Autofit を On に切り替えて、各アクイ

ジション後に波形の位置が自動的に
変更され、ヒット数が採用に抑えら
れるようにします。

11. Tolerance（公差）タブをクリックして、

公差を設定します。

公差の設定を 0% より大きくすると、

マスク・テストに通過しづらくなりま
す。設定を 0% より小さくすると、マス

ク・テストの通過が容易になります。 

標準で指定されたとおりのマスクが
必要な場合は、0% を使用してくださ

い。 パーセンテージを変更すること

により、マージン・テストを実施する
ことができます。 
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12. Pass/Fail Setup（合否テスト設定）タブ

をクリックして、合否テスト・パラメー
タを設定します（アクイジション・モー
ドが Waveform Database（波形データ

ベース）のときは、# of Wfms（波形

数）ラベルが Samples（サンプル）に

なります）。

13. Pass/Fail Test Notifications（合否テスト

通知）を選択します。

14. テストする波形の極性を選択しま
す。

15. Repeat を On に切り替えると、マス

ク・テストが連続的に実行されます。

16. テスト終了時の通知方法を選択しま
す。

17. Pass/Fail Results（合否テスト結果）タ

ブをクリックすると、テスト結果が表
示されます。

18. Pass/Fail Test（合否テスト）をクリック

して On（オン）にすると、マスク・テス

トが開始されます。

19. 合計をリセットし、すべての違反をク
リアするには、Reset（リセット）をクリ

ックします。

ヒント

■ マスク内に信号が存在しない場合、Autoset（オートセット）を有効にして、マスク内の中央に波形を配置しま

す。
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リミット・テストの使用

リミット・テスト機能を使用すると、アクティブ信号とテンプレート波形を比較できます。 既知の適切な信号からテン

プレート波形を作成し、そのテンプレート波形を使用してアクティブな信号と比較し、パス／フェイル・テストを行い
ます。

1. Mask > Limit Test Setup... を選択しま

す。

2. Source、Destination、および Tolerances
を選択して、テンプレートを作成しま
す。汎用ノブを使用して、Tolerances
を調整します。Tolerances は、信号が

リミット・テストでフェイルになるまで
に許容されるマージンを指定しま
す。

3. Save をクリックします。あとで使用で

きるよう、複数のテンプレートを作成
して保存することができます。

4. テンプレートと比較するソース波形を
選択します。

5. ソース波形と比較するテンプレートを
選択します。 （通常、これはステップ

 3 で作成したテンプレートになりま

す。）

 波形の解析
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6. Failure Notification をクリックし、エラ

ー通知をセットアップします。

7. Failure Notification(s) を選択し、Setup
をクリックして、セットアップ・コントロ
ール・ウィンドウに戻ります。

8. Lock Template to Waveform の On をク

リックすると、垂直軸スケールまたは
テンプレート位置をソース波形に合
わせて固定されます。

9. Highlight Hits の On をクリックすると、

テンプレートから外れるポイントが別
の色で表示されます。

10. Limit Test を On に切り替えると、テス

トが開始されます。

11. Reset をクリックすると、すべての違

反がクリアになりテストがリセットさ
れます。

ヒント

■ アクティブ波形または保存されている波形を使用して、リミット・テスト・テンプレートを作成します。

■ 平均アクイジション・モードを使用すると、よりスムーズなテンプレート波形が作成されます。

■ エンベロープ・アクイジション・モードを使用すると、時折発生するオーバーシュート対応のテンプレートが作成
されます。
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MyScope
MyScope では、日常的に使用するコントロールのみで構成されたカスタム・コントロール・ウィンドウを作成できま

す。いくつかのコントロール・ウィンドウを切り替えるのではなく、使用するコントロールを 1 つのカスタム・コントロ

ール・ウィンドウに配置します。

このセクションでは、MyScope コントロール・ウィンドウを作成および使用する手順について説明します。詳細につ

いてはオンライン・ヘルプを参照してください。

新しい MyScope コントロール・ウィンドウの作成

1. MyScope > New Control Window... を
選択します。

2. +（プラス記号）をクリックしてカテゴリ

を展開します。MyScope コントロー

ル・ウィンドウに追加できるコントロ
ールが、それぞれのカテゴリ内に表
示されます。これらのカテゴリはメニ
ュー・バーと同じ配置で表示される
ため、よく使用するコントロールを簡
単に見つけることができます。

3. コントロールをクリックし、プレビュー
を表示します。
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4. コントロールをダブルクリックするか
または + （プラス記号）をクリックし、

コントロール・リストを展開します（+
（プラス記号）がない場合は、コント
ロールをそれ以上カスタマイズでき
ません）。

5. チェック・ボックスをオフにして、コン
トロールに表示しないコンポーネント
を選択解除します。

MyScope  
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6. コントロールをクリックし、MyScope コ
ントロール・ウィンドウまでドラッグし
ます。マウス・ボタンを放すと、最も
近いグリッド位置にコントロールが配
置されます。 コントロールをクリック

してドラッグすると、MyScope コントロ

ール・ウィンドウ内のコントロールの
配置を変更できます。

7. New Tab をクリックし、MyScope コント

ロール・ウィンドウにタブを追加しま
す。最大 6 つのタブを設定できま

す。

8. タブの名前を変更するには、次のい
ずれかの操作を行います。

■ Rename Tab をクリックします。

■ タブをダブルクリックして、新し
い名前を入力します。

 

9. User Pref...（ユーザ設定...）をクリック

し、MyScope コントロール・ウィンドウ

にロードするユーザ設定を指定しま
す。

 MyScope
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10. コントロールを削除するには、次の
いずれかの操作を行います。

■ タブを選択し、Delete（削除）をク

リックします。タブとすべてのコ
ントロールが削除されます。

■ コントロールを選択し、Delete（削
除）をクリックします。選択したコ
ントロールだけが削除されま
す。

 

11. Save（保存）をクリックし、MyScope コ
ントロール・ウィンドウの名前を入力
するか、またはデフォルトの名前を
使用します。

ヒント

■ コントロールを再設定するには、コントロールをクリックし、プレビュー・ウィンドウまでドラッグして戻します。次
に、チェック・ボックスをオンまたはオフにして、コントロール内のコンポーネントを選択したり選択解除したりし
ます。

■ タブの順番を変更するには、タブをクリックして新しい位置までドラッグします。

■ コントロールを削除するには、コントロールをクリックして、画面の上半分（MyScope コントロール・ウィンドウの

外側）までドラッグします。

MyScope  
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MyScope コントロール・ウィンドウの使用

以前に作成した MyScope コントロール・ウィンドウを開くには、次の手順を実行します。

1. MyScope > Open Control Window... を
選択するか、または最近使用した
5 つの MyScope ウィンドウの 1 つを

選択します。

2. 使用する MyScope コントロール・ウィ

ンドウを選択し、Open（開く）をクリッ

クします。

アクティブな MyScope コントロール・ウィンドウを表示するには、次の手順を実行します。

1. MyScope > Current... を選択するか、

またはツールバー・モードで
MyScope をクリックします（MyScope
コントロール・ウィンドウが表示され
ない場合でも、そのウィンドウはアク
ティブのままになります）。

MyScope コントロール・ウィンドウを編集するには、次の手順を実行します。

 MyScope
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1. MyScope > Edit Control Window... を
選択します。

2. 編集するコントロール・ウィンドウを
選択し、Open（開く）をクリックしま

す。

ヒント

■ MyScope コントロール・ウィンドウの一部のコントロールの機能は、標準のコントロール・ウィンドウにおける機

能と異なります。詳細については、オンライン・ヘルプを参照してください。

■ MyScope コントロール・ウィンドウ（.tcw ファイル）は、MSO/DPO70000DX シリーズ、MSO/DPO70000C シリーズ、

DPO7000C シリーズ、および MSO/DPO5000B シリーズの別の機器にコピーできます。

MyScope  
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情報の保存と呼び出し

このセクションでは、スクリーン・イメージとセットアップの保存および呼び出し、測定の保存、クリップボードの使
用、および機器での印刷の手順について説明します。詳細についてはオンライン・ヘルプを参照してください。

スクリーン・イメージの保存

1. File > Save または Save As > Screen
Capture... を選択します。

2. Palette、View、Image、または Screen
Capture Format オプションをセットアッ

プする場合は Options... をクリックし

ます。セットアップしない場合はステ
ップ  3 に進みます。
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3. スクリーン・イメージを保存する場所
を選択します。

4. スクリーン・イメージの名前を入力す
るか、またはデフォルトの名前を使
用して、ファイルの種類を選択しま
す。

5. Save をクリックします。

ヒント

■ 複数のスクリーン・イメージを高速保存するには、Set Front Panel Print Button to Save を選択して、Save をクリ

ックします。 これで、外部フロント・パネルの Print ボタンを押すことにより、スクリーン・イメージを保存できるよ

うになります。

情報の保存と呼び出し  
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波形を保存

1. 波形を保存するには、File > Save ま
たは Save As > Waveform... を選択し

ます。

2. Waveform をクリックします。

3. Waveform Data Range、FastFrame Data
Range、Waveform Detail、Data
Destination、Source、または Data
Ordering を指定する場合は Options...
をクリックします。指定しない場合は
ステップ  4 に進みます。

 情報の保存と呼び出し
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4. ソースを選択します。

5. 波形は、リファレンス波形として機器
メモリに保存することも、.wfm ファイ

ル形式で Windows ディレクトリに保

存することもできます。 波形をリファ

レンスとして保存するには、Ref 1 ～
4 を選択します。.wfm ファイル形式

で保存するには、波形を保存する場
所を選択します。

6. .wfm ファイル形式で保存する場合

は、ファイル名を入力するか、デフォ
ルトの名前を使用します。

7. Save をクリックします。

ヒント

■ 類似する波形を複数保存する場合は、Auto-increment file name チェック・ボックスをオンにすると、同じような

名前を繰り返し入力する手間が省けます。

■ 複数の波形を高速保存するには、Set Front Panel Print Button to Save を選択して、Save をクリックします。 こ
れで、外部フロント・パネルの Print ボタンを押すことにより、波形を保存できるようになります。

情報の保存と呼び出し  
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波形の呼出

1. File > Recall... を選択します。

2. Waveform をクリックします。

3. 呼び出す波形の保存先を選択しま
す。

4. 呼び出す波形を選択します。

5. Recall（呼出し）をクリックします。

Recall をクリックすると、リファレンス

波形がオ ンになり、Reference
Waveform コントロール・ウィンドウが

アクティブにな ります。

6. コントロールを使用して、リファレン
ス波形を調整します。 File >
Reference Waveform Controls... を選

択して、Reference Waveform コントロ

ール・ウィンドウにアクセスすること
もできます。

ヒント

■ 保存可能なファイルにはさまざまな種類がありますが、呼出せるのは設定（*.set）ファイルおよび波形（*.wfm）

ファイルのみです。

 

 情報の保存と呼び出し
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機器設定の保存

1. File > Save または Save As > Setup...
を選択します。

2. Setup をクリックします。

3. 設定を保存する場所を選択します。
設定は、10 個の設定ストレージ位置

のうちの 1 つとして機器のメモリに保

存することも、.set ファイル形式で

Windows ディレクトリに保存すること

もできます。

4. ファイル名を入力するか、デフォルト
の名前を使用します。 ポップアップ・

キーボードを使用して、機器のメモリ
に保存された設定に対して名前を入
力します。

5. Save をクリックします。

ヒント

■ タッチ・スクリーンが有効な場合は、容易に識別できるようにポップアップ・キーパッドを使用してその設定にラ
ベルを付けます。

■ 類似するファイルを複数保存する場合は、Auto-increment file name チェック・ボックスをオンにすると、同じような

名前を繰り返し入力する手間が省けます。

■ 複数の設定を高速保存するには、Set Front Panel Print Button to Save を選択して、Save をクリックします。 こ
れで、外部フロント・パネルの Print ボタンを押すことにより、設定を保存できるようになります。
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機器設定の呼び出し

1. File > Recall... を選択します。

2. Setup をクリックします。

3. 呼び出す設定を選択します。 設定フ

ァイルは、機器のメモリの 10 個 の
位置のうちの 1 つから、または

Windows ディレクトリから呼び出すこ

とができます。

現在のでスキュー設定をそのまま使
用するには、Don't recall deskew
values チェック・ボックスをオンにしま

す。 

4. Recall（呼出し）をクリックします。

ヒント

■ ディスク上に保存されている設定は、呼出して、内部設定ストレージ位置に保存すると簡単に使用できます。

 情報の保存と呼び出し
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測定の保存

1. File > Save または Save As >
Measurement... を選択します。

2. Displayed Measurements、Measurement
Snapshot、または Measurement Format
を指定する場合は Options... をクリッ

クします。指定しない場合はステップ
 3 に進みます。

3. 測定を保存する場所を選択します。

4. 測定の名前を入力し、ファイル・タイ
プを選択します。

5. Save をクリックします。

情報の保存と呼び出し  
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ユーザ・マスクの保存

1. File > Save または Save As > User
Mask を選択します。

2. User Mask をクリックします。

3. マスクを保存する場所を選択しま
す。

4. マスク名を入力し、ファイル・タイプを
選択します。

5. Save をクリックします。

 情報の保存と呼び出し
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ヒストグラム・データの保存

1. File > Save または Save As >
Histogram Data を選択します。

2. Histogram を選択します。 以前の選

択によっては、Histogram の選択肢を

表示するために、More > Histogram
Data を選択する必要がある場合が

あります。

3. ヒストグラムを保存する場所を選択
します。

4. ヒストグラム名を入力し、ファイル・タ
イプを選択します。

5. Save をクリックします。

情報の保存と呼び出し  
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タイムスタンプの保存

1. File > Save or Save As > Timestamp
Table を選択します。

2. Timestamp をクリックします。 以前の

選択によっては、Timestamp の選択

肢を表示するために、More >
Timestamp Table を選択する必要が

ある場合があります。

3. Source または FastFrame Data Range
を指定する場合は Options... をクリッ

クします。指定しない場合はステップ
 4 に進みます。

4. タイムスタンプを保存する場所を選
択します。

5. タイムスタンプ名を入力し、ファイル・
タイプを選択します。

6. Save をクリックします。

 情報の保存と呼び出し
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クリップボードへの結果のコピー

Microsoft クリップボードにコピーするイメージ、波形、または測定値の出力内容およびフォーマットを設定するに

は、次の手順を使用します。

1. Edit > Copy Setup... を選択します。

2. Images（イメージ）タブ、Waveforms
（波形）タブ、または Measurements
（測定）タブをクリックして、必要なオ
プションを選択します。

イメージ、波形、または測定値をコピーするには、次の手順を実行します。

情報の保存と呼び出し  
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1. コピーするアイテムを選択します。

2. Edit > Copy を選択するか、Ctrl + C を
押します。

3. Ctrl + V を押して、Windows アプリケ

ーションに貼り付けます。

 情報の保存と呼び出し
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ハードコピーの印刷

1. ハード・コピーを印刷するには、印刷
ボタンを押すか、または File > Print
を選択します。必要であれば、Page
Setup ダイアログ・ボックスで、ページ

の方向を変更します。

Print（印刷）ダイアログ・ボックスおよび

Page Setup（ページ設定）ダイアログ・ボッ

クスは、使用しているプリンタによって異
なります。 

2. Page Setup... をクリックします。

3. 印刷パラメータを選択します。

情報の保存と呼び出し  
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アプリケーション・ソフトウェアの実行

各アプリケーションについて、本器で 10 回の無料トライアルを行うことができます。これらのアプリケーションに

は、アプリケーション固有の測定ソリューションが用意されています。以下にいくつかの例を示します。追加のパッ
ケージが入手できる場合もあります。機器によっては、使用できないアプリケーションもあります。詳細について
は、当社の担当者にお問い合わせいただくか、当社の Web サイト（www.tektronix.com）にアクセスしてください。 

■ 複雑なクロック、デジタル、およびシリアルのデータ信号の測定の信頼度を高めるには、DJA DPOJET
Advanced (ジッタ／アイ・ダイアグラム解析) を使用します。DPOJET Essentials はすべてのモデルに標準で搭載

されています。

■ 複雑なクロック、デジタル、およびシリアルのデータ信号の測定の信頼度を高めるには、DJAN-DPOJET を使

用します（オプション DJA 型が必要）。

■ 取り込まれた波形と設定した許容限界を比較するには、LT（波形リミット・テスト）を使用します。

■ MOST50 および MOST150 の電気的適合性およびデバッグ試験には、MOST Essentials を使用します。

■ 4 値パルス振幅変調（PAM4）デバイスおよびインタフェースのトランスミッタ／チャンネル・テストには、PAM4 を
使用します。

■ シリアル・データ・チャンネルのエミュレート、フィクスチャのディエンベデッド、トランスミッタ・イコライゼーション
の挿入または除去を行うには、SDLA64（シリアル・データ・リンク解析ビジュアライザ）を使用します。

■ 8B/10B 信号のシリアル・トリガと解析を行うには、SR-810B を使用します（ST6G が必要）。

■ オーディオ信号を解析するには、SVA（AM/FM/PM オーディオ信号解析）を使用します（オプション SVE が必

要）。

■ 広帯域設計の検証および広帯域スペクトラム・イベントの評価を行うには、 SVP、SVM、および SVE（スペクトラ

ム解析アプリケーション）を使用します。

■ フレキシブル OFDM の解析には SVO を使用します（SVE が必要）。

■ 周波数と位相のセトリング時間の測定には SVT を使用します（SVE が必要）。

■ WLAN802.11a/b/g/j/p 信号を測定するには、SV23 WLAN802.11a/b/g/j/p 測定アプリケーションを使用します（Opt.
SVE が必要）。

■ WLAN802.11n 信号を測定するには、SV24 WLAN 802.11n 測定アプリケーションを使用します（オプション SV23
が必要）。

■ WLAN802.11ac 信号を測定するには、SV25 WLAN 802.11ac 測定アプリケーションを使用します（オプション SV24
が必要）。

■ Bluetooth 信号を測定するには、SV27（Bluetooth LE TX SIG の基本測定）を使用します。

■ LTE ダウンリンク RF 信号を測定するには、SV28（SignalVu LTE ダウンリンク RF 測定を使用します。

■ ビジュアル・トリガとその検索を有効にするには、VET を使用します。
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ソフトウェアをインストールする場合は、アプリケーション・ソフトウェアに付属のインストラクションに従ってくださ
い。 ソフトウェアを実行するには、Analyze を選択してから、アプリケーションを選択します。
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使用例

このセクションでは、一般的なトラブルシューティング作業における機器の使用例、および機器の使用範囲を広げ
るための例について説明します。

間欠的に発生する異常の取り込み

設計エンジニアが直面する最も困難な作業の 1 つは、間欠的なエラーの原因をつきとめることです。異常の種類

が判明している場合は、オシロスコープの拡張トリガ機能を設定して、問題を容易に特定することができます。し
かし、調査対象が不明な場合、間欠的な異常の調査は、非常に時間がかかり単調で退屈な作業となる場合があ
ります。このことは、従来のデジタル・ストレージ・オシロスコープを使用して、波形の取り込み速度が遅い場合
に、特に顕著となります。

DPX テクノロジにより実現したデジタル・フォスファ・オシロスコープは、FastAcq と呼ばれる非常に高速なアクイジ

ション・モードを備えており、このモードを使用すると、このような異常を数秒または数分で発見することができま
す。通常の DSO では、同じイベントを発見するのに何時間または何日もかかることがあります。 FastAcq は
TekConnect チャンネルでは利用できますが、ATI チャンネルでは利用できません。

間欠的に発生する異常を取り込むには、次の手順を使用します。

1. プローブを入力信号ソースに接続し
ます。

2. Horiz/Acq > Autoset を選択するか、

外部フロント・パネルの Autoset ボタ

ンを押します。
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3. Display > Display Persistence >
Infinite Persistence を選択します。こ

の例では、クロック信号を表示して
います。1、2 分信号を観察したら、

他の場所にある問題を検索する前
に、ステップ  4 に進みます。

4. Horiz/Acq > Fast Acquisitions を選択

するか、外部フロント・パネルの
FastAcq ボタンを押します。

5. 信号内に存在するグリッチ、過渡的
現象、その他の不規則な異常を探し
ます。 この例では、FastAcq により、

わずか数秒後に約 300 ns の正のグ

リッチが発見されています。

6. ステップ  5 で特定したグリッチでトリ

ガするために、Glitch Setup... を選択

します。
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7. 適切な極性を選択します。

8. Level をクリックし、ステップ  5 で見つ

けた結果に基づいてレベルを設定し
ます。

9. Width をクリックし、ステップ  5 で見

つけた結果に基づいてパルス幅を
設定します。

トリガで、高周波バーストを 1 つのパ

ルスとして取り扱う場合は、Envelope
をオンにします。 

10. E-mail on Trigger をクリックして、On に
します。（イベント時の電子メールの
設定(98 ページ)を参照）。

11. 単一のグリッチでトリガするには、
Horiz/Acq > Run/Stop...、Single
Sequence を選択するか、または外

部フロント・パネルで Single ボタンを

押します。

 使用例
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拡張デスクトップおよび OpenChoice アーキテクチャを使用した効率的なドキ

ュメント作成

多くの場合、エンジニアは後で参照できるように研究室の作業を文書化する必要があります。OpenChoice アーキ

テクチャを使用すると、スクリーン・ショットおよび波形データを CD または USB メモリ・デバイスに保存しておいて

後でレポートを生成する代わりに、リアルタイムで作業を文書化することができます。

機器を中心として設計および文書化の処理を行うには、次の手順を使用します。

注： 64 ビットのシステムでは 64 ビットの互換ドライバとアプリケーション・ソフトウェアが必要になります。

1. Microsoft Word または Microsoft Excel
を機器に読み込みます。

2. モニタをもう 1 つ接続します。（2 台
めのモニタの追加(31 ページ)を参

照）。

3. Microsoft Word を開き、Word ウィンド

ウを拡張デスクトップ上にドラッグし
ます。

4. TekScope をクリックして、機器のアプ

リケーションを再び表示します。

5. Edit > Select for Copy > Full Screen
(bitmap) を選択します。
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6. Ctrl+C を押します。

7. Word 文書内でスクリーン・ショットを

配置する場所をクリックして、Ctrl+V
を押します。

ヒント

■ 機器には各種 OpenChoice ソフトウェア・ツールが付属しています。これらのツールは、他の設計環境の効率

と接続性を最大限に高めるように設計されています。

 使用例
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バスでのトリガ

各種のバス（I2C、SPI、RS-232/422/485/UART、MIPI DSI-1、MIPI CSI-2、8B/10B、USB、CAN、およびパラレル）でトリガす

ることができます。物理層 (アナログ波形として) とプロトコル・レベルの情報 (デジタルおよびシンボル波形として)
の両方を表示できます。

注： 一部の機種では、使用できないタイプのトリガがあります。

バス・トリガの詳細については、次を参照してください （パラレル・バスでのトリガ(90 ページ)を参照）および（シリア
ル・バスでのトリガ(92 ページ)を参照）。

バス・トリガを設定するには、次の手順を実行します。

1. Vertical > Bus Setup を選択します。

2. バスのタイプを選択します。

3. Bus Type で Serial を選択した場合

は、シリアル・バスのタイプを選択し
ます。

4. コンポーネントを指定します。

5. Trig > Bus Setup を選択します。
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6. 設定するバスを選択します。

7. Trigger On を選択して、使用するトリ

ガを選択します。

8. 選択する Trigger On の種類によって

は、さらに追加の指定が必要な場合
があります。

 使用例
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付録 A、メンテナンス

メンテナンス

このセクションでは、機器の定期的なメンテナンスに必要な情報について説明します。

注意： 機器を覆っているカバー・ケースを取り外さないでください。 カバーを取り外すと、機器が損傷する可能性
があります。 機器が損傷すると、EMC 要件を満たせなくなります。

機器を覆っているカバー・ケースを取り外さないでください。 機器の修理が必要になった場合には、当社サービ

ス・センターに返送していただく必要があります。

クリーニング

本機器のクリーニングには、次の手順を使用します。 特別なクリーニングが必要な場合は、資格のあるサービス

担当者に依頼してください。

外部のクリーニング

シャーシの外部表面のクリーニングには、乾いた柔らかい布か柔らかい毛ブラシを使用してください。汚れが落ち
ない場合は、75% のイソプロピル・アルコール溶液をしみ込ませた布または綿棒を使用してください。コントロール

やコネクタの周りの狭い部分のクリーニングには、綿棒を使用してください。 シャーシのどの部分にも研磨剤は使

用しないでください。

On/Standby スイッチは、溶剤をしみ込ませたクリーニング・タオルを使用してクリーニングしてください。スイッチに

溶剤を直接吹き付けたり、スイッチをぬらさないでください。

注意： 不適切な洗浄剤や洗浄方法を使用したり、力を入れすぎたりすると、フラットパネル・ディスプレイが損傷す
る可能性があります。化学洗浄剤は、オシロスコープに使用されているプラスチックを損傷させる可能性があるた
め、使用しないでください。フロント・パネルのボタンをクリーニングする際は、純水だけを使用してください。洗浄
剤として 75% のイソプロピル・アルコール溶剤を使用し、純水で洗い流してください。他の種類の洗浄剤を使用す
る場合は、まず当社サービス・センターまたは代理店にお問い合わせください。

外部のクリーニング時に機器の内部が湿らないように、布またはアプリケータを必要以上に液体に浸さないでくだ
さい。
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調整間隔

機器内部の電圧およびタイミング・リファレンスはきわめて安定しているため、定期的な調整を行う必要はありま
せん。 

『仕様および性能検査マニュアル』に記載された性能テストにパスしない場合には、機器の調整が必要な場合が
あります。 このマニュアルは製品に付属していますが、当社 Web サイト（www.tektronix.com/manuals）でもご利用に

なれますので、製品名で検索してください。

要件として定期的な校正が欠かせない場合には、原則として、機器を 2,000 時間使用するごとに、あるいは使用

頻度が高くない場合には年に 1 回、性能検証を実施して、（必要がある場合にのみ）調整を行なうようにしてくださ

い。

調整

調整は当社サービス・センターによってのみ実施できます。 当社サービス・センターの連絡先については、このマ

ニュアルの巻頭の著作権情報のページを参照してください。 

フラットパネル・ディスプレイのクリーニング

ディスプレイは柔らかいプラスチック製なので、クリーニング時の取り扱いには注意する必要があります。 

注意：

不適切な洗浄剤または洗浄方法を使用すると、フラット・パネル・ディスプレイが損傷する可能性があります。

ディスプレイの表面のクリーニングに、研磨剤または市販のガラス用洗剤を使用しないでください。

液体をディスプレイの表面に直接吹き付けないでください。ディスプレイを磨くときは、力を入れすぎないでくださ
い。

フラットパネル・ディスプレイの表面を清掃する場合は、清掃用ティッシュ（Kimberly-Clark 社製の Wypall Medium Duty
Wipes#05701 など）でディスプレイをやさしくふいてください。

ディスプレイの汚れがひどい場合は、蒸留水または 75% のイソプロピル・アルコール溶液でティッシュを湿らせ、

ディスプレイの表面を優しく拭きます。力を入れすぎないように注意してください。プラスチック製のディスプレイの
表面を傷つける可能性があります。

注意： 外部のクリーニング時に機器の内部が湿らないように、布またはアプリケータを必要以上に液体に浸さな
いでください。
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修理のための機器の返送

機器を輸送用に再梱包する場合は、元の梱包材を使用してください。元の梱包材が手元にないか、使用に適して
いない場合は、当社営業所まで新しい梱包材を依頼してください。 

輸送用カートンを業務用ステープルまたは丈夫なテープで止めます。

修理のために機器を返送する前に、サービス受付センターに連絡して RMA（Return Material Authorization）番号を入

手し、また詳細についてお問い合わせください。

機器を当社サービス受付センターに送る際には、次の情報を添えてください。
■ RMA 番号
■ 住所
■ 担当者の名前と電話番号
■ 機器のシリアル番号
■ 返却の理由
■ ご依頼の詳細な説明
梱包箱の見やすい 2 箇所に、当社サービス受付センターの住所と返却先住所を記してください。

TekScope リカバリ・レポート・ユーティリティ

TekScope リカバリ・レポート・ユーティリティは、当社が TekScope エラーの診断を行う上で役に立つデータが含まれ

ると考えられるログや、その他のファイルを収集する目的で設計されており、収集されたデータをすべて収め
た .zip ファイルをデスクトップに上に作成します。 圧縮ファイルはデスクトップからリムーバブル・ドライブに簡単に

コピーできます。または、電子メールに添付して当社までファイルをお送りいただくこともできます。 

TekScope エラーの診断を当社までご依頼された場合には、このユーティリティを実行して、.zip ファイルを当社に提

出していただくようお客様にお願いする場合があります。

注： ユーティリティを実行したユーザ・アカウントに作成された一時データは、ユーティリティによって削除されま
す。 そのため、TekScope が次回起動されたときには、新しいファイルを生成できます。

ユーティリティの場所

ユーティリティへのリンクは、Start\All Programs\Tektronix\TekScope\ ディレクトリにあります。
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ユーティリティの実行

ユーティリティのリンクをクリックします。

ユーティリティが起動されたときに TekScope がすでに実行されていた場合には、TekScope を停止させる必要があ

ることを知らせる警告メッセージが表示されます。 これは、いくつかのファイルをユーティリティによってアクセスで

きる状態にするためです。 機器のシリアル番号の問い合わせが完了すると、TekScope は自動的に停止されま

す。 Yes をクリックして、TekScope の停止とレポートに必要なファイルの収集を許可します。

TekScope が実行されていない場合には、リカバリ・ユーティリティは通常どおり実行され、レポートに必要なファイ

ルを収集します。

レポートの場所

ユーティリティの実行が完了すると、圧縮されたレポートファイルがデスクトップに作成されます。

1. ユーティリティを起動したときに TekScope が実行されていた場合には、デスクトップに作成された .zip ファイル

の名前の一部に、機器のタイプとシリアル番号が使用されます。例：

TekScope_Recovery_Report_DPO77002SX_123456789.zip. 

2. ただし、ユーティリティを起動したときに TekScope が実行されていなかった場合には、デスクトップに作成され

た .zip ファイルの名前にはシリアル番号が含まれません。例：

TekScope_Recovery_Report_DPO77002SX.zip

レポートに含まれるデータ

ユーティリティの実行が完了したときに、機器に次のファイルが存在した場合は、レポートにはこれらのファイルの
コピーが含まれます。

C:\Windows\Sysnative\winevt\logs\Application.evtx

C:\programdata\tektronix\ISD.XML

C:\programdata\Tektronix\TekScope\Calibration\console.log

C:\programdata\Tektronix\TekScope\Calibration\console.logOld

C:\programdata\Tektronix\TekScope\Calibration\calSPCConst.dat

 C:\programdata\Tektronix\TekScope\Calibration\caldiag.log

C:\programdata\Tektronix\TekScope\Calibration\caldiag.logOld

C:\programdata\Tektronix\TekScope\Calibration\error.log

ユーティリティの実行が完了すると、圧縮されたレポート・ファイルには、次のディレクトリの中のすべてのファイル
のコピーが含まれます。

C:\programdata\Tektronix\TekScope\Internal\*.* 

C:\programdata\Tektronix\TekScope\Calibration\ CalDramDump\*.*

C:\programdata\Tektronix\TekScope\Calibration\ CalDramDumpFact\*.* 
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ユーティリティによって削除されるデータ

このユーティリティを実行すると、次のファイルが削除されます。

C:\users\&lt;current_user&gt;\AppData\LocalLow\Tektronix\ tekScope\Internal
\*.*

TekScope の実行に何らかの問題が生じたために、一部のファイルが破損している可能性もあります。 そのため、

これらのファイルを削除することで、次回 TekScope を起動したときにファイルを再生成させることができます。 これ

らのファイルを削除すると、問題が解決する場合があります。

ユーティリティのログ・ファイル

次の場所に、リカバリ・レポート・ユーティリティによって実行された操作が記録されたログ・ファイルが作成されま
す。

C:\Temp\TekScopeRecoveryReportUtility_log.txt

交換できる部品

このセクションでは、ご使用の機器の交換できる部品について説明します。 該当するセクションのリストを使用し

て交換部品を特定し、交換部品を注文してください。 

スタンダード・アクセサリ

本製品のスタンダード・アクセサリは、ユーザ・マニュアルに記載されています。 ユーザー・マニュアルは、当社

Web サイト（www.tektronix.com/manuals）でご利用になれます。

交換できる部品

インデックス番
号

当社部品番号 有効シリアル
番号

製造停止シリ
アル番号

数量 名称と説明

1 348-2037-00 4 脚、リア、コーナー、安全基準
準拠

2 211-1481-00 4 ネジ、マシンネジ、10-32X.
500 パンヘッド T25、ナイロン・

パッチ（青）

3 348-1948-00 2 脚、固定、ナイロン（30% のガラ

ス充填）、安全基準準拠

4 348-1950-00 2 脚組み立て部品、可動

5 211-1459-00 2 ネジ、マシンネジ、8-32X.312 パ
ンヘッド T20、ナイロン・パッチ

（青）

6 348-1947-00 2 クッション、脚; サントプレーン、

（4）黒 101-80 
7 367-0528-00 1 ハンドル、キャリー（ガス・アシ

スト、オーバーモールド）、安全
基準準拠

8 407-4887-00 1 ブラケット、ハンドル・ベース、
安全基準準拠
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9 211-1265-00 2 ネジ、マシンネジ、8-32 X 1.000L
パンヘッド、ブラック・オキサイ
ド、T20、ナイロン、スチール

10 131-9650-00 2 コネクタ; SMA 50 Ω、終端（鎖あ

り）

部品注文情報

交換部品は最寄りの当社営業所から注文することができます。 

当社製機器の部品は改良されていることがあります。この改良版に交換することで、最新の改良がもたらすメリッ
トを受けることができます。したがって、部品をご注文の際は、次の情報も一緒にお知らせください。

■ 部品番号

■ 機器のタイプまたはモデル番号

■ 機器のシリアル番号

■ 機器の改修番号（適応されている場合）

ご注文の部品が別の部品または改良版の部品によって代替されている場合は、当社販売店より部品番号の変
更についてご連絡を差し上げます。
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付録 B、ヴァージョン・リリース

最新の高度な解析アプリケーションとバージョン・リリースの入手方法

機器と共にオプションのアプリケーションを発注された場合でも、機器にインストールされているバージョンが最新
でない場合があります。最新のソフトウェア・バージョンを入手するには、次の場所からダウンロードするのが簡単
で迅速な方法です。

最新のソフトウェア・バージョンをダウンロードするには、Tektronix ホームページ（www.tektronix.com）にアクセスし、

Downloads セクションを探します。ENTER MODEL NUMBER テキスト・ボックスにアプリケーション名を入力し、Select
Download Type プルダウン・メニューから Software を選択します。 

注： ホームページから入手可能なリリース・ノート・ファイルには、ダウンロード可能な実行ファイルに含まれる
readme.txt ファイルよりも最新の情報が含まれている場合があります。

検索条件を定義するには、ENTER MODEL NUMBER テキスト・ボックスにアプリケーションのタイトルを入力します。

たとえば、DPOJET の最新バージョンを探してダウンロードするには、キーワード「DPOJET」を入力します。

機器と共にアプリケーションを購入された場合は、付属の Tektronix ライセンス・キーを使用してアプリケーションを

使用します。

アップグレードする場合は、Readme.txt ファイル内の「How to Install your new Tektronix License Key」に記載されている

方法に従ってアプリケーションを有効にしてください。
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セットアップ, 96
ARM ステータス・ライト, 83
Autoset Undo（オートセットを元に戻す）, 51
Aux In, 34
Average アクイジション・モード, 54

B
B イベント・スキャン, 87

C
CAN, 178
Clock Out

リアパネル, 35

D
Dots

波形のレコード・ポイントの表示スタイル,
DPO7AFP 型, 24
DSP 帯域幅拡張, 61

E
ENOB, 55
Envelope アクイジション・モード, 54

F
FastFrame

フレーム・ファインダ, 75

I
I2C, 178
Intensified samples

波形の表示スタイル,

L
LAN コネクタ

リアパネル, 35

M
MIPI CSI-2, 178
MIPI DSI-1, 178
Monochrome Green カラー・パレット, 109
MultiView ズーム, 113
MyScope

編集, 155

N
Normal カラー・パレット, 109

O
OpenChoice

例, 176

P
PCIE コネクタ, 35
Peak Detect アクイジション・モード, 54

R
READY ステータス・ライト, 83
Ri Res アクイジション・モード, 54

S
Sample アクイジション・モード, 54
Sin(x)/x 補間法, 105
SPI, 178

T
TekScope リカバリ・レポート・ユーティリティ, 183
TekVISA インストレーション, 31
Temperature Grading カラー・パレット, 109
TRIG'D ステータス・ライト, 83

U
UltraSync バス・ケーブル, 13
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Undo Last Autoset（直前のオートセットを元に戻す）, 51
USB コネクタ

フロントパネル・コネクタ, 34
リアパネル, 35

V
Vectors

波形の表示スタイル,
VGA ポート

リアパネル, 35

W
Wave Database アクイジション・モード, 54
Windows シャットダウン, 10

X
X-Y 表示フォーマット, 104
X-Y-Z 表示フォーマット, 104

Y
Y-T 表示フォーマット, 104

あ
アクイジション

サンプリング, 52
入力チャネルおよびデジタイザ, 52

アクイジション・モード
変更, 56

アクイジションの開始, 57
アクイジションの停止, 57
アクセサリ, 1
アッテネータの選択, 5
アナログ入力

フロントパネル・コネクタ, 34
アプリケーション・ソフトウェア, 171
アプリケーションの例, 173

い
インタフェース・マップ, 36

う
ウィンドウ・トリガ

定義, 81

え
エッジ・トリガ

定義, 81

お
オート・トリガ・モード, 77
オートセット, 51
オペレーティング・システムのリストア, 31
オンライン・ヘルプ, 40

か
カーソル測定, 136
カップリング

トリガ, 78

く
クリーニング, 181
グリッチ

トリガの対象, 78
取り込み, 60, 173
捕捉, 54

グリッチ・トリガ
定義, 81

グリッド目盛スタイル,
クロス・ヘア目盛スタイル,

け
ゲート幅と分解能帯域幅, 145

こ
コネクタ

リアパネル, 33, 35
コネクタのクリーニング, 5
コネクタの保護, 6
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コピー, 168
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サンプリング・プロセス

定義, 52

し
シーケンス・トリガ, 84
シャーシ・グランド

フロントパネル・コネクタ, 34
シャットダウン

強制, 10
シリアル・マスク・テスト, 146
シングル・シーケンス, 57
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ズーム, 113
ズーム目盛のサイズ, 113
スタンダード・アクセサリ, 1
ステータス・メッセージ

校正の推奨, 27, 45
ステート・トリガ

定義, 81
スペクトラム演算式
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セグメント・メモリ, 73
セットアップ／ホールド・トリガ

定義, 81

そ
その他の測定, 130
ソフトウェア

ヴァージョン, 187
オプション, 171
最新リリース, 187

ソフトウェア・インストレーション, 31
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ターミネーション電圧, 64
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タイムアウト・トリガ
定義, 81
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ディスプレイ・マップ, 36
デュアル・モニタ, 31

と
トランジション・トリガ

定義, 81
トリガ

B イベント・スキャン, 87
カップリング, 78
シリアル・バス, 92
ステータス, 82
スロープ, 78
トリガ時の電子メール, 97
パラレル・バス, 90
ビジュアル・トリガ, 94
プリトリガ, 77, 78
ホールドオフ, 78
ポストトリガ, 77, 78
リードアウト, 82
レベル, 78
強制, 77

トリガ・イベント
定義, 77

トリガの強制, 77
トリガ位置, 86
トリガ時の電子メール, 97

の
ノーマル・トリガ・モード, 77
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バス

シリアル・バスのセットアップ, 68
バスのセットアップ, 66
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パラレル・バスのセットアップ, 70
設定, 72

パターン・トリガ
定義, 81

パラレル, 178
パルス幅トリガ

定義, 81

ひ
ビジュアル・トリガ, 94
ヒストグラムの設定, 138
ヒストグラム測定, 130
ビデオ・ポート, 35
ピンポイント・トリガ, 77
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フラット・パネル・ディスプレイのクリーニング, 182
プリトリガ, 77, 78
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デスキュー, 52
校正, 34, 52
補正, 52

フロントパネル
コネクタ, 34
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ヘルプ, 40
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ポストトリガ, 77, 78
ボタン

マークの設定／クリア, 118

ま
マーク, 117
マークの設定／クリア・ボタン, 118
マスク

オートセット, 148

マージン交差, 147
マスク・テスト, 146
マニュアル, xvi
マルチ機器構成

モードの切り替え, 20
機器の積み重ね, 10
起動, 16
起動前の確認, 13
高速再起動, 21
時間同期モード, 19, 20
接続の手順, 15
利用できない機能, 22

め
メイン・トリガ, 78, 84
メニュー, 41
メンテナンス

TekScope リカバリ・レポート・ユーティリティ, 183
クリーニング, 181
フラット・パネル・ディスプレイのクリーニング, 182
外部のクリーニング, 181
交換部品, 185
修理のための返送, 183
調整, 182
調整間隔, 182
部品注文, 186

も
モードの切り替え, 20

ゆ
ユーザ・マスク, 117
ユーザ設定, 51

ら
ラベル

バス, 66
ラント・トリガ

定義, 81
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リードアウト

トリガ, 82
リストア

AWG 製品ソフトウェア, 31

Windows オペレーティング・システム, 31
リミット・テスト, 149
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ロール・モード, 65
ロール・モードの相互操作, 65
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